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ΠΡΟΛΟΓΟ΢ 

Ζ παξνχζα πηπρηαθή εξγαζία πξαγκαηνπνηήζεθε ζην ρψξν ηνπ εξγαζηεξίνπ 

Αληνρήο ησλ Τιηθψλ ηνπ Σκήκαηνο Μεραλνινγίαο ηνπ Σερλνινγηθνχ Δθπαηδεπηηθνχ 

Ηδξχκαηνο Πάηξαο κε ηίηιν “Πεηξακαηηθή θαη Αξηζκεηηθή αλάιπζε ηάζεσλ ζε δνθίκηα κε ηελ 

κέζνδν ηεο θσηνειαζηηθφηεηαο θαη ησλ πεπεξαζκέλσλ ζηνηρείσλ”. Ζ κειέηε επεηεχρζε κε 

πεηξάκαηα θσηνειαζηηθφηεηαο ζην ρψξν ηνπ εξγαζηεξίνπ ζε ζπλδπαζκφ κε ηελ κέζνδν 

ησλ πεπεξαζκέλσλ ζηνηρείσλ κε ηελ ρξήζε ηνπ ινγηζκηθνχ ΑNSYS. 

Θα ζέιακε λα επραξηζηήζνπκε ζεξκά ηνλ επηβιέπνληα Δπίθνπξν Κ. ΢ηέθαλν 

Σζηλφπνπιν, Δπίθνπξν Καζεγεηή ηνπ ηκήκαηνο Μεραλνινγίαο, γηα ηηο ζπκβνπιέο, ηε 

ζπλεξγαζία θαη ηελ πνιχηηκε θαζνδήγεζή ηνπ ζε φια ηα ζηάδηα ηεο εξγαζίαο, θαζψο θαη 

ηνλ θ. Αρηιιέα Παπαζαλαζφπνπιν, ππεχζπλν ηνπ εξγαζηεξίνπ Αληνρήο ησλ Τιηθψλ γηα ηε 

βνήζεηα πνπ καο πξφζθεξε θαζ’ φιε ηελ δηαδηθαζία ηνπ πεηξακαηηθνχ κέξνπο. 
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ΠΔΡΙΛΗΦΗ 

΢ηελ πηπρηαθή εξγαζία καο πξαγκαηνπνηνχληαη πεηξάκαηα θσηνειαζηηθφηεηαο κε 

ρξήζε ηεο ζπζθεπήο ηνπ Πνισζηνζθνπίνπ πνπ δηαζέηεη ην Δξγαζηήξην ηεο Αληνρήο ησλ 

Τιηθψλ ηνπ Σκήκαηνο Μεραλνινγίαο ηνπ ΣΔΗ Πάηξαο θαη κέζσ απηψλ πξαγκαηνπνηείηαη 

κειέηε ηεο θαηαλνκήο ησλ ηάζεσλ ζηα ππφ εμέηαζε δνθίκηα. Σα πεηξάκαηα δηεμάγνληαη γηα 

δηάθνξεο γσλίεο πφισζεο ηνπ θσηφο θαη δηάθνξεο ζπλζήθεο πφισζεο.  

Παξάιιεια, ζρεδηαζηήθαλ ηα πεηξακαηηθά δνθίκηα κε ηηο αθξηβείο δηαζηάζεηο ζην 

ππνινγηζηηθφ πξφγξακκα ANSYS θαη πξνζνκνηψλεηαη ε θαηαπφλεζε ηνπο. Οη θαηαλνκέο 

ησλ ηάζεσλ, φπσο πξνθχπηνπλ απφ ηηο αξηζκεηηθέο αλαιχζεηο ζπγθξίλνληαη κε ηηο 

αληίζηνηρεο ησλ πεηξακάησλ ηεο θσηνειαζηηθφηεηαο. 

΢ην ηέινο ηεο Πηπρηαθήο ππάξρνπλ παξαξηήκαηα φπνπ δίλνληαη νη νδεγίεο ρξήζεο 

ηεο πεηξακαηηθήο ζπζθεπήο θαη ε βήκα πξνο βήκα επίιπζε ησλ πξνβιεκάησλ κε ηε 

ρξήζε ηνπ ANSYS.  
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ΚΔΦΑΛΑΙΟ 1: ΘΔΧΡΙΑ ΣΗ΢ ΔΛΑ΢ΣΙΚΟΣΗΣΑ΢ 

 
1.1. ΣΑ΢Η 

 

Σα εμσηεξηθά θνξηία F1,F2,…,FN θαη νη αληηδξάζεηο ζηήξημεο ζε έλα ζηεξεφ ζψκα, 
φηαλ απηφ βξίζθεηαη ζε ζηαηηθή ηζνξξνπία, νδεγνχλ ζηελ αλάπηπμε εζσηεξηθψλ δπλάκεσλ 
νη νπνίεο θαηαλέκνληαη ζε φιε ηε δηαηνκή ηνπ θνξέα φπσο θαίλεηαη ζην ΢ρ. 1.1. Ζ έληαζε 
ησλ ζηνηρεησδψλ δπλάκεσλ ζηε γεηηνληά ελφο ζεκείνπ νξίδνπλ ηνλ ηαλπζηή ησλ ηάζεσλ 
ζην ζεκείν απηφ. Γεληθά, ε ηάζε έρεη ηα ραξαθηεξηζηηθά δχλακεο σο πξνο επηθάλεηα: 

 

ζ =
ΓΤΝΑΜΖ

ΔΠΗΦΑΝΔΗΑ
  (1.1) 

 
΢ην SI, κνλάδα κέηξεζεο ηεο ηάζεο είλαη ην Pa ην νπνίν ηζνχηαη κε 1Ν αλά m2

. 
 

 
΢ρήκα 1.1. :  Δκθάληζε εμσηεξηθψλ δπλάκεσλ θαη αλάιπζε ζπληζησζψλ ησλ νξζψλ 

ηάζεσλ ζε έλαλ θνξέα.  
 

 
Ο ηαλπζηήο ησλ ηάζεσλ, φπσο θαίλεηαη ζην Σχ. 1.2, κπνξεί λα αλαιπζεί ζε ζπληζηψζεο: 
 

1. Σηο ορθές ηάζεις : 
 

𝜎 =
𝐹

𝐴
                                                                                                                           (1.2)       

 

φπνπ σ ε νξζή ηάζε (normal ή axial longitudinal), F ε ζπληζηακέλε ησλ ζηνηρεησδψλ 
δπλάκεσλ πνπ έρνπλ θαηαλεκεζεί ζηελ ζεσξνχκελε επηθάλεηα θαη είλαη θάζεηεο ζε απηή 
θαη A ην εκβαδφ ηεο ζεσξνχκελεο επηθάλεηαο. 

Οη νξζέο ηάζεηο αλαπηχζζνληαη ζπλήζσο απφ δπλάκεηο πνπ είλαη θάζεηεο ζηελ 
εγθάξζηα δηαηνκή (cross-sectional area) ηνπ ζψκαηνο.  

Τπάξρνπλ δπν είδε νξζψλ ηάζεσλ, ε εθειθπζηηθή θαη ε Θιηπηηθή ηάζε. Δκείο ζα 
αλαιχζνπκε ηελ Δθειθπζηηθή ηάζε ιφγσ ηνπ πεηξάκαηνο ηεο θσηνειαζηηθφηεηαο. 

 

 
2. Σηο διαημηηικές ηάζεις:   

 

http://el.wikipedia.org/wiki/%CE%91%CF%81%CF%87%CE%B5%CE%AF%CE%BF:Stress_in_a_continuum.svg
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𝜏 =
𝑄

𝐴 
                                                                                                                          (1.3) 

 
 
φπνπ 𝜏 (shear ή transverse stress) ε Γηαηκεηηθή ή εγθάξζηα ηάζε, Q ε ζπληζηακέλε ησλ 
ζηνηρεησδψλ δπλάκεσλ πνπ έρνπλ θαηαλεκεζεί ζηελ ζεσξνχκελε επηθάλεηα θαη είλαη 
παξάιιειεο κε απηή θαη A : ην εκβαδφ ηεο ζεσξνχκελεο επηθάλεηαο. 

Οη δηαηκεηηθέο ηάζεηο αλαπηχζζνληαη ζπλήζσο απφ δπλάκεηο πνπ εθαξκφδνληαη 
παξάιιεια  κε ηελ εγθάξζηα δηαηνκή ηνπ ζψκαηνο. 

 

 
΢τήμα 1.2. :΢πλδπαζκέλεο νξζέο ηάζεηο θαη δηαηκεηηθέο ηάζεηο ζε έλα νξζνγψλην . 

 

 

1.2. ΔΦΔΛΚΤ΢ΜΟ΢ 

 

Ζ πην απιή πεξίπησζε εθειθπζκνχ είλαη απηή  κηαο επζείαο πιαζηηθήο ή 
κεηαιιηθήο ξάβδνπ κε ζηαζεξή εγθάξζηα δηαηνκή ζε φιν ην κήθνο ηεο , ε φπνηα θνξηίδεηαη 
ζηα άθξα ηεο απφ δπν νκναμνληθέο θαη αληίζεηεο δπλάκεηο, φπσο θαίλεηαη ζην ΢ρ. 1.3. Οη 
δπλάκεηο απηέο βξίζθνληαη ζηνλ άμνλα ηεο ξάβδνπ, ν φπνηνο πεξλά απφ ην θέληξν βάξνπο 
θάζε δηαηνκήο. Γηα λα έρνπκε ζηαηηθή ηζνξξνπία νη δπλάκεηο πξέπεη λα έρνπλ Ίζα κέηξα 
θαη Αληίζεηεο θνξέο. Αλ νη δπλάκεηο θαηεπζχλνληαη απφ ηελ ξάβδν πξνο ην εμσηεξηθφ ηεο, 
ιέκε φηη ε ξάβδνο βξίζθεηαη ζε εθειθπζκφ. ΢ηνλ εθειθπζκφ ζε εγθάξζηεο δηαηνκέο 
αλαπηχζζνληαη κφλν νξζέο ηάζεηο, ε θαηαλνκή ησλ νπνίσλ ζε εγθάξζηεο δηαηνκέο καθξηά 
απφ ηα άθξα είλαη ζηαζεξή ζε θάζε ζεκείν απηήο (΢ρ. 1.4). 

 

 

΢τήμα 1.3:Παξάδεηγκα εθειθπζκνχ. 

https://www.google.gr/search?um=1&noj=1&biw=1366&bih=624&hl=el&tbm=isch&q=%CE%9C%CE%97%CE%A7%CE%91%CE%9D%CE%99%CE%9A%CE%95%CE%A3+%CE%A4%CE%91%CE%A3%CE%95%CE%99%CE%A3&spell=1&sa=X&ei=NNeoUbq5FeO80QXgh4DYDQ&ved=0CFEQBSgA
https://www.google.gr/search?noj=1&biw=1366&bih=624&q=%CE%95%CE%A6%CE%95%CE%9B%CE%A5%CE%A3%CE%9C%CE%9F%CE%A3&um=1&ie=UTF-8&hl=el&tbm=isch&source=og&sa=N&tab=wi&ei=qdeoUe70H4Pu0gW3zIDYDQ
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΢τήμα 1.4. : Καηαπφλεζε δνθηκίνπ ζε εληαηηθή θαηάζηαζε θαηά ηελ θαηαπφλεζε ζε 
εθειθπζκφ. 

 
 
 
 

1.3. ΠΑΡΑΜΟΡΦΧ΢Η 
 

Ζ παξακφξθσζε (strain) είλαη ην απνηέιεζκα ηεο επίδξαζεο ησλ ηάζεσλ ζηα 
ζηεξεά ζψκαηα. Οη νξζέο ηάζεηο πξνθαινχλ νξζέο παξακνξθψζεηο θαη νη δηαηκεηηθέο 
ηάζεηο, δηαηκεηηθέο παξακνξθψζεηο. ΢ηελ θπιηλδξηθή ξάβδν ηνπ ΢ρ. 1.5, βάδνπκε δχν 
ζεκάδηα πνπ απέρνπλ κεηαμχ ηνπο απφζηαζε L

o
. Δθαξκφδνληαο έλα εθειθπζηηθφ θνξηίν 

P ζηε ξάβδν, ζα δηαπηζηψζνπκε φηη ε απφζηαζε κεηαμχ ησλ δχν ζεκαδηψλ ζα έρεη 

απμεζεί θαηά κία πνζφηεηα u θαη ζα είλαη ηψξα 𝐿𝑓 =  𝐿𝑜 +  𝑢.  Ζ πνζφηεηα u νλνκάδεηαη 
επηκήθπλζε (elongation). Ζ νλνκαζηηθή νξζή παξακφξθσζε ή απιψο νξζή 
παξακφξθσζε (nominal ή engineering strain) ε νξίδεηαη σο: 

 

𝜀 =
𝐿𝐹−𝐿0

𝐿0
=

𝐿0+𝑈−𝐿0

𝐿0
=

𝑢

𝐿0
                                                                                           (1.4)                                           

 

΢τήμα 1.5. : Καηαπφλεζε ξάβδνπ ζε εθειθπζκφ θαζψο επηκεθχλεηαη. 

 

 

 

 

https://www.google.gr/search?noj=1&biw=1366&bih=624&q=%CE%95%CE%A6%CE%95%CE%9B%CE%A5%CE%A3%CE%9C%CE%9F%CE%A3&um=1&ie=UTF-8&hl=el&tbm=isch&source=og&sa=N&tab=wi&ei=qdeoUe70H4Pu0gW3zIDYDQ
http://www.mie.uth.gr/ekp_yliko/mhx_symp_ylik_I.pdf
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1.4. ΔΛΑ΢ΣΙΚΗ ΚΑΙ ΠΛΑ΢ΣΙΚΗ ΢ΤΜΠΔΡΙΦΟΡΑ 
 

Ζ ζπκπεξηθνξά ησλ ζηεξεψλ πιηθψλ θαη θαηά ζπλέπεηα ησλ κεηάιισλ θαη ησλ 
πιαζηηθψλ πιηθψλ έρεη δείμεη φηη φια ηα πιηθά παξακνξθψλνληαη, δειαδή πθίζηαληαη 
κεηαβνιέο ησλ δηαζηάζεσλ ή θαη ηνπ ζρήκαηφο ηνπο, θάησ απφ ηελ επίδξαζε εμσηεξηθψλ 
θνξηίσλ.  

Δπίζεο, έρεη βξεζεί φηη γηα θάζε πιηθφ ππάξρεη κία νξηαθή ηηκή θνξηίνπ, ε νπνία εάλ 
δελ μεπεξαζηεί ηφηε ην πιηθφ επαλέξρεηαη ζηηο αξρηθέο ηνπ δηαζηάζεηο κφιηο απνκαθξπλζεί 
ην θνξηίν. Ζ επαλαθνξά ελφο ζψκαηνο πνπ έρεη ππνζηεί παξακφξθσζε ζηηο αξρηθέο ηνπ 
δηαζηάζεηο, κφιηο απνκαθξπλζεί ην θνξηίν, νλνκάδεηαη ειαζηηθή ζπκπεξηθνξά (Σχ. 1.6). 

Αληίζηνηρα, ε παξακφξθσζε απηνχ ηνπ είδνπο νλνκάδεηαη ειαζηηθή παξακφξθσζε. 
Ζ νξηαθή ηηκή ηνπ θνξηίνπ πνπ δέρεηαη ην πιηθφ, ε νπνία φηαλ μεπεξαζηεί ηφηε ην πιηθφ 
παχεη λα ζπκπεξηθέξεηαη ειαζηηθά, νλνκάδεηαη όξην ειαζηηθόηεηαο (elastic limit). ΋ζνλ 
αθνξά εηδηθφηεξα ηα κέηαιια, ην νξηαθφ απηφ θνξηίν ζπλήζσο αλαθέξεηαη ζαλ φξην ξνήο 
(yield stress).  

΢ηα πεξηζζφηεξα ζηεξεά πιηθά, φζν ηα εμσηεξηθά θνξηία είλαη κηθξφηεξα απφ ην  
φξην ειαζηηθφηεηαο, ε παξακφξθσζε (δειαδή ε ειαζηηθή παξακφξθσζε) είλαη επζέσο θαη 
γξακκηθά αλάινγε πξνο ην θνξηίν. Ζ γξακκηθή απηή ζπζρέηηζε κεηαμχ θνξηίνπ θαη 
παξακφξθσζεο ζηελ ειαζηηθή πεξηνρή είλαη γλσζηή σο λφκνο ηνπ Hooke . Ο λφκνο ηνπ 
Hooke, δειαδή ε γξακκηθή ζρέζε αλάκεζα ζηελ ηάζε (stress) θαη ηελ ειαζηηθή 
παξακφξθσζε, ηζρχεη ζε φια ηα κεηαιιηθά θαη πιαζηηθά  πιηθά γηα κηθξέο 
παξακνξθψζεηο. 

΋ηαλ ηα εμσηεξηθά θνξηία ππεξβνχλ ην φξην ειαζηηθφηεηαο (ή ην φξην ξνήο) ηνπ 
πιηθνχ, ηφηε ην ζηεξεφ ζψκα πθίζηαηαη κία κφληκε κεηαβνιή ησλ δηαζηάζεσλ ή θαη ηνπ 
ζρήκαηφο ηνπ, ε νπνία παξακέλεη αθφκε θαη κεηά ηελ απνκάθξπλζε ηνπ θνξηίνπ. Έλα 
ζψκα πνπ παξακνξθψλεηαη κφληκα θαη’ απηφ ηνλ ηξφπν ιέγεηαη φηη έρεη ππνζηεί πιαζηηθή 
παξακόξθωζε (΢ρ. 1.6). 

 

 

 

 

 

 

 

 

 

 

 

΢τήμα 1.6. :Γηάγξακκα ηάζεο-παξακφξθσζεο ζε ζρέζε κε ηελ ζπκπεξηθνξά ηνπ πιηθνχ. 
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1.5. ΟΛΚΙΜΑ - ΦΑΘΤΡΑ ΤΛΙΚΑ 

 

Γεληθά, ε ζπκπεξηθνξά ησλ πιηθψλ θάησ απφ ηελ επίδξαζε εμσηεξηθψλ θνξηίσλ 
ραξαθηεξίδεηαη σο φιθηκε (ductile) ή σο ςαζπξή (brittle), αλάινγα κε ην αλ ην πιηθφ 
εκθαλίδεη ηε δπλαηφηεηα λα ππνζηεί πιαζηηθή παξακφξθσζε ή φρη ζε ζπλήζεο 
ζεξκνθξαζηαθέο ζπλζήθεο θφξηηζεο. 

Αληίζεηα, έλα πνιχ ςαζπξφ πιηθφ θαηά ηε δνθηκή εθειθπζκνχ δελ κπνξεί λα 
παξαιάβεη ζρεδφλ θαζφινπ πιαζηηθή παξακφξθσζε, κε απνηέιεζκα λα ζπάεη ακέζσο 
κφιηο ε ηηκή ηεο ηάζεο θηάζεη ζην φξην ειαζηηθφηεηαο ηνπ πιηθνχ (΢ρ.1.7). Τπάξρνπλ θαη 
θάπνηα πιηθά, φπσο νη ιεπθνί ρπηνζίδεξνη, πνπ παξνπζηάδνπλ πνιχ κηθξή πιαζηηθφηεηα 
πξνηνχ ππνζηνχλ ζξαχζε (΢ρ.1.8). 

 

Γηαγξάκκαηα ηάζεσλ –παξακνξθψζεσλ. 

΢τήμα 1.7.:Διαζηηθή ζπκπεξηθνξά        ΢τήμα 1.8. :Διαζηηθή θαη πιαζηηθή             
ζπκπεξηθνξά. 

 

Δίλαη ζεκαληηθφ λα αλαθέξνπκε φηη ην πφζν ςαζπξφ ή φιθηκν είλαη έλα κέηαιιν ή 
πιαζηηθφ δελ είλαη κία απφιπηε ηδηφηεηα ηνπ πιηθνχ.  

΢εκαληηθφ ξνιφ έρεη θαη ε ζεξκνθξαζία ελφο πιηθνχ, γηα παξάδεηγκα, ην 
βνιθξάκην, πνπ είλαη ςαζπξφ ζε ζεξκνθξαζία δσκαηίνπ, είλαη αξθεηά φιθηκν ζε 
πςειφηεξεο ζεξκνθξαζίεο. Δπίζεο, έλα κέηαιιν πνπ κπνξεί λα εκθαλίδεη ςαζπξή 
ζπκπεξηθνξά θαηά ηε δνθηκή εθειθπζκνχ, κπνξεί  λα είλαη αξθεηά φιθηκν θάησ απφ 
ζπλζήθεο πδξνζηαηηθήο πίεζεο. 

 Δπνκέλσο, νξηζκέλεο θνξέο ε ζπκπεξηθνξά ελφο πιηθνχ εμαξηάηαη θαη απφ ηε 
ζπγθεθξηκέλε εληαηηθή θαηάζηαζε ζηελ νπνία ππφθεηηαη. Αθφκε, ππάξρνπλ πιηθά πνπ 
ελψ ζε ζεξκνθξαζία δσκαηίνπ εκθαλίδνπλ φιθηκε ζπκπεξηθνξά φηαλ εθειθχνληαη, κπνξεί 
λα ζπκπεξηθεξζνχλ κε έληνλα ςαζπξφ ηξφπν φηαλ ππάξρνπλ ζε απηά εγθνπέο ή 
ξήγκαηα θαη βξεζνχλ ζε ρακειή ζεξκνθξαζία.  

Γηαπηζηψλνπκε, ινηπφλ, φηη ην θαηά πφζν έλα πιηθφ ζα ζπκπεξηθεξζεί φιθηκα ή 
ςαζπξά εμαξηάηαη θαη απφ πνιινχο παξάγνληεο. 

 
 

 

 

 

http://www.mie.uth.gr/ekp_yliko/mhx_symp_ylik_I.pdf


7 
 

1.6. ΚΑΜΠΤΛΗ ΣΑ΢Η΢ - ΠΑΡΑΜΟΡΦΧ΢Η΢ 

 

Καηά ηε δηάξθεηα ελφο πεηξάκαηνο εθειθπζκνχ, θαζψο ην αμνληθφ θνξηίν απμάλεηαη 
βαζκηαία, κεηξηέηαη ε ζπλνιηθή επηκήθπλζε ζε θάζε αχμεζε απηνχ θαη απηφ ζπλερίδεηαη 
κέρξη λα ζπκβεί ζξαχζε ηνπ δνθηκίνπ. Αθνχ γλσξίδνπκε ην αξρηθφ εκβαδφ ηεο δηαηνκήο 
ηνπ δνθηκίνπ, ε κέζε νξζή ηάζε σ, κπνξεί λα ππνινγηζηεί γηα νπνηαδήπνηε ηηκή ηνπ 
αμνληθνχ θνξηίνπ απφ ηνλ ηχπν : 

          

𝜎 =
𝑃

𝐴
                                                                                                                        (1.5) 

φπνπ ην Ρ : ζπκβνιίδεη ην αμνληθφ θνξηίν θαη ην Α : είλαη ην αξρηθφ εκβαδφ ηεο εγθάξζηαο 
δηαηνκήο ζπλήζσο θπθιηθή ή νξζνγσληθή. 

Έρνληαο πνιιά δεχγε ηηκψλ, νξζήο ηάζεο σ θαη νξζήο παξακφξθσζεο ε, 
ζρεκαηίδεηαη ην δηάγξακκα ηάζεσλ – παξακνξθψζεσλ ηνπ πιηθνχ γηα απηφλ ηνλ ηχπν 
θφξηηζεο. Σα δηαγξάκκαηα ηάζεσλ-αλεγκέλσλ παξακνξθψζεσλ έρνπλ πνιχ δηαθνξεηηθέο  
κνξθέο γηα ηα δηάθνξα πιηθά (΢ρ. 1.9 θαη ΢ρ. 1.10) 

Σα πιηθά δηαθξίλνληαη ζε απνιύηωο ειαζηηθά (π.ρ. γπαιί, πιαζηηθφ), ημώδε (π.ρ. 
αζθαιηηθά πιηθά) θαη βηζθνειαζηηθά  (π.ρ. ζθπξφδεκα). 

 

 

΢τήμα 1.9. : Κακπχιε ηάζεο- παξακφξθσζεο γηα ηνλ ράιπβα. 

 

 

https://www.google.gr/search?noj=1&biw=1366&bih=624&q=%CE%95%CE%A6%CE%95%CE%9B%CE%A5%CE%A3%CE%9C%CE%9F%CE%A3&um=1&ie=UTF-8&hl=el&tbm=isch&source=og&sa=N&tab=wi&ei=qdeoUe70H4Pu0gW3zIDYDQ
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΢τήμα 1.10. : Γηαγξάκκαηα ηάζεσλ – παξακνξθψζεσλ γηα ραξαθηεξηζηηθά δνκηθά πιηθά. 

 

Δπίζεο  αλάινγα κε ην πιηθφ, ζεκαληηθφ ξφιν  έρνπλ θαη νη κεραληθέο ηδηφηεηεο ησλ πιηθψλ 
, φπσο θαίλεηαη ζην ΢ρ. 1.11. 

 

 

 

 

 

 

 

 

 

 

 

΢τήμα 1.11.:Γηαγξάκκαηα ηάζεσλ – παξακνξθψζεσλ αλάινγα κε ηηο κεραληθέο ηδηφηεηεο 
ησλ πιηθψλ . 

Η. Μαιαθά θαη αζζελή  ,  ΗΗ. ΢θιεξά θαη εχζξαπζηα , ΗΗΗ. ΢θιεξά θαη δχζθακπηα , 

IV. Μαιαθά θαη δχζθακπηα   , V. ΢θιεξά θαη δχζθακπηα. 

 

 

http://www.ntua.gr/vitruvius/ty1.pdf
http://www.materials.uoi.gr/polymers/assets/lectures pdfs/Texnologia_Part2.pdf
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Ζ κνξθή ησλ δηαγξακκάησλ ηάζεο παξακφξθσζεο είλαη ηδηαίηεξα ρξήζηκε γηα ηελ 
θαηάηαμε ησλ πιηθψλ σο πξνο ηε κεραληθή ηνπο ζπκπεξηθνξά .Με βάζε ην πξνεγνχκελν 
δηάγξακκα ,έρνπκε : 

 

1. Σχπνο Η :Μαιαθά θαη αζζελή.  
Υαξαθηεξηζηηθά : ρακειφ κέηξν ειαζηηθφηεηαο , ΢εκείν δηαξξνήο. 

2. Σχπνο ΗΗ: ΢θιεξά θαη εχζξαπζηα. 
 Υαξαθηεξηζηηθά : πςειφ κέηξν ειαζηηθφηεηαο, ΋ρη ζεκείν δηαξξνήο. 

3. Σχπνο ΗΗΗ : ΢θιεξά θαη ζηηβαξά ή δχζθακπηα . 
Υαξαθηεξηζηηθά  : Πνιχ πςειφ κέηξν ειαζηηθφηεηαο , Τςειή αληνρή ζε 
εθειθπζκφ. ΋ρη ζεκείν δηαξξνήο. 

4. Σχπνο Η: Μαιαθά θαη δχζζξαπζηα. 
 Υαξαθηεξηζηηθά : Υακειφ κέηξν ειαζηηθφηεηαο , Τςειή επηκήθπλζε θαηά ηε 
ζξαχζε ,΢εκείν δηαξξνήο. 

5. Σχπνο  V : ΢θιεξά θαη δχζζξαπζηα. 
 Υαξαθηεξηζηηθά : Πνιχ  πςειφ κέηξν ειαζηηθφηεηαο , Τςειή αληνρή ζε 
εθειθπζκφ ,Τςειή επηκήθπλζε θαηά ηε ζξαχζε , ΢εκείν δηαξξνήο. 
 

 

 

1.7. ΜΔΣΡΟ ΔΛΑ΢ΣΙΚΟΣΗΣΑ΢. 
 

 Σν κέηξν ειαζηηθφηεηαο ελφο πιηθνχ, σο θπζηθή έλλνηα, εθθξάδεη ηελ αληίζηαζε 
πνπ πξνβάιιεη ην πιηθφ ζε ειαζηηθή παξακόξθωζε θαη εμαξηάηαη άκεζα απφ ηελ ηζρχ 
ησλ ρεκηθψλ δεζκψλ κεηαμχ ησλ αηφκσλ ηνπ πιηθνχ.  

Έηζη, πιηθά πνπ ζρεκαηίδνπλ ηζρπξνχο ρεκηθνχο δεζκνχο, φπσο ηα κέηαιια 
(κεηαιιηθνί δεζκνί) θαη ηα θεξακηθά (νκνηνπνιηθνί ή εηεξνπνιηθνί δεζκνί), ραξαθηεξίδνληαη 
απφ πςειφ κέηξν ειαζηηθφηεηαο. Απηφ ζεκαίλεη φηη απαηηνχληαη ζρεηηθά κεγάιεο ηάζεηο γηα 
λα παξαρζεί ζρεηηθά κηθξή ειαζηηθή παξακφξθσζε.     

Αληίζεηα, πιηθά φπσο ηα πνιπκεξή θαη ηα ειαζηνκεξή, ησλ νπνίσλ νη κνξηαθέο 
αιπζίδεο ζπγθξαηνχληαη κεηαμχ ηνπο κε αζζελείο ρεκηθνχο δεζκνχο (π.ρ. Van der Waals), 
ραξαθηεξίδνληαη απφ ρακειφ κέηξν ειαζηηθφηεηαο, πνπ ζεκαίλεη φηη ζρεηηθά κηθξέο ηάζεηο 
κπνξνχλ λα πξνθαιέζνπλ κεγάιεο ειαζηηθέο παξακνξθψζεηο.  

Σν κέηξν ειαζηηθφηεηαο ελφο πιηθνχ εμαξηάηαη επίζεο απφ ηελ ζεξκνθξαζία. 
Δπεηδή φζν απμάλεηαη ε ζεξκνθξαζία ηα άηνκα ησλ πιηθψλ γίλνληαη πην θηλεηηθά, απηφ έρεη 
ζαλ ζπλέπεηα ηελ ραιάξσζε ηεο ηζρχνο ησλ ρεκηθψλ δεζκψλ πνπ ηα ζπγθξαηνχλ ζηηο 
ζέζεηο ηζνξξνπίαο ηνπο, κε απνηέιεζκα λα κεηψλεηαη θαη ην κέηξν ειαζηηθφηεηαο ηνπ 
πιηθνχ. 

 

 
1.8. ΝΟΜΟ΢ ΣΟΤ POISSON 

 

 ΋ηαλ κηα ξάβδνο θαηαπνλείηαη κε απιφ εθειθπζκφ θαηά ηε δηεχζπλζε x, απμάλεηαη 
ην κήθνο ηεο θαηά ηελ δηεχζπλζε ηνπ θνξηίνπ (εx) αιιά κεηψλνληαη νη άιιεο δηαζηάζεηο 
θάζεηα ζηελ δηεχζπλζε ηνπ Φνξηίνπ (εy θαη εz). Ο ιφγνο ηεο εγθάξζηαο παξακφξθσζεο 
πξνο ηελ αμνληθή παξακφξθσζε νλνκάδεηαη  ιφγνο Poisson, θαη δίλεηε απφ ηελ ΢ρέζε 
1.6. : 

 

𝑣 = −
𝜀𝑦

𝜀𝛸
                                                                                                                   (1.6) 
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1.9. ΙΓΙΟΣΗΣΔ΢ ΤΛΙΚΧΝ 

 
΢ηνλ πίλαθα 1.1 παξνπζηάδνληαη ην κέηξν ειαζηηθφηεηαο θαη ν ιφγνο Poisson ζπλήζσλ 
κεραλνινγηθψλ πιηθψλ.  

 
 

Τλικό  
 

Μέηρο ελαζηικόηηηας  
Δ (ζε GPa)  

Λόγος Poisson 
ν  

Κξάκαηα αινπκηλίνπ (Al)  72,4  0,31 

Υαιθφο (Cu)  110 0,33 

Υάιπβεο  210 0,33 

Αλνμείδσηνη ράιπβεο 193 0,28 

Σηηάλην (Ti)  117 0,31 

Βνιθξάκην (W) 400 0,27 

Plexiglas (PMMA) 3 0,35 

PLM-4B 0,13 0,45 

Πίνακας 1.1. : Υαξαθηεξηζηηθέο ηδηφηεηεο ησλ πιηθψλ. 
 

 
 

1.10. Α΢ΣΟΥΙΑ ΣΧΝ ΤΛΙΚΧΝ 
 

Σα δηάθνξα ζηνηρεία κηαο θαηαζθεπήο κπνξεί λα απνηχρνπλ ζηελ εθηέιεζε ησλ 
ιεηηνπξγηψλ γηα ηηο νπνίεο ρξεζηκνπνηνχληαη, δειαδή κπνξεί λα ππνζηνχλ αζηνρία 
(failure), κε ηξεηο θπξίσο ηξφπνπο:  

1. Λφγσ ππεξβνιηθήο ειαζηηθήο παξακφξθσζεο.  
2. Λφγσ πιαζηηθήο ξνήο ή ππεξβνιηθήο πιαζηηθήο παξακφξθσζεο.  
3. Λφγσ ζξαχζεο.  

 
 

ΤΠΔΡΒΟΛΙΚΗ ΔΛΑ΢ΣΙΚΗ ΠΑΡΑΜΟΡΦΧ΢Η 

Ζ πιήξεο θαηαλφεζε ησλ πηζαλψλ ηξφπσλ αζηνρίαο είλαη ηδηαίηεξα ζεκαληηθή γηα 
ηνλ ζσζηφ θαη αζθαιή ζρεδηαζκφ δνκηθψλ ζηνηρείσλ. 

Ζ αζηνρία ελφο δνκηθνχ ζηνηρείνπ ιφγσ ππεξβνιηθήο ειαζηηθήο παξακφξθσζεο 
κπνξεί λα εκθαληζηεί κε δχν κνξθέο: 

 
1. Τπεξβνιηθή ειαζηηθή παξακφξθσζε θάησ απφ ζπλζήθεο ζηαηηθήο ηζνξξνπίαο, 

φπσο γηα παξάδεηγκα είλαη ε ειαζηηθή θάκςε κίαο δνθνχ ππφ ηελ επίδξαζε 
ζηαδηαθά απμαλφκελνπ θνξηίνπ.  

2. Λπγηζκφο (buckling) ζηνηρείσλ πνπ δέρνληαη ζιηπηηθά αμνληθά θνξηία (π.ρ. 
ξάβδνη), θάησ απφ ζπλζήθεο αζηαζνχο ζηαηηθήο ηζνξξνπίαο.  

 
Ζ αζηνρία ελφο δνκηθνχ ζηνηρείνπ ιφγσ ππεξβνιηθήο ειαζηηθήο παξακφξθσζεο 

κπνξεί λα είλαη εμίζνπ επηδήκηα θαη θαηαζηξνθηθή γηα κία κεραλή ή γεληθφηεξα γηα κία 
θαηαζθεπή, φζν ζα ήηαλ αθφκε θαη αλ απηφ έζπαγε ηειείσο.  

Ζ ζπκπεξηθνξά ησλ πιηθψλ ζε ειαζηηθή παξακφξθσζε θαζνξίδεηαη θαη εμαξηάηαη 
απνθιεηζηηθά απφ ην: 

 
1. Μέηξν ειαζηηθφηεηαο (Δ)  
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Μεγάιν κέηξν ειαζηηθφηεηαο ζεκαίλεη φηη ην πιηθφ παξνπζηάδεη κεγάιε αληίζηαζε 
ζε ειαζηηθέο παξακνξθψζεηο. 

Δπεηδή δελ κπνξνχκε λα παξέκβνπκε ηερλεηά ζην είδνο ησλ ρεκηθψλ δεζκψλ, 
επνκέλσο δελ κπνξνχκε λα βειηηψζνπκε θαη ην κέηξν ειαζηηθφηεηαο ηνπ πιηθνχ, ζε 
εθαξκνγέο πνπ απαηηείηαη κεγάιε δπζθακςία πξέπεη λα επηιέγνληαη πιηθά κε πςειφ κέηξν 
ειαζηηθφηεηαο. 

 
2. Kαη ΟΧΙ απφ ηελ αληνρή ηνπ θάζε πιηθνχ (π.ρ. φξην ξνήο).  
 
 
 

 
ΛΟΓΧ ΠΛΑ΢ΣΙΚΗ΢ ΡΟΗ΢ Η ΤΠΔΡΒΟΛΙΚΗ΢ ΠΛΑ΢ΣΙΚΗ΢ ΠΑΡΑΜΟΡΦΧ΢Η΢. 

Αζηνρία ιφγσ πιαζηηθήο ξνήο ή ππεξβνιηθήο πιαζηηθήο παξακφξθσζε 
εκθαλίδεηαη φηαλ : 

 
1. Σα εμσηεξηθά θνξηία πνπ θαηαπνλνχλ έλα δνκηθφ ζηνηρείν είλαη αξθεηά κεγάια, 

ψζηε νη ηάζεηο πνπ αλαπηχζζνληαη ζην πιηθφ λα ππεξβνχλ ην φξην ξνήο ηνπ. 
Απηφ έρεη ζαλ απνηέιεζκα ηελ πιαζηηθή παξακφξθσζε ηνπ δνκηθνχ ζηνηρείνπ, 

δειαδή ηελ κφληκε αιιαγή ησλ δηαζηάζεσλ ή θαη ηνπ ζρήκαηφο ηνπ, γεγνλφο πνπ κπνξεί 
λα ην θαηαζηήζεη αλίθαλν λα ζπλερίζεη λα ιεηηνπξγεί νκαιά θαη κε αζθάιεηα.  

 Ζ πιαζηηθή ξνή ζπάληα νδεγεί ζε ζξαχζε, δηφηη εκθαλίδεηαη ην θαηλφκελν ηεο 
εξγνζθιήξπλζεο (work - hardening), πνπ ζεκαίλεη φηη φζν απμάλεηαη ε πιαζηηθή 
παξακφξθσζε ηνπ πιηθνχ, ηφζν πςειφηεξε ηάζε απαηηείηαη γηα λα ζπλερηζηεί πεξαηηέξσ ε 
παξακφξθσζε. 

 
2.  Ζ αζηνρία ιφγσ ππεξβνιηθήο πιαζηηθήο παξακφξθσζεο εμαξηάηαη απφ ην φξην 

ξνήο (yield-stress) ζε ζπλζήθεο νκναμνληθήο θφξηηζεο (εθειθπζκνχ ή ζιίςεο).  
΢ε πην πεξίπινθεο εληαηηθέο θαηαζηάζεηο θαη πάιη ην φξην ξνήο είλαη ε θπξίαξρε 

παξάκεηξνο, πξνζαξκνζκέλν φκσο ζε θάπνηα εηδηθά θξηηήξηα πιαζηηθήο ξνήο.  
Σα πην ζεκαληηθά απφ απηά θξηηήξηα είλαη : 
 

Α. ην θξηηήξην κέγηζηεο Γηαηκεηηθή ηάζεο (ή θξηηήξην Tresca)  
Β. Σν θξηηήξην ζηξνθηθήο ελέξγεηαο (ή θξηηήξην Von Misses) 

 

Σέινο, ε εκθάληζε αζηνρίαο ιφγσ ππεξβνιηθήο πιαζηηθήο παξακφξθσζεο απνθηά 
ηδηαίηεξε ζεκαζία φηαλ ε ζεξκνθξαζία ιεηηνπξγίαο ηνπ δνκηθνχ ζηνηρείνπ είλαη πςειή.  
Σφηε, ειιείςεη ηνπ θαηλνκέλνπ ηεο εξγνζθιήξπλζεο, ηα κεηαιιηθά πιηθά παξνπζηάδνπλ 
ζπλερψο απμαλφκελε πιαζηηθή παξακφξθσζε αθφκε θαη θάησ απφ ζηαζεξή ηάζε. Σν 
θαηλφκελν απηφ νλνκάδεηαη εξππζκόο (creep). 

 
ΛΟΓΧ ΘΡΑΤ΢Η΢. 

Αζηνρία ιφγσ ζξαχζεο (fracture) εκθαλίδεηαη φηαλ ζε έλα πιηθφ πξνυπάξρνπλ ή 
δεκηνπξγνχληαη ξήγκαηα (cracks), ηα νπνία θάησ απφ ζπγθεθξηκέλεο ζπλζήθεο κεραληθήο 
θαηαπφλεζεο πξνσζνχληαη, αθαξηαία ή ζηαδηαθά, θαη νδεγνχλ ζηελ θαηαζηξνθή ηνπ 
δνκηθνχ ζηνηρείνπ. Ζ ζξαχζε είλαη έλαο πνιχ επηθίλδπλνο ηξφπνο αζηνρίαο, εηδηθά ζηα 
ςαζπξά (brittle) πιηθά, δηφηη ζπκβαίλεη αθαξηαία θαη πνιιέο θνξέο ρσξίο λα δψζεη 
πξνεγνπκέλσο θάπνηα πξνεηδνπνηεηηθή έλδεημε. ΢ηα φιθηκα (ductile) πιηθά ε θαηάζηαζε 
είλαη θαιχηεξε, δηφηη εθεί ηεο ζξαχζεο πξνεγείηαη ζπλήζσο εθηεηακέλε πιαζηηθή 
παξακφξθσζε, ε νπνία κπνξεί λα γίλεη επθνιφηεξα αληηιεπηή θαη λα νδεγήζεη ζηελ 
πξφιεςε ηεο θαηαζηξνθηθήο ζξαχζεο. Ζ ζξαχζε ζηα κεηαιιηθά πιηθά εκθαλίδεηαη γεληθά 
κε δχν κνξθέο:  
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A. αθαξηαία ςαζπξή ζξαχζε θαη  
B. ζηαδηαθή ζξαχζε ή θφπσζε (fatigue). 
 

Ζ μαθληθή ςαζπξή ζξαχζε εκθαλίδεηαη ζηα ςαζπξά πιηθά, ρσξίο λα έρεη πξνεγεζεί 
ζρεδφλ θαζφινπ πιαζηηθή παξακφξθσζε ζε απηά. Φαζπξή ζξαχζε κπνξεί λα εκθαληζηεί 
θαη ζε φιθηκα κεηαιιηθά πιηθά, θάησ απφ νξηζκέλεο πξνυπνζέζεηο. Σν ζπλεζέζηεξν 
παξάδεηγκα απηήο ηεο θαηεγνξίαο είλαη νη απινί αλζξαθνχρνη ράιπβεο θαηαζθεπψλ, νη 

νπνίνη ζε ρακειέο ζεξκνθξαζίεο (ζπλήζσο θάησ απφ 0 
ν

C) παξνπζηάδνπλ κηα κεηάβαζε 
απφ φιθηκε ζε ςαζπξή ζπκπεξηθνξά, γεγνλφο πνπ θαζηζηά πηζαλή κηα μαθληθή ζξαχζε 
ηνπο ρσξίο λα έρεη πξνεγεζεί ζεκαληηθή πιαζηηθή παξακφξθσζή ηνπο.  

Ζ κεηάβαζε απφ φιθηκε ζε ςαζπξή ζξαχζε επλνείηαη απφ ηελ κείσζε ηεο 
ζεξκνθξαζίαο φπσο αλαθέξζεθε, αιιά θαη απφ ηελ αχμεζε ηνπ ξπζκνχ θφξηηζεο, δειαδή 
πφζν γξήγνξα εθαξκφδεηαη κία δχλακε επάλσ ζην δνκηθφ ζηνηρείν. Γηα παξάδεηγκα, ελψ 
φηαλ έλα θνξηίν κεγέζνπο F εθαξκνζηεί ζηγά-ζηγά ζε έλα πιηθφ ηφηε απηφ δελ πθίζηαηαη 
ζξαχζε, κπνξεί ην ίδην θνξηίν F φηαλ εθαξκνζηεί κε κεγάιε ηαρχηεηα (π.ρ. ζαλ θξνπζηηθφ 
θνξηίν) λα νδεγήζεη ην ίδην πιηθφ ζε ςαζπξή ζξαχζε. Γηα ηελ αλάιπζε πξνβιεκάησλ 
ςαζπξήο ζξαχζεο ππάξρεη κία ηζρπξή ζεσξία πνπ νλνκάδεηαη θρασζηομητανική 
(fracture mechanics). 
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ΚΔΦΑΛΑΙΟ 2: ΘΔΧΡΙΑ ΣΟΤ ΦΧΣΟ΢ 

 

Καηά ηελ ζσκαηηδηαθή ζεσξία ηνπ θσηφο, ηα ζσκαηίδηα πνπ εθπέκπνληαη απφ ηε 
θσηεηλή πεγή θηλνχληαη επζχγξακκα εληφο ηνπ κέζνπ έσο φηνπ ζπλαληήζνπλ ηελ 
επηθάλεηα ελφο άιινπ κέζνπ φπνπ αλαθιψληαη ή δηαζιψληαη, φπσο ραξαθηεξηζηηθά 
θαίλεηαη ζην ζρήκα 2.1. 

 

 

 

 

(α) θαη (β) (γ ,δ) 

΢τήμα 2.1. : (α) Αλάθιαζε, (β) Γηάζιαζε θσηεηλψλ αθηηλψλ θαη (γ ,δ) Γηάδνζε κεηψπσλ 
Κχκαηνο  

 

΢χκθσλα κε ηελ θπκαηηθή ζεσξία ηνπ θσηφο, απφ ζεκεηαθή πεγή Π εθπέκπεηαη έλα 
θχκα πνπ γελλάηαη απφ ηηο δνλήζεηο ησλ αηφκσλ ηεο πεγήο. Σν θχκα δηαδίδεηαη ζην ρψξν 
κε ηαρχηεηα U, φπνπ U ε ηαρχηεηα δηαδφζεσο ηνπ θσηφο ζην ρψξν ηεο πεγήο. Σν θχκα 
δηαδηδφκελν πξνο φιεο ηηο επηθάλεηεο ζρεκαηίδεη ζθαηξηθέο επηθάλεηεο αθηίλαο R, δίλεηε 
απφ ηελ ζρέζε 2.1.: 

 

𝑅 = 𝑈 ∗ 𝑡.                                                                                                               (2.1) 

φπνπ t o ρξφλνο. 

΋ια ηα ζεκεία ηεο ζθαίξαο επξίζθνληαη ζε θάζε. Οη επηθάλεηεο απηέο απνηεινχλ ηα 
κέησπα ηνπ θχκαηνο. Σα ζεκεία ηνπ πξψηνπ κεηψπνπ θαζίζηαληαη λέεο θσηεηλέο πεγέο 
πνπ ζρεκαηίδνπλ λέα κέησπα θχκαηνο θαη ε πεξηβάιινπζα ησλ επί κέξνπο κεηψπσλ 
ζρεκαηίδεη ην λέν κέησπν θχκαηνο ζχκθσλα κε ηελ αξρή ηνπ Huygens. Σα ζθαηξηθά 
κέησπα ηνπ θχκαηνο πνιχ καθξηά ηεο πεγήο Π θαζίζηαληαη ζρεδφλ επίπεδα έηζη ψζηε ζε 
άπεηξε απφζηαζε απφ ηελ πεγή Π ηα κέησπα ζεσξνχληαη επίπεδα θάζεηα ζηηο θσηεηλέο 
αθηίλεο, φπσο θαίλεηαη ζην ΢ρ. 2.1 γ. 

΢χκθσλα κε ηελ ζεσξία ηνπ θσηφο θαη ηελ αξρή ηνπ Huygens, κπνξεί εχθνια λα 
εμεγεζεί ε αλάθιαζε θαη ε δηάζιαζε ηνπ θσηφο. Έηζη, φηαλ έλα κέησπν θχκαηνο θζάζεη 
ζηελ δηαρσξηζηηθή επηθάλεηα ηφηε ηα ζεκεία ηεο δηαρσξηζηηθήο επηθάλεηαο θαζίζηαληαη 
δεπηεξεχνπζεο πεγέο θπκάησλ κε απνηέιεζκα έλα λέν κέησπν θχκαηνο λα γελλάηαη θαη 
αθ’ ελφο κελ λα αλαθιάηαη αθ’ εηέξνπ δε λα δηαζιάηαη. 



15 
 

2.1. ΦΧΣΟΔΛΑ΢ΣΙΚΟΣΗΣΑ 

 

H Φσηνειαζηηθφηεηα είλαη κηα πεηξακαηηθή κέζνδνο αλάιπζεο θαη ππνινγηζκνχ ησλ 
ηάζεσλ πνπ εκθαλίδνληαη ζε έλα ειαζηηθά ζπκπεξηθεξφκελν ζψκα . 

Απαηηεί ηε ρξεζηκνπνίεζε θσηεηλήο πεγήο θαη ηελ γλψζε νπηηθψλ ηερληθψλ κέζσλ  
φπσο ηεο θπκαηηθήο ζεσξίαο δηάδνζεο ηνπ θσηφο. 

Βαζίδεηαη ζηελ ηδηφηεηα πνπ εκθαλίδνπλ κεξηθά δηαθαλή πιαζηηθά πιηθά λα 
επεξεάδνπλ ηελ πνξεία ηνπ θσηφο πνπ δηέξρεηαη κέζα απφ απηά, φηαλ κεηαβάιιεηαη ε 
εληαηηθή ηνπο θαηάζηαζε.   

Ζ ζπζθεπή πνπ ρξεζηκνπνηείηαη ζηελ θσηνειαζηηθφηεηα είλαη ην πνισζηνζθφπην 
θαη ζπλεπάγεηαη φηη ε θαηαζθεπή ησλ δνθηκίσλ-κνληέισλ γίλεηαη απφ δηαθαλήο πιαζηηθφ 
πιηθφ. 

Με ηελ κέζνδν απηή παίξλνπκε άκεζεο πνηνηηθέο πιεξνθνξίεο ζρεηηθά κε ηελ 
θαηαλνκή ησλ ηάζεσλ, ηηο ζέζεηο ζπγθεληξψζεσλ ηάζεσλ, ηηο θχξηεο ηάζεηο, θαζψο θαη γηα 
ηηο πεξηνρέο ρακειψλ ηάζεσλ. 

Με βάζε απηά ηα απνηειέζκαηα, νη κειέηεο κπνξνχλ λα ηξνπνπνηεζνχλ ψζηε λα 
κεησζνχλ ή λα δηαζθνξπηζηνχλ νη ζπγθεληξψζεηο ησλ ηάζεσλ ή λα αθαηξεζεί πιενλάδνλ 
πιηθφ απφ πεξηνρέο ρακειψλ ηάζεσλ, κε απνηέιεζκα κείσζε ηνπ βάξνπο θαη ηνπ θφζηνπο 
κηαο θαηαζθεπήο. 

Απφ ηελ ζηηγκή πνπ ε θσηνειαζηηθή αλάιπζε κπνξεί λα εθηειεζηεί ζην κνληέιν κηαο 
θαηαζθεπήο ππφ κειέηε, δειαδή πξηλ αξρίζεη ε παξαγσγή, κπνξνχκε λα απνθχγνπκε 
ελδερφκελεο αζηνρίεο ή απνηπρίεο θαηά ηελ παξαγσγή, δαπαλεξέο ζρεδηαζηηθέο 
κεηαηξνπέο, θαζψο θαη επαλεθαηεξγαζίεο. Αθφκα θαη ζηελ πεξίπησζε εκθάληζεο 
αζηνρίαο ε κέζνδνο απηή είλαη απνηειεζκαηηθή γηα ηελ δηεξεχλεζε ηεο θαη ζπρλά παξέρεη 
πνιχηηκεο πιεξνθνξίεο πνπ νδεγνχλ ζε επηηπρή επαλαζρεδηαζκφ. 
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2.2. ΓΙΠΛΟΓΙΑΘΛΑ΢Η ΚΑΙ ΦΧΣΟΣΑ΢ΔΟΠΣΙΚΟ΢ ΝΟΜΟ΢ 
 

Σα θσηνειαζηηθά κνληέια θαηαζθεπάδνληαη απφ εηδηθά δηαθαλή πιηθά πνπ, φηαλ 
θαηαπνλνχληαη παξνπζηάδνπλ ηελ ηδηφηεηα ηεο δηπινδηάζιαζεο. Σα πιηθά απηά 
νλνκάδνληαη δηπινζιαζηηθά. 

Ζ θσηεηλή αθηηλνβνιία θαηά ηελ πξφζπησζε ηεο, ζε δηπινδηαζιαζηηθφ ζψκα, ππφ 
εληαηηθή θαηάζηαζε, δηαρσξίδεηαη ζε δπν επίπεδα πνισκέλεο δέζκεο θάζεηεο κεηαμχ ηνπο. 
Οη δηεπζχλζεηο ηνπο ζε νπνηνδήπνηε ζεκείν ζπκπίπηνπλ κε ηηο δηεπζχλζεηο ησλ θχξησλ 
ηάζεσλ. Οη ηαρχηεηεο ησλ θσηεηλψλ απηψλ δεζκψλ είλαη αλάινγεο ηνπ κεγέζνπο ησλ 
αληίζηνηρσλ θχξησλ ηάζεσλ ζε θάζε δηεχζπλζε.  

  Έρεη απνδεηρζεί πεηξακαηηθά φηη ε εθαξκνγή εληαηηθήο θαηαζηάζεσο ζε ηζφηξνπα 
πιηθά πξνθαιεί δηπινδηάζιαζε, πνπ ζε θάζε ζεκείν ηνπ ζψκαηνο είλαη αλάινγε πξνο ηε 
δηαθνξά ησλ θχξησλ ηάζεσλ ζ’ απηφ ην ζεκείν, ζηελ πεξηνρή ησλ θαηαπνλήζεσλ, πνπ 
ηζρχεη ν λφκνο ηνπ Hooke. Ζ αλαινγία κεηαμχ ηεο δηπινδηάζιαζεο θαη ηεο εληαηηθήο 
θαηάζηαζεο ζπλδέεηαη κε ηελ αθφινπζε καζεκαηηθή ζρέζε 2.2., είλαη γλσζηή σο 
θωηνηαζενπηηθόο λόκνο. 

 

ζ1 − ζ2 =
𝑓

𝑆
 N                                                                                                       (2.2) 

 

΋πνπ ζ1,ζ2 : ε δηαθνξά ησλ θπξίσλ ηάζεσλ, f : είλαη ε ζηαζεξά ηεο 
θσηνειαζηηθφηεηαο ηνπ πιηθνχ, s: ην πάρνο ηνπ θσηνειαζηηθνχ κνληέινπ θαη Ν: ν αξηζκφο 
ησλ θξνζζψλ πνπ εκθαλίδνληαη ζην πξνο κειέηε κνληέιν.   

 

 

΢τήμα 2.2. : Γέζκεο ηνπ Φσηφο. 
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Ζ δηάθνξα θάζεο ησλ δπν θσηεηλψλ δεζκψλ φπνπ εμέξρνληαη απφ ην 
θσηνειαζηηθφ κνληέιν δίλεηαη απφ ηελ ζρέζε 2.3.: 

𝛥 = 2 ∗ 𝜋 ∗
𝑠

𝜆
∗  𝑛1 − 𝑛2                                                                                           (2.3) 

΋πνπ Δ :ε δηαθνξά θάζεο ησλ δπν θσηεηλψλ δεζκψλ, n1, n2: νη δείθηεο δηάζιαζεο ηνπ 
θαηαπνλνχκελνπ κνληέινπ ζηηο δπν θάζεηεο κεηαμχ ηνπο δηεπζχλζεηο, λ :ην κήθνο θχκαηνο 
θσηφο πεγήο θαη s ην πάρνο ηνπ θσηνειαζηηθνχ κνληέινπ. 

 

Δπίζεο ζπκθψλα κε ηνλ λφκν ηνπ Hooke πξνθχπηεη: 

 

𝑛1 − 𝑛2 = 𝑐 ∗  𝜎1 − 𝜎2                                                                                                                   (2.4) 

 

΋πνπ  n1, n2 : νη δείθηεο δηάζιαζεο ηνπ θαηαπνλνχκελνπ κνληέινπ ζηηο δπν θάζεηεο κεηαμχ 
ηνπο δηεπζχλζεηο, c : ε ζηαζεξά ηνπ πιηθνχ  θαη ζ1,ζ2 : ε δηαθνξά ησλ θπξίσλ ηάζεσλ. 
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2.3. ΠΟΛΧ΢Η ΣΟΤ ΦΧΣΟ΢ 

 

΢χκθσλα κε ηελ θπκαηηθή ζεσξία ηνπ θσηφο, ην θνηλφ θσο απνηειείηαη απφ 
εγθάξζηα θχκαηα δηαθφξσλ ζπρλνηήησλ θαη δηεπζχλζεσλ, φπσο θαίλεηαη ζην ζρήκα     
2.3. 

 

΢τήμα 2.3. : Δγθάξζηα θχκαηα θσηφο δηαθφξσλ ζπρλνηήησλ θαη δηεπζχλζεσλ. 

 

Δάλ ην θνηλφ θσο πέζεη ζε κηα πάιηλε πιάθα κε θαηάιιειε γσλία πξφζπησζεο ηφηε 
ην αλαθιψκελν θσο απνηειείηαη απφ εγθάξζηα θχκαηα κε επίπεδα ηαιάλησζεο 
παξάιιεια κεηαμχ ηνπο θαη θάζεηα ζηελ δηάδνζε ηνπ θχκαηνο. ΢ηελ πεξίπησζε απηή ην 
θσο θαιείηαη πνιωκέλν, ΢ρ. 2.5. Σν δηάλπζκα ηνπ πνισκέλνπ θσηφο θηλείηαη πάλσ ζε 
νξηζκέλε ηξνρηά, θάζεηε ζηελ δηεχζπλζε ηνπ θχκαηνο, Υαξαθηεξηζηηθφ είλαη ην ΢ρ. 2.4. 

 

 

΢τήμα 2.4. : (α) Δπίπεδα πνισκέλν θσο, (β) Κπθιηθά πνισκέλν θσο, 

(γ) Διιεηπηηθά πνισκέλν θσο. 

 

 

 

 

 

http://dspace.lib.ntua.gr/bitstream/123456789/3212/3/kravvaritisi_crack.pdf
http://www.teiser.gr/icd/staff/bozikis/Physics2/lab/f2-lab-02.pdf


19 
 

 Δπίπεδα πολωμένο θως: είλαη ην θσο φπνπ ην δηάλπζκα ηνπ θσηφο βξίζθεηαη 
πάλσ ζε επζεία γξακκή θάζεηε πξνο ηελ δηεχζπλζε δηάδνζεο ,ραξαθηεξηζηηθφ είλαη 
ην ΢ρ. 2.5. 

 

 Κσκλικά πολωμένο θως: είλαη ην θσο φπνπ ην δηάλπζκα ηνπ θσηφο θηλείηαη ζε 
θπθιηθή ηξνρηά ,ην επίπεδν ηεο νπνίαο είλαη θάζεην ζηελ δηεχζπλζε δηάδνζεο. 
Δπνκέλσο θαηά ηελ δηάδνζε ηνπ θπθιηθά πνισκέλνπ θσηφο ζρεκαηίδεηαη θπθιηθή 
έιηθα. ,ραξαθηεξηζηηθφ είλαη ην ΢ρ. 2.5. 

 

 Δλλειπηικά πολωμένο θως: είλαη ην θσο φπνπ ην δηάλπζκα ηνπ θσηφο θηλείηαη επί 
ειιεηπηηθήο ηξνρηάο ζην επίπεδν ηεο νπνίαο είλαη θάζεην ζηελ δηεχζπλζε δηάδνζεο. 
Καηά ηελ δηάδνζε ηνπ ειιεηπηηθά πνισκέλνπ θσηφο ζρεκαηίδεηαη ειιεηπηηθή έιηθα. 

 

 

΢τήμα 2.5. : Απεηθνλίδεηαη ζηελ Γεμηά πιεπξά ην επίπεδν πνισκέλν θσο θαη ζηελ 

αξηζηεξή πιεπξά ην θπθιηθφ πνισκέλν θσο.  

 

 

 

2.4. I΢ΟΥΡΧΜΑΣΙΚΔ΢ ΚΑΙ Ι΢ΟΚΛΙΝΔΙ΢ ΚΑΜΠΤΛΔ΢ 

 

΋ηαλ νη δπν θσηεηλέο δέζκεο θηάζνπλ ζηνλ αλαιπηή ζε θάζεηε δηάηαμε απηφο ζα 
επηηξέςεη λα δηέιζνπλ κφλν νη νξηδφληηεο ζπληζηψζεο. Έλαο παξαηεξεηήο βιέπεη κέζα 
απφ ηνλ αλαιπηή ηελ ζπληζηάκελε ηνπο. Οη ζπληζηψζεο απηέο ζπλδπάδνληαη θαη 
ζρεκαηίδνπλ ηνπο θξνζζνύο ζπκβνιήο , ραξαθηεξηζηηθφ είλαη ην ΢ρ. 2.6. 

Αλ ε πεγή δίλεη κνλνρξωκαηηθό θωο, π.ρ. πξάζηλν ηνπ πδξάξγπξνπ ή θίηξηλν ηνπ 
λάηξηνπ, ηφηε νη θξνζζνί εκθαλίδνληαη σο δηαθξηηηθέο καύξεο δώλεο ζε έλα νκνηφκνξθν 
πξάζηλν ή θίηξηλν θφλην. Φπζηθά απηέο νη καχξεο δψλεο αληηζηνηρνχλ ζε ζεκεία φπνπ ε 
δηάθνξα θάζεο κεηαμχ ησλ δπν θσηεηλψλ δεζκψλ, πνπ εμέξρνληαη απφ ην θσηνειαζηηθφ 
κνληέιν, είλαη αθέξαην πνιιαπιάζην ηνπ κήθνπο θφκκαηνο ι θαη επνκέλσο πξνθχπηνπλ 
ζθνηεηλέο γξακκέο πνπ νλνκάδνληαη ηζνρξωκαηηθέο. 

΢ε αληίζεηε πεξίπησζε αλ ε πεγή δίλεη ιεπθό θωο, δειαδή θσο κε φια ηα κήθε 
θχκαηνο, ηφηε νη θξνζζνί εκθαλίδνληαη κε δηάθνξα ρξψκαηα. Κάζε κήθνο θχκαηνο ζα 
δεκηνπξγήζεη ηζνρξσκαηηθέο θαη ν παξαηεξεηήο ζα βιέπεη κηα έγρξωκε εηθόλα 
ηζνρξσκαηηθψλ.  

 

https://www.google.gr/search?q=%CF%80%CE%BF%CE%BB%CF%89%CF%83%CE%B7+%CF%86%CF%89%CF%84%CF%8C%CF%82&bav=on.2,or.r_cp.r_qf.&biw=1366&bih=624&um=1&ie=UTF-8&hl=el&tbm=isch&source=og&sa=N&tab=wi
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 ΢τήμα 2.6. : Δκθάληζε έγρξσκσλ ηζνρξσκαηηθψλ ιφγσ ιεπθνχ θσηφο. 

 

 

Οη κνλνρξωκαηηθέο πήγεο πξνηηκνχληαη γηα αθξηβείο θσηνειαζηηθέο κεηξήζεηο, 
θαζψο κπνξνχκε λα δηαθξίλνπκε θαζαξά έλα κεγάιν αξηζκφ θξνζζψλ, φπσο π.ρ. ζε 
ζέζεηο ζπγθέληξσζεο ηάζεσλ. 

Σψξα αλ ε πεγή δίλεη κνλνρξσκαηηθφ θσο, ζηελ πεξίπησζε ηνπ επίπεδνπ 
πνιωκέλνπ θωηόο, θαίλνληαη ζθνηεηλά φια ηα ζεκεία ηνπ κνληέινπ κε δηάθνξα θάζεο 
Γ=1,2,3,4,5 θ.η.ι. Παξαηεξνχληαη δε ζην κνληέιν ζθνηεηλέο γξακκέο, νη ηζνρξσκαηηθέο , 
΢ρ. 2.7.  

 

 

 

΢τήμα 2.7. : Σν δίθηπν ησλ ηζφρξσκσλ ζε δνθίκην θαζαξήο θάκςεο. 

΢ηελ πεξίπησζε πάληα ηνπ επίπεδνπ πνισκέλνπ θσηφο θαη αλεμάξηεηα απφ ην 
είδνο ηεο θσηεηλήο πεγήο, ζην κνληέιν εθηφο απφ ηηο ηζνρξσκαηηθέο εκθαλίδνληαη θαη 
άιιεο καχξεο γξακκέο ζηα ζεκεία πνπ ε δηεχζπλζε ηεο κηαο θχξηαο ηάζεο ζπκπίπηεη κε 
ηνλ άμνλα πφισζεο. Οη γξακκέο απηέο νλνκάδνληαη ηζνθιηλείο. 

 

 

 

https://www.google.gr/search?gs_rn=16&gs_ri=psy-ab&tok=gTUCfUB56mJaVR8SZDnwvQ&suggest=p&pq=%CE%B4%CE%B9%CE%AC%CE%B4%CE%BF%CF%83%CE%B7+%CF%84%CE%BF%CF%85+%CF%86%CF%89%CF%84%CF%8C%CF%82+%CF%83%CE%B5+%CE%B4%CE%B9%CE%AC%CF%86%CE%BF%CF%81%CE%B5%CF%82+%CE%BA%CE%
file:///C:\Documents and Settings\stsinop\My Documents\Downloads\���������� ����������� ��� ��� ���������� ��� ��������������.
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2.5. ΠΟΛΧ΢ΙΟ΢ΚΟΠΙΟ GS 2 C 

 

Σα πεηξάκαηα ηεο θσηνειαζηηθφηεηαο έγηλαλ κε ρξήζε ηεο ζπζθεπήο ηνπ 
Πνισζηνζθνπίνπ GS 2 C πνπ δηαζέηεη ην Δξγαζηήξην ηεο Αληνρήο ησλ Τιηθψλ ηνπ 
Σκήκαηνο Μεραλνινγίαο ηνπ ΣΔΗ Πάηξαο, ραξαθηεξηζηηθφ είλαη ην ΢ρ.2.8. θαη κέζσ απηψλ 
πξαγκαηνπνηείηαη κειέηε ηεο θαηαλνκήο ησλ ηάζεσλ ζηα ππφ εμέηαζε δνθίκηα.  

 

 
΢τήμα 2.8. : Πνισζηνζθφπην GS 2 C πνπ δηαζέηεη ην Δξγαζηήξην ηεο Αληνρήο ησλ Τιηθψλ 

ηνπ Σκήκαηνο Μεραλνινγίαο ηνπ ΣΔΗ Πάηξαο. 

 

 

  Σν πνισζηνζθφπην GS 2 C είλαη έλαο θνξεηφο ειεγθηήο ηάζεσλ κε δηαρεφκελν 
θσο. Ή δηάκεηξνο ηνπ πεδίνπ είλαη 300 ή 450 mm. Απηά ηα φξγαλα απνηεινχληαη απφ δχν 
κέξε : 

 

1. Μέρος P  με ηον πολωηή 

΢ην ηκήκα Ρ ππάξρνπλ θσηεηλέο πεγέο γηα άζπξν θαη γηα κνλνρξσκαηηθφ θσο 
(ιάκπεο αηκνχ λαηξίνπ) έλαο δηάρπηεο θσηφο, ν πξαγκαηηθφο πνισηήο κε έλα βέινο ζηελ 
πεξηθέξεηα, έλαο δίζθνο L/4 κε ζεκεία απφ 0˚ έσο 45˚ θαη ζην ηέινο έλα πξνζηαηεπηηθφ 
γπαιί. ΋ πνισηήο θαη ν δίζθνο L/4 είλαη πεξηζηξεθφκελνη. Γηα ηελ αλάγλσζε ηεο γσλίαο 
ππάξρεη κηα θιίκαθα απφ 0˚ έσο 180˚ θαη ζηηο δπν δηεπζχλζεηο ππνδηαηξεκέλε ζε ζέζεηο 
αλά 10 βαζκνχο θαη κηα νπή δείθηεο ζηελ θνξπθή .  
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2. Μέρος Α με ηον αναλσηή 

 Σν ηκήκα Α απαξηίδεηαη απφ έλα πξνζηαηεπηηθφ γπαιί, δίζθν L/4 κε θιίκαθα γηα 
γσλίεο απφ 0˚ έσο 180˚ θαη ζηηο δχν δηεπζχλζεηο ππνδηαηξεκέλε ζε 1/1˚, έλαο 
πνισηήο ζαλ πξαγκαηηθφο αλαιπηήο κε έλα βέινο ζηελ πεξηθέξεηα θαη έλα δεχηεξν 
πξνζηαηεπηηθφ γπαιί. 
 

 ΋ δίζθνο L/4 θαη ν πνισηήο είλαη επίζεο πεξηζηξεθφκελνη, ε θιίκαθα κέηξεζεο ηεο 
γσλίαο είλαη απφ 0˚ έσο 180˚ θαη ζηηο δχν δηεπζχλζεηο ππνδηαηξεκέλε ζε ζέζεηο αλά 
10 βαζκνχο κε νπή δείθηε ζηελ θνξπθή. ΢ηελ βάζε ηνπ ηκήκαηνο Α ππάξρνπλ 
δηαθφπηεο γηα θσηηζκφ θαη ζπγρξνληζκφ απνηεινχκελν απφ  κηα ζχγρξνλε 
γελλήηξηα θαη έλα ζχγρξνλν θηλεηήξα.  

 

Σα κέξε Ρ θαη Α ηνπνζεηνχληαη ην έλα απέλαληη ζην άιιν θαη ζπλδένληαη κε έλα 
θαιψδην. Ο πνισηήο θαη ν αλαιπηήο πξέπεη λα είλαη παξάιιεινη θαη ε απφζηαζε κεηαμχ 
ηνπο φρη κεγαιχηεξε απφ ηελ πξέπνπζα , πεξίπνπ 1 m .Σν πξνο εμέηαζε αληηθείκελν 
πξέπεη λα ηνπνζεηεζεί θνληά ζηνλ πνισηή. ΋ηαλ παίξλνπκε θσηνγξαθία κε θσηνγξαθηθή 
κεραλή ε απφζηαζε κνληέινπ θαη αλαιπηή πξέπεη λα είλαη κηθξή. Σν κήθνο 
αθηηλνζθνπήζεσο ησλ θαθψλ πξέπεη λα είλαη κεγάιν.   

 

΢ην ζρήκα 2.9 απεηθνλίδεηαη ην πνισζηνζθφπην GS 2 

 

 

΢τήμα 2.9. : απεηθφληζε πνισζηνζθφπην GS 2 c. 

 

 

 

 

 

 

 

 

 

 

file:///C:\Documents and Settings\stsinop\My Documents\Downloads\���������� ����������� ��� ��� ���������� ��� ��������������.


23 
 

2.6. ΛΔΙΣΟΤΡΓΙΑ ΠΟΛΧ΢ΙΟ΢ΚΟΠΙΟΤ GS 2 C 
 

1. Ηλεκηρική Δνέργεια: 220 V, 50 Ηz.  

Σν πνισζηνζθφπην, ζπλδέεηαη κε ειεθηξηθφ ξεχκα 200 V, ζπρλφηεηα  50 Ζz θαη 
ηέινο έλαο αλεκηζηήξαο μεθηλά απηνκάησο ζηνλ πνισηή γηα ηελ ςχμε. 

 

2. Φωηιζμός: Λεσκός ή μονοτρωμαηικός.  

Oη δηαθφπηεο γηα ηνπο θσηηζκνχο είλαη ζηε βάζε ηνπ αλαιπηή .Ο δηαθφπηεο ηνπ 
ιεπθνχ θσηφο έρεη ην γξάκκα “L” θαη γηα ην κνλνρξσκαηηθφ θσο ην γξάκκα “Ν” .Οη ιάκπεο 
αηκψλ Ναηξίνπ ζέινπλ 5 ιεπηά γηα λα παξάγνπλ κνλνρξσκαηηθφ θσο θαη νη δπν θσηεηλέο 
πήγεο κπνξνχλ ακέζσο λα αλάςνπλ χζηεξα απφ ζβήζηκν ρσξίο θίλδπλν. ΋ δηαθφπηεο “Α” 
είλαη γηα ην SYNCHRO.  

 

3.  Η τρήζη ηοσ SYNCHRO 
Γηα λα ρξεζηκνπνηήζνπκε ηo SYNCHRO, πξέπεη :  
 

 Πνισηήο θαη αλαιπηήο λα είλαη ζηε ζέζε κεδέλ (γξακκηθή πφισζε) ή ζηελ 
δηαγψληα ζέζε (θπθιηθή πφισζε)  

 Σα ζπλδεηηθά ηζηκπηδάθηα ζηνλ αλαιπηή θαη ζηνλ πνισηή λα είλαη ζηελ 
θαηάιιειε ζέζε.  

 Οη θνριίεο ζηνλ πνισηή θαη ζηνλ αλαιπηή λα είλαη ραιαξσκέλνη.  

 

Πηέδνπκε ηνλ δηαθφπηε Α ζηε βάζε ηνπ αλαιπηή. ΋ηαλ ζηξέθνπκε ηνλ ζπλδεδεκέλν 
δίζθν L/4 θαη ηνλ πνισηή ζηνλ αλαιπηή κε ην ρέξη, ν δίζθνο L/4 θαη ν πνισηήο επίζεο 
ζπλδεδεκέλα ζηνλ πνισηή αθνινπζνχλ απηνκάησο θαη ζπγρξφλσο ηελ ίδηα δηεχζπλζε θαη 
ή γσλία παξακέλεη ή ίδηα.  

 

ΠΡΟ΢ΟΧΗ: Απηή ή κεηαθίλεζε πξέπεη λα είλαη αξγή θαη απαιή.  

΢ηελ πεξίπησζε ιάζνπο ζβήλνπκε ην SYΝCHRO θαη θάλνπκε επαλεθθίλεζε  

 

4. Δίδος πόλωζης: Γραμμική και κσκλική 

Σν είδνο ηεο πφισζεο είλαη δπλαηφ λα κεηαβιεζεί κε ηελ πεξηζηξνθή ησλ 
ηεζζάξσλ ζηνηρείσλ πφισζεο. Γηα θάζε ζέζε ππάξρνπλ κεξηθά ελδεηθηηθά ζεκεία θαη 
θιίκαθεο. Kαη’ αξράο ππάξρνπλ δχν ζηαζεξέο ελδεηθηηθέο νπέο ζηελ θνξπθή ηνπ πνισηή 
θαη αλαιπηή γηα γσλίεο ζηελ πεξηθέξεηα απφ 0˚ έσο 180˚ πξνο ηηο δχν δηεπζχλζεηο 
ππνδηαηξεκέλεο ζε ζέζεηο αλά 10 βαζκνχο. ΢ηελ πεξηζηξεθφκελε πιάθα L/4 ηνπ πνισηή 
νη ζέζεηο είλαη πεξηθεξεηαθά ησλ 0ν θαη 45ν . Δπί ηεο πεξηζηξεθφκελεο πιάθαο L/4 ηνπ 
αλαιπηή ππάξρεη πεξηθεξεηαθά κηα θιίκαθα απφ 0˚ έσο 180˚ πξνο ηηο δχν δηεπζχλζεηο 
ππνδηαηξεκέλεο ζε 1/1˚. Οη πεξηζηξεθφκελνη πνισηέο ζηνλ πνισηή θαη ηνλ αλαιπηή 
δείρλνπλ κφλν έλα βέινο ζηελ πεξηθέξεηα ηνπο. Απηά ηα βέιε είλαη δηεπζεηεκέλα κε ηέηνην 
ηξφπν ψζηε φηαλ ζπκπέζνπλ ε ζέα ηνπ πεδίνπ γίλεηαη καχξε. 

 

 

 

 

 

 



24 
 

i. Γξακκηθή πόιωζε (ζέζε 0) 
Πξηλ ελεξγνπνηήζνπκε ηε γξακκηθή πφισζε ραιαξψλνπκε ηηο δπν βίδεο θαη 

ζέηνπκε φια ηα ζεκεία ησλ πνισηψλ θαη ησλ πιαθψλ L/4 ζηελ ζέζε κεδέλ ησλ θιηκάθσλ. 
Δάλ φια ηα ζεκεία κεδέλ ζπκπίπηνπλ, έρνπκε γξακκηθή πφισζε θαη ζέα καχξνπ πεδίνπ. 
Γηα θαιχηεξν έιεγρν κπνξνχκε λα ρξεζηκνπνηήζνπκε ηνπο ξπζκηδφκελνπο θνριίεο ζηε 
βάζε ηνπ αλαιπηή. Οη πνισηέο ζηνλ πνισηή θαη αλαιπηή είλαη πνισκέλνη ζηαπξσηά θαη νη 
δίζθνη L/4 απνδεηθλχνληαη κε επαξθείο.  

Λακβάλνληαο ππφςε ηελ ζπνπδαηφηεηα απηήο ηεο ζέζεσο έλα ηζηκπηδάθη  
αζθαιείαο ζε κνξθή θνξηηζκέλνπ ζπλδεηηθνχ ειαηεξίνπ πξνζηίζεηαη ζηνλ πνισηή θαη 
αλαιπηή. Δθφζνλ ηα ειαηεξησηά ηζηκπηδάθηα δξνπλ, νη πνισηέο θαη νη πιάθεο L/4 
ζηξέθνληαη κφλν ζπγρξφλσο. Έηζη είλαη απαξαίηεην γηα λα πάξνπκε ζπγρξνληζκέλε 
πεξηζηξνθηθή θίλεζε.  

 

ii. Κπθιηθή πόιωζε (δηαγώληνο ζέζε) 
Γηα ηελ θπθιηθή πφισζε, ν πνισηήο ζηνλ πνισηή θαη ε πιάθα L/4 ζηνλ αλαιπηή 

πξέπεη λα είλαη ζηε ζέζε κεδέλ. Γηα λα θξαηήζνπκε απηά ηα ζηνηρεία ζε απηέο ηηο ζέζεηο 
ρξεζηκνπνηνχκε ηνπο δχν θνριίεο ζηνλ πνισηή θαη αλαιπηή. Σφηε απνκαθξχλνπκε ηα δχν 
ζπλδεηηθά ηζηκπηδάθηα θαη ζηξέθνπκε ηηο πιάθεο L/4 ζηνλ πνισηή θαη ηνλ πνισηή ζηνλ 
αλαιπηή 45 βαζκνχο θαηά δηεχζπλζε αληίζεηε πξνο ηελ θνξά ησλ δεηθηψλ ηνπ ξνινγηνχ. 
΢ε απηέο ηηο ζέζεηο ζα βξνχκε ηφηε λέεο νπέο γηα ηα ζπλδεηηθά ηζηκπηδάθηα, γηα λα 
δηαηεξήζνπκε ηε θιίζε γηα θπθιηθά πνισκέλν θσο.  
 
 

5. Μεηρήζεις ηων θωηοελαζηικών δεδομένων με ηην βοήθεια ηων δίζκων L/4 
(μέθοδος SENARMONT) 

 

Γηα λα αξρίζνπκε ηηο κεηξήζεηο ησλ θσηνειαζηηθψλ δεδνκέλσλ ζε δηαθαλέο 
κνληέιν κε ην πνισζηνζθφπην πξέπεη:  

 ΋ιεο νη ζέζεηο πξέπεη λα είλαη ζην κεδέλ. 

 Σν θσο πξέπεη λα είλαη κνλνρξσκαηηθφ. 

 ΋ δηαθφπηεο Α πξέπεη λα είλαη ζηε ζέζε ΟΝ. 

 

 Παξαηεξψληαο κέζα απφ ηνλ αλαιπηή παξαηεξνχκε γξακκέο έγρξσκεο θαη 
καχξεο ζην κνληέιν πνχ ζα εμεηαζηεί. Τπάξρεη έλα καχξν πεδίν γχξσ απφ ην αληηθείκελν. 
΢ηξέθνληαο ην αληηθείκελν νη έγρξσκεο γξακκέο δελ αιιάδνπλ, νη καχξεο γξακκέο φκσο 
θηλνχληαη. Απηέο είλαη νη ηζνθιηλείο γξακκέο.  

΢ηελ πξάμε δελ πξέπεη λα ζηξέθεηαη ην κνληέιν πνπ εμεηάδεηαη. Ο θαηαζθεπαζηήο 
ηνπ πνισζηνζθνπίνπ επηηξέπεη λα ζηξέθεηαη ν αλαιπηήο. Πξψηα ζηξέθνπκε ηνλ αλαιπηή 
έσο φηνπ κηα ηζνθιηλείο επαλεκθαληζζεί ζην ζεκείν έξεπλαο ηνπ κνληέινπ. Σφηε 
ζηξέθνπκε ην SYΝCHRO θαηά 45˚ θαηά ηελ δηεχζπλζε ησλ δεηθηψλ ηνπ ξνινγηνχ θαη 
ζβήλνπκε ην SYΝCHRO. Απηφ θαηαιήγεη ζε θπθιηθά πνισκέλν θσο. Μεηά ζθίγγνπκε ηηο 
βίδεο ζηνλ αλαιπηή, ηξαβάκε έμσ ηα ειαηήξηα ζπλδέζεσο θαη ζηξέθνπκε ηνλ πνισηή ζηνλ 
αλαιπηή έσο φηνπ ε ηζνθιηλήο επαλεκθαληζζεί ζην πξνο εξεπλά ζεκείν.  

Ζ γσλία ζηξνθήο W κπνξεί λα δηαβαζηεί ζηνλ αλαιπηή θαη ρξεζηκνπνηνχκε ηνλ 
αθφινπζν ηχπν γηα ηνλ ππνινγηζκφ ηνπ: 

 

𝑔 = 589 ∗
10−6

180
∗ 𝑊  (𝑚𝑚)                                                                                         (2.5) 
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Σε δηαθνξά ησλ θξνζζψλ  ελφο κνληέινπ ηελ ππνινγίδνπκε σο εμήο. : 

𝑛1 − 𝑛2 = 589 ∗
10−6

180
∗

𝑊

𝑑
  (𝑚𝑚)                                                                               (2.6) 

 

2.7. PLEXIGLAS 

Πολύμεθακρσλικό μεθύλιο (ΡΜΜΑ) είλαη έλα δηαθαλέο ζεξκνπιαζηηθφ πιηθφ , 
ρξεζηκνπνηείηαη ζπρλά σο έλα ειαθξχ ή αληηζξαπζηηθά ελαιιαθηηθή ιχζε γηα ην γπαιί . Αλ 
θαη δελ είλαη ηερληθά έλα είδνο γπαιηνχ, ε νπζία έρεη κεξηθέο θνξέο ηζηνξηθά 
θιεζεί ακρσλικό γσαλί. Υεκηθψο, είλαη ην ζπλζεηηθφ πνιπκεξέο  ηνπ κεζαθξπιηθνχ 
κεζπιίνπ. Σν πιηθφ απηφ αλαπηχρζεθε ην 1928 ζε δηάθνξα εξγαζηήξηα απφ πνιινχο 
ρεκηθνχο, φπσο ηνπο  William Chalmers, Otto Rohm θαη Walter Bauer θαη ην έθεξαλ γηα 
πξψηε θνξά ζηελ αγνξά ην 1933 απφ ηελ εηαηξία Rohm θαη Raas , ζχκθσλα κε ην 
εκπνξηθφ ζήκα ηεο Plexiglas.  Απφ ηφηε έρεη πσιεζεί κε πνιιά δηαθνξεηηθά νλφκαηα , 
ζπκπεξηιακβαλνκέλσλ ησλ ACRYLITE, Lucite θαη Perspex. 

Σν ΡΜΜΑ πξνηηκάηαη ιφγσ ησλ κέηξησλ ηδηνηήησλ ηνπ, ηνλ εχθνιν ρεηξηζκφ ,ηελ 
επεμεξγαζία θαη ην ρακειφ θφζηνο. Σν ΡΜΜΑ ζπκπεξηθέξεηαη κε έλα εχζξαπζην ηξφπν 
φηαλ θνξηψλεηαη, εηδηθά απφ κία δχλακε θξνχζεο . 

 

 

Ι΢ΣΟΡΙΑ 

Σν πξψην αθξπιηθφ νμέσο δεκηνπξγήζεθε ην 1843.  Απφ ην Μεζαθξπιηθφ , 
πξνέξρεηαη ην αθξπιηθφ νμχ θαη δηαηππψζεθε ην 1865. Ζ αληίδξαζε κεηαμχ ηνπ 
κεζαθξπιηθνχ νμένο θαη ηεο κεζαλφιεο έρεη ζαλ  απνηειέζκαηα ην κεζαθξπιηθφ κεζχιην. 
Οη Γεξκαλνί ρεκηθνί Wilhelm Rudolph Fittig θαη  Paul  αλαθάιπςαλ ην 1877 ηε δηαδηθαζία 
πνιπκεξηζκνχ πνπ κεηαηξέπεη ην κεζαθξπιηθφ κεζχιην ζε Πνιχκεζαθξπιηθφ κεζχιην. Σν 
1933 έλαο άιινο Γεξκαλφο ρεκηθφο, ν Otto Rνhm, θαηνρχξσζε κε δίπισκα επξεζηηερλίαο 
ην Plexiglas  κε εκπνξηθφ ζήκα. Σν 1936 ε πξψηε εκπνξηθά βηψζηκε παξαγσγή 
αθξπιηθνχ γπαιηνχ αζθαιείαο μεθίλεζε απφ ηελ ICI Acrylics (ηψξα Lucite International Δηθ. 
2.2.). Καηά ηελ δηάξθεηα ηνπ Β Παγθνζκίνπ Πνιέκνπ ην αθξηιηθφ γπαιί ρξεζηκνπνηείηε γηα 
ππνβξχρηα ,παξκπξίδ, ζηέγαζηξα θαη ζε αεξνπιάλα, ραξαθηεξηζηηθή είλαη ε Δηθ. 2.1.  

 

                                

Δικόνα 2.1. :To δηακέξηζκα ηεο κχηεο ηνπ          Δικόνα 2.2. : Αγαπεκέλε θαξθίηζα Lucite.  

βνκβαξδηζηηθνχ είλαη θαηαζθεπαζκέλν                    

απφ  Plexiglas (1943). 

 

http://en.wikipedia.org/wiki/Wilhelm_Rudolph_Fittig
http://en.wikipedia.org/wiki/File:B-17G_Nose_in_Detail.jpg
http://en.wikipedia.org/wiki/File:WWIIsweetheartpin.JPG
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ΟΝΟΜΑΣΑ 

Σν PMMA έρεη πσιεζεί θάησ απφ κηα πνηθηιία απφ κάξθεο θαη θνηλέο νλνκαζίεο. Αλ 
θαη αθξπιηθφ κπνξεί επίζεο λα αλαθέξεηαη ζε άιια πνιπκεξή ή ζπκπνιπκεξή πνπ 
πεξηέρνπλ  πνιπαθξπινληηξίιην. Άιιεο αμηνζεκείσηεο εκπνξηθέο νλνκαζίεο είλαη: 

 ACRYLITE 

 Lucite  

 Plexiglas  

 Optix (Plaskolite)   

 Perspex  

 Oroglas 

 Altuglas  

 

ΔΠΔΞΔΡΓΑ΢ΙΑ 

Ζ ζεξκνθξαζία κεηάπησζεο πάινπ (Σg) ηνπ ΡΜΜΑ είλαη 105 ° C (221 ° F). Οη ηηκέο 
Σg ησλ εκπνξηθψλ πνηνηήησλ ηεο ζεηξάο ΡΜΜΑ είλαη απφ 85 έσο 165 ° C (185 έσο 329 ° 
F). Ζ επεμεξγαζία κπνξεί λα γίλεη κε ρχηεπζε ζπκπεξηιακβαλνκέλεο ηεο ρχηεπζεο κε 
έγρπζε , ρχηεπζε κε ζπκπίεζε , θαη εμψζεζε . Σα πςειφηεξα πνηφηεηα θχιια ΡΜΜΑ 
παξάγνληαη απφ ρχηεπζε θπηηάξνπ , αιιά ζε απηή ηελ πεξίπησζε, νη βαζκίδεο 
πνιπκεξηζκνχ θαη ρπηεχζεσο ζπκβαίλνπλ ηαπηφρξνλα. Ζ αληνρή ηνπ πιηθνχ είλαη 
πςειφηεξε απφ ηνπο βαζκνχο ρπηεχζεσο ιφγσ ηεο εμαηξεηηθά πςειήο κνξηαθήο κάδαο . 

Δπίζεο ρξεζηκνπνηείηε θανπηζνχθ ζθιήξπλζεο  γηα λα απμήζεη ηελ αληνρή ηνπ, 
επεηδή  ην ΡΜΜΑ έρεη ςαζπξή ζπκπεξηθνξά φηαλ εθαξκφδνληαη θνξηία. 

 

ΑΚΡΤΛΙΚΗ ΡΗΣΙΝΗ ΥΤΣΔΤ΢Η΢ 

Σν κεζαθξπιηθφ κεζχιην " ή ζπλζεηηθή ξεηίλε " γηα ρχηεπζε κπνξεί λα 
ρξεζηκνπνηεζεί ζε ζπλδπαζκφ κε έλαλ θαηαιχηε πνιπκεξηζκνχ φπσο ην ΜΔΚΡ , έηζη 
παξάγνληαη δηαθαλέο ΡΜΜΑ πιηθά ζε νπνηνδήπνηε ζρήκα, απφ έλα θαινχπη.  

Σν PMMA είλαη έλα ηζρπξφ θαη ειαθξχ πιηθφ. Έρεη ππθλφηεηα απφ 1.17 έσο 1.20 gr 
/ cm 3, ε νπνία είλαη κηθξφηεξε απφ ην ήκηζπ ηνπ γπαιηνχ. Δπίζεο, έρεη θαιή αληνρή ζε 
θξνχζε, ,σζηφζν ε αληνρή ηνπ  ΡΜΜΑ εμαθνινπζεί λα είλαη ζεκαληηθά ρακειφηεξε απφ 
έλα πνιπαλζξαθηθφ πιηθφ .Σν ΡΜΜΑ αλαθιέγεηαη ζηνπο 460 ° C (860 ° F) ζρεκαηίδνληαο 
δηνμείδην ηνπ άλζξαθα , λεξφ ,  κνλνμείδην ηνπ άλζξαθα. 

Σν ΡΜΜΑ κεηαδίδεη έσο 92% ηνπ νξαηνχ θσηφο (3 mm πάρνο), θαη δίλεη κηα 
αληαλάθιαζε πεξίπνπ 4% ζε θάζε κηα επηθάλεηα ηνπ, βάζε ηνπ δείθηε δηάζιαζεο . 
Φηιηξάξεη ην ππεξηψδεο (UV) θσο ζε κήθε θχκαηνο θάησ απφ 300 nm (παξφκνηα κε 
ζπλεζηζκέλν γπαιί). ΢ην PMMA πεξλά ππέξπζξν θσο κέρξη 2800 nm . 

Σν ΡΜΜΑ έρεη κία κέγηζηε αλαινγία λεξνχ απνξξφθεζεο 0,3 - 0,4 % θαηά βάξνο. 
Ζ αληνρή ζε εθειθπζκφ κεηψλεηαη κε απμεκέλε απνξξφθεζε χδαηνο.  Ο ζπληειεζηήο 
ζεξκηθήο δηαζηνιήο είλαη ζρεηηθά πςειφο ζε (5-10) × 10 -5 Κ -1 .  
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ΤΠΟΚΑΣΑ΢ΣΑΣΟ ΣΟΤ ΓΤΑΛΙΟΤ 

 

Σν ΡΜΜΑ αθξπιηθή χαινο ρξεζηκνπνηείηαη ζπλήζσο γηα ηελ θαηαζθεπή θαηνηθηψλ 
θαη εκπνξηθψλ ελπδξείσλ . Σν ΡΜΜΑ ρξεζηκνπνηείηαη ζηνπο θαθνχο ,ζηα εμσηεξηθά θψηα 
ησλ απηνθηλήησλ. Ζ πξνζηαζία ησλ ζεαηψλ ζην ρφθετ επί πάγνπ -παγνδξφκηα γίλεηαη απφ 
PMMA. 

Ηζηνξηθά ην PMMA ήηαλ κηα ζεκαληηθή βειηίσζε ζην ζρεδηαζκφ ησλ παξαζχξσλ 
ησλ αεξνζθαθψλ, ψζηε λα θαηαζηεί δπλαηή, φπσο ην δηαθαλήο δηακέξηζκα ηνπ 
Bombardier ζηελ Boeing Β-17 . 

Ορήκαηα Αζηπλνκίαο γηα ηνλ έιεγρν , έρνπλ αληηθαηαζηήζεη ην γπαιί κε αθξπιηθφ 
ΡΜΜΑ γηα ηελ πξνζηαζία ησλ επηβαηψλ απφ εθηνμεπφκελα αληηθείκελα. Σν PMMA (κε ηελ 
επσλπκία "Lucite") ρξεζηκνπνηήζεθε γηα ηελ νξνθή ηνπ Υηνχζηνλ Astrodome, 
ραξαθηεξηζηηθή είλαη ε Δηθ. 2.3. 

 

          
        Δικόνα 2.3: νξνθή ηνπ Υηνχζηνλ Astrodome.         Δικόνα 2.4 : Βαζπζθάθνο Trieste. 

 

To Βαζπζθάθνο Trieste έρεη θσληθφ κνλφ παξάζπξν θαηαζθεπαζκέλν απφ PMMA 

(Plexiglas). Ο  πνιχ κηθξφο καχξνο θχθινο είλαη ε εζσηεξηθή πιεπξά ηνπ πιαζηηθνχ 

"παξάζπξνπ", θαη είλαη κφλν κεξηθά εθαηνζηά ζε δηάκεηξν. Ζ κεγαιχηεξε θπθιηθή δηαπγείο 

καχξε πεξηνρή αληηπξνζσπεχεη ηελ κεγαιχηεξε εμσηεξηθή πιεπξά ηνπ θψλνπ ην νπνίν 

είλαη έλα παρχ πιαζηηθφ "παξάζπξν", ραξαθηεξηζηηθή είλαη ε Δηθ. 2.4. 

 

ΙΑΣΡΙΚΔ΢ ΣΔΥΝΟΛΟΓΙΔ΢ ΚΑΙ ΔΜΦΤΣΔΤΜΑΣΑ 

 Σν ΡΜΜΑ έρεη έλα θαιφ βαζκφ ζπκβαηφηεηαο κε ην αλζξψπηλν ηζηφ θαη 
ρξεζηκνπνηείηαη ζηελ παξαζθεπή άθακπησλ ελδνθζάικησλ θαθψλ  ζην κάηη, θπξίσο 
γηα ηελ ζεξαπεία θαηαξξαθηψλ. Απηή ε ζπκβαηφηεηα αλαθαιχθζεθε ην Β' Παγθφζκην 
Πφιεκν. 

 ΢θιεξνί θαθνί επαθήο  ήηαλ ζπρλά θαηαζθεπαζκέλνη απφ απηφ ην πιηθφ. Οη καιαθνί 
θαθνί επαθήο θαηαζθεπάδνληαη ζπρλά απφ έλα ζρεηηθφ πνιπκεξέο. 

 ΢ηελ νξζνπεδηθή ρεηξνπξγηθή ην PMMA νζηψλ ηζηκέλην ρξεζηκνπνηείηαη γηα επέκβαζε 
θαη ηα εκθπηεχκαηα ηνπνζεηνχληαη θαη αλαδηακνξθψλνπλ ηα θαηεζηξακκέλα 
νζηά. Παξέρεηαη σο κία ζθφλε κε πγξφ κεζαθξπιηθφ κεζπιεζηέξα (ΜΜΑ). 

https://www.google.gr/search?q=%CE%BF%CF%81%CE%BF%CF%86%CE%AE+%CF%84%CE%BF%CF%85+%CE%A7%CE%B9%CE%BF%CF%8D%CF%83%CF%84%CE%BF%CE%BD+Astrodome&bav=on.2,or.r_cp.r_qf.&bvm=bv.47534661,d.d2k&biw=1366&bih=624&um=1&ie=UTF-8&hl=el&tbm=isch&source=og&sa=N&tab=wi&ei=
http://en.wikipedia.org/wiki/File:Bathyscaphe_Trieste_sphere.jpg
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Οη ρεηξνπξγνί κπνξνχλ λα θξίλνπλ ηελ ζεξαπεία ηνπ νζηηθνχ ηζηκέληνπ ΡΜΜΑ 
πηέδνληαο ηνλ αληίρεηξά ηνπο ζε απηφ. Μνινλφηη ην ΡΜΜΑ είλαη βηνινγηθά ζπκβαηφ, ην 
ΜΜΑ ζεσξείηαη λα είλαη έλα εξεζηζηηθφ θαη πηζαλφ θαξθηλνγφλν. Σν PMMA έρεη 
ζπλδεζεί επίζεο κε θαξδηνπλεπκνληθά γεγνλφηα ζην ρεηξνπξγείν ιφγσ ππφζηαζεο.  

Έλα κεηνλέθηεκα απηνχ ηνπ νζηηθνχ ηζηκέληνπ είλαη φηη ζεξκαίλεηαη  κέρξη 82.5 ° C 
(160.5 ° F) ελψ ε ξχζκηζε πνπ δέρεηαη κπνξεί λα πξνθαιέζεη ζεξκηθή λέθξσζε ηνπ 
γεηηνληθνχ ηζηνχ. Δπεηδή ην ΡΜΜΑ έρεη έλα Μέηξν Young  κεηαμχ 18 θαη 31 GPa, ε 
νπνία είλαη κεγαιχηεξε απφ εθείλε ηνπ θπζηθνχ νζηνχ (πεξίπνπ 14 GPa γηα 
αλζξψπηλε θινηψδεο νζηφ), νη ηάζεηο θνξηψλνληαη κέζα ζην ηζηκέλην θαη έηζη ην νζηφ 
δελ ιακβάλεη πιένλ κεραληθά ζήκαηα  λα ζπλερίζνπλ αλάπιαζε ηνπ νζηνχ. 

 Οδνληνζηνηρίεο θαηαζθεπάδνληαη ζπρλά απφ ΡΜΜΑ, θαη κπνξεί λα ρξσκαηίδνπλ  θαη 
λα ηαηξηάδνπλ κε ηα δφληηα ηνπ αζζελνχο θαη ηνπ ηζηνχ ησλ νχισλ 

 ΢ηελ αηζζεηηθή ρεηξνπξγηθή, κηθξνζθνπηθά ΡΜΜΑ κηθξνζθαηξίδηα αλαζηέιινληαη ζε 
θάπνην βηνινγηθφ πγξφ πνπ ηνπνζεηείηε θάησ απφ ην δέξκα γηα λα κεηψζεη ηηο ξπηίδεο 
θαη νπιέο κφληκα. 

 

ΚΑΛΛΙΣΔΥΝΙΚΔ΢ ΚΑΙ ΑΙ΢ΘΗΣΙΚΔ΢ ΥΡΗ΢ΔΙ΢ 

 Μνληέξλα έπηπια, εηδηθά ζηε δεθαεηία ηνπ 1960 θαη ηνπ 1970, ζθνπφο ηνπο ήηαλ λα 
δψζνπλ ζηα πξντφληα ηνπο κηα αηζζεηηθή δηαζηεκηθήο επνρήο. Ζ Lucite ελζσκάησζε 
θαη άιια πξντφληα απφ PMMA ζε ζρέδηα ηνπο. Πνιιά άιια πξντφληα (γηα παξάδεηγκα, 
θηζάξεο), κεξηθέο θνξέο θαηαζθεπάζηεθαλ κε αθξπιηθφ γπαιί γηα λα θάλνπλ ηα ζπρλά 
αδηαθαλή αληηθείκελα εκηδηαθαλέο. 

 Ζ Diasec είλαη κηα δηαδηθαζία ε νπνία ρξεζηκνπνηεί αθξπιηθφ γπαιί σο ππνθαηάζηαην 
ηνπ θαλνληθνχ γπαιηνχ .Απηφ γίλεηαη γηα ζρεηηθά ρακειφ θφζηνο, κηθξφ βάξνο, αληνρή 
ζξαχζεο θαη αηζζεηηθή . 

 Απφ πεξίπνπ ην 1960 θαη κεηά, γιχπηεο θαη θαιιηηέρλεο γπαιηνχ, φπσο ν Leroy Lamis 
άξρηζε λα ρξεζηκνπνηεί αθξπιηθά, ιακβάλνληαο  πιενλεθηήκαηα  ηεο επειημίαο ηνπ 
πιηθνχ, ην ειαθξχ βάξνο, ην θφζηνο θαη ηελ ηθαλφηεηά ηεο λα δηαζινχλ ην θσο θαη ην 
θηιηξάξηζκα. 

 ΢ηε δεθαεηία ηνπ 1950 θαη ηνπ 1960, ην Lucite ήηαλ έλα εμαηξεηηθά δεκνθηιέο πιηθφ γηα 
θνζκήκαηα, κε αξθεηέο εηαηξείεο πνπ εηδηθεχνληαη ζηελ δεκηνπξγία πςειήο πνηφηεηαο 
θνκκάηηα απφ ην πιηθφ απηφ. Οη Lucite ράληξεο θαη ζηνιίδηα εμαθνινπζνχλ λα 
πσινχληαη απφ ηνπο πξνκεζεπηέο. 

 Σα αθξπιηθά θχιια παξάγνληαη ζε δεθάδεο βαζηθά ρξψκαηα, ζπλήζσο πσινχληαη κε 
ηε ρξήζε  ρξσκάησλ φπνπ αλαπηχρζεθε απφ ηελ Rohm & Haas ην 1950. 

      

 

Δικόνα 2.5: Γιππηηθή απηνθίλεηνπ Perspex. 

http://en.wikipedia.org/wiki/File:Lexus_LF-A_Crystallised_Wind.jpg
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ΆΛΛΔ΢ ΥΡΗ΢ΔΙ΢ 

 Αθξπιηθφ ρξεζηκνπνηείηαη ζε θξεβάηηα καπξίζκαηνο, φπσο ε  δηαθαλέο επηθάλεηα πνπ 
ρσξίδεη ηνλ επηβάηε απφ ηηο ιάκπεο καπξίζκαηνο. Απηή ε έλσζε  επηηξέπεη ηελ  
δηέιεπζε ησλ ππεξησδψλ αθηηλψλ. 

 Σα θχιια ΡΜΜΑ ρξεζηκνπνηνχληαη ζπλήζσο ζηελ βηνκεραλία , θπκαίλνληαη απφ πάρε 
3 έσο 25 ρηιηνζηά (0.1 έσο 1.0 in).  

 Σα PMMA ρξεζηκνπνηνχληαη ζε laser disc νπηηθά κέζα ( CDs θαη  DVDs) . 

 Υξεζηκνπνηείηαη σο έλαο νδεγφο θσηφο γηα ηηο back lights ζε TFT-LCD . 

 Πιαζηηθή Οπηηθή Ίλα ρξεζηκνπνηείηαη γηα ηελ επηθνηλσλία ,γηα κηθξή απφζηαζε ε 
νπηηθή πιαζηηθή ίλα θαηαζθεπάδεηε απφ PMMA θαη ππεξθζνξησκέλα PMMA, 
επηζηξσκέλα κε θζνξηνχρν PMMA.  

 Σν PMMA επίζεο ρξεζηκνπνηείηε  εθηελψο σο έλαο πβξηδηθφο πχξαπινο  θαπζίκσλ. 

 ΢ηε δεθαεηία ηνπ 1960, αλαπηχρζεθε κηα ζεηξά απφ ειεθηξηθέο θηζάξεο θαη ηα κπάζα 
ησλ νπνίσλ ηα ζψκαηα έγηλαλ εληειψο απφ αθξπιηθφ. Σα κέζα απηά δηαηίζεληαη ζην 
εκπφξην κε ηελ Ampeg κάξθα. Ζ Ibanez  θαη ε BC Rich έρνπλ επίζεο αθξπιηθέο  
θηζάξεο. 

 Ludwig-Musser θάλεη κηα ζεηξά απφ αθξπιηθά ηχκπαλα πνπ νλνκάδεηαη Vistalites, θαη 
ρξεζηκνπνηνχληαη απφ ηνπο Led Zeppelin, κε ληξάκεξ ηνλ John Bonham . 

 Σα ηερλεηά λχρηα ελίνηε θαηαζθεπάδνληαη απφ αθξπιηθφ. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://translate.googleusercontent.com/translate_c?depth=1&ei=ozplUdqCIsjcOdDkgaAL&hl=el&prev=/search%3Fq%3D%25CF%2580%25CE%25BB%25CE%25B5%25CE%25BE%25CE%25B9%25CE%25B3%25CE%25BA%25CE%25BB%25CE%25B1%25CF%2582%2Bwikipedia%26hl%3Del%26biw%3D1366%26bih%3D624&rurl=translate.google.gr&sl=en&u=http://en.wikipedia.org/wiki/TFT_LCD&usg=ALkJrhh3Brd76IIFYENZLyfrNqQFjlNHQw
http://translate.googleusercontent.com/translate_c?depth=1&ei=ozplUdqCIsjcOdDkgaAL&hl=el&prev=/search%3Fq%3D%25CF%2580%25CE%25BB%25CE%25B5%25CE%25BE%25CE%25B9%25CE%25B3%25CE%25BA%25CE%25BB%25CE%25B1%25CF%2582%2Bwikipedia%26hl%3Del%26biw%3D1366%26bih%3D624&rurl=translate.google.gr&sl=en&u=http://en.wikipedia.org/wiki/Ampeg&usg=ALkJrhh8kjZXDKaR6qpb5k0sQuOtRIMUaQ
http://translate.googleusercontent.com/translate_c?depth=1&ei=ozplUdqCIsjcOdDkgaAL&hl=el&prev=/search%3Fq%3D%25CF%2580%25CE%25BB%25CE%25B5%25CE%25BE%25CE%25B9%25CE%25B3%25CE%25BA%25CE%25BB%25CE%25B1%25CF%2582%2Bwikipedia%26hl%3Del%26biw%3D1366%26bih%3D624&rurl=translate.google.gr&sl=en&u=http://en.wikipedia.org/wiki/Ibanez&usg=ALkJrhjagGluMGKWQphQExJErNAbJ1hERQ
http://translate.googleusercontent.com/translate_c?depth=1&ei=ozplUdqCIsjcOdDkgaAL&hl=el&prev=/search%3Fq%3D%25CF%2580%25CE%25BB%25CE%25B5%25CE%25BE%25CE%25B9%25CE%25B3%25CE%25BA%25CE%25BB%25CE%25B1%25CF%2582%2Bwikipedia%26hl%3Del%26biw%3D1366%26bih%3D624&rurl=translate.google.gr&sl=en&u=http://en.wikipedia.org/wiki/B.C._Rich&usg=ALkJrhhDlFdBCwoDF7VzcbZfmJQJadk5xg
http://translate.googleusercontent.com/translate_c?depth=1&ei=ozplUdqCIsjcOdDkgaAL&hl=el&prev=/search%3Fq%3D%25CF%2580%25CE%25BB%25CE%25B5%25CE%25BE%25CE%25B9%25CE%25B3%25CE%25BA%25CE%25BB%25CE%25B1%25CF%2582%2Bwikipedia%26hl%3Del%26biw%3D1366%26bih%3D624&rurl=translate.google.gr&sl=en&u=http://en.wikipedia.org/wiki/Ludwig-Musser&usg=ALkJrhgjO62LutIyPHMcmxf7bU65-uX0zw
http://translate.googleusercontent.com/translate_c?depth=1&ei=ozplUdqCIsjcOdDkgaAL&hl=el&prev=/search%3Fq%3D%25CF%2580%25CE%25BB%25CE%25B5%25CE%25BE%25CE%25B9%25CE%25B3%25CE%25BA%25CE%25BB%25CE%25B1%25CF%2582%2Bwikipedia%26hl%3Del%26biw%3D1366%26bih%3D624&rurl=translate.google.gr&sl=en&u=http://en.wikipedia.org/wiki/Led_Zeppelin&usg=ALkJrhj_xIXlZbjb0O1aIpk2iTh3UfFL-Q
http://translate.googleusercontent.com/translate_c?depth=1&ei=ozplUdqCIsjcOdDkgaAL&hl=el&prev=/search%3Fq%3D%25CF%2580%25CE%25BB%25CE%25B5%25CE%25BE%25CE%25B9%25CE%25B3%25CE%25BA%25CE%25BB%25CE%25B1%25CF%2582%2Bwikipedia%26hl%3Del%26biw%3D1366%26bih%3D624&rurl=translate.google.gr&sl=en&u=http://en.wikipedia.org/wiki/John_Bonham&usg=ALkJrhhTynBGWKoRrJOvE3KxG9czet-nDQ
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2.8. ΚΑΣΑ΢ΚΔΤΗ ΓΟΚΙΜΙΧΝ 

 

΢ην ρψξν ηνπ κεραλνινγηθνχ εξγαζηεξίνπ ηνπ Σκήκαηνο Μεραλνινγίαο 

πξαγκαηνπνηήζεθε έλα κεγάιν κέξνο θαηαζθεπήο ησλ δνθηκίσλ απφ αθξπιηθά θχιια 

κηθξψλ δηαζηάζεσλ Plexiglas (PMMA) γηα ηελ δηεμαγσγή ησλ πεηξακάησλ. 

Σα πεηξακαηηθά δνθίκηα θφπεθαλ αξρηθά ζε κνξθή νξζνγσλίνπ παξαιιειεπίπεδνπ 

γηα λα βνιεχνπλ ζηε ζηήξημε θαηά ην πείξακα. 

΢ηελ ζπλερεία πηάλνληαο ηα ζηελ δέζηξα δεκηνπξγήζακε νπέο κε ην δξάπαλν, 

αξρηθά κε κηθξήο δηακέηξνπ ηξππάλη θαη ζηγά-ζηγά απμάλακε ηε δηάκεηξν, ραξαθηεξηζηηθή 

είλαη ε Δηθ.2.6 θαη Δηθ 2.7. Γηα λα κελ ππάξμνπλ ξσγκέο πηέδακε πνιχ καιαθά πξνο ηα 

θάησ ην ηξππάλη. 

 

Δικόνα 2.6. : Γηάλνημε νπψλ  αξρηθά κε κηθξήο δηακέηξνπ ηξππάλη. 

 

 

Δικόνα 2.7. : Γηάλνημε νπψλ κε κεγαιχηεξεο δηακέηξνπ ηξππάλη. 

 

΢ηελ ζπλερεία ηα ηνπνζεηήζακε ηα δνθίκηα ζηελ πεηξακαηηθή ζπζθεπή 

πνισζηνζθνπίνπ φπνπ βξίζθεηαη ζην εξγαζηήξην Αληνρήο ησλ Τιηθψλ. 
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2.9. ΓΙΔΞΑΓΧΓΗ ΠΔΙΡΑΜΑΣΟ΢ 

Γηα ην πείξακα ρξεζηκνπνηήζεθαλ ηξία δνθίκηα πιηθνχ PLM-4B ηα νπνία έρνπλ 

ειαζηηθή ζπκπεξηθνξά θαη ζε κεγάιν βαζκφ νπηηθή επθξίλεηα θαη πέληε δνθίκηα ησλ 

αθξπιηθψλ PMMA (ην ιεγφκελν Plexiglas) ηα νπνία ρξεζηκνπνηήζεθαλ ιφγσ ηεο επθνιίαο 

εχξεζεο θαζψο θαη ηεο ρξεζηκνπνίεζεο ηνπο ζην εκπφξην. 

 

ΙΓΙΟΣΗΣΔ΢ ΤΛΙΚΧΝ 

΢ηνλ πίλαθα 2.1. δίλνληαη νη κεραληθέο ηδηφηεηεο ηνπ PLM-4B θαη ηνπ Plexiglas (PMMA).   

 

PLM-4B Plexiglas (PMMA) 

Μέηξν Διαζηηθφηεηαο  E= 0.13 GPa Μέηξν Διαζηηθφηεηαο  E=  3 GPa 

Λφγνο Poisson  v=0,45 Λφγνο Poisson  v=0,35 

Ππθλφηεηα  p=2680 kg/m3 Ππθλφηεηα  p=1200 kg/m3 

Πίνακας 2.1. :΢χγθξηζε ηδηνηήησλ πιηθψλ. 

Παξφια απηά ππάξρνπλ απψιεηεο ζηελ απεηθφληζε ησλ θσηνγξαθηψλ ιφγσ 

ζθαικάησλ πνπ παξαηεξήζεθαλ ζηελ πεηξακαηηθή ζπζθεπή (πνισζηνζθφπην) παξφιε 

ηελ πξνζπάζεηα πνπ έγηλε γηα ηε ζπληήξεζή ηεο. Δπίζεο ιφγσ ηεο ρξφληαο θζνξάο ησλ 

ππαξρφλησλ δνθηκίσλ θαζψο θαη νξηζκέλα θζαξκέλα ζεκεία ζηηο επηθάλεηεο ζηήξημεο ησλ 

δνθηκίσλ είραλ σο απνηέιεζκα παξαηήξεζε απσιεηψλ. Απψιεηεο παξαηεξήζεθαλ επίζεο 

θαη ζηελ ςεθηαθή κεραλή. 

Οη θσηνγξαθίεο-κεηξήζεηο έγηλαλ σο εμήο: 

1η θσηνγξαθία: Αθφξηηζην ζψκα 

2ηθσηνγξαθία: Φνξηηζκέλν ζψκα γξακκηθή πφισζε 0˚ 

3ηθσηνγξαθία: Φνξηηζκέλν ζψκα γξακκηθή πφισζε 90˚ 

3ηθσηνγξαθία: Φνξηηζκέλν ζψκα θπθιηθή πφισζε 0˚ 

5η θσηνγξαθία: Φνξηηζκέλν ζψκα θπθιηθή πφισζε 90˚ 

6η θσηνγξαθία: Τπεξθνξηηζκέλν ζψκα θπθιηθή πφισζε 90˚ 

Tα δνθίκηα PLM-4B ηα θνξηίδακε κε 400 gr βάξνο θαη κε ζηαζεξφ θνξηίν παίξλακε 

ηηο απαηηνχκελεο κεηξήζεηο πεξηζηξέθνληαο φπνηε ρξεηάδνληαλ ηνλ αλαιπηή. ΢ηηο 

πεξηπηψζεηο πνπ ππεξθνξηίδνληαη αζθνχκε βάξνο ίζν κε 1200 gr. ΢ηα δνθίκηα PMMA 

απιά αζθνχκε εθειθχζηεθεο δπλάκεηο κέρξη λα παξαηεξήζνπκε αιιαγή ζηελ νπηηθή 

ζπκπεξηθνξά ησλ δνθηκίσλ. ΢ηηο πεξηπηψζεηο ηνπ ππεξθνξηηζκέλνπ ζψκαηνο αζθνχκε 

εθειθπζηηθή δχλακε ιίγν πξηλ ηελ εκθάληζε ξσγκήο θαη παξάιιεια αζηνρία ηνπ πιηθνχ. 
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2.9.1. AΝΑΛΤ΢Η ΔΠΙΠΔΓΗ΢ ΟΡΘΟΓΧΝΙΑ΢ ΠΛΑΚΑ΢ ΜΔ ΟΠΗ. 
 

΢ηηο εηθφλεο 2.8 έσο 2.13 παξνπζηάδνληαη νη θσηνγξαθίεο πνπ ιήθζεζαλ θαηά ηε 

δηάξθεηα ηνπ θσηνειαζηηθνχ πεηξάκαηνο κε ηε ζεηξά πνπ αλαθέξεηαη ζηελ Παξάγξαθν 

2.9. 

 

 

Δικόνα 2.8.  : Αθφξηηζην ζψκα. 

 

 

Δικόνα 2.9.: Φνξηηζκέλν ζψκα γξακκηθή πφισζε 0˚. 
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Δικόνα 2.10.  : Φνξηηζκέλν ζψκα γξακκηθή πφισζε 90˚. 

 

 

 

 

Δικόνα 2.11.  :  Φνξηηζκέλν ζψκα θπθιηθή πφισζε 0˚. 
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Δικόνα 2.12.  : Φνξηηζκέλν ζψκα θπθιηθή πφισζε 90˚. 

 

 

 

 

Δικόνα 2.13.  : Τπεξθνξηηζκέλν ζψκα  θπθιηθή πφισζε 90˚. 
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2.9.2. ΑΝΑΛΤ΢Η ΢ΤΜΜΔΣΡΙΚΟΤ ΢ΧΜΑΣΟ΢. 

 

΢ηηο εηθφλεο 2.14 έσο 2.19 παξνπζηάδνληαη νη θσηνγξαθίεο πνπ ιήθζεζαλ θαηά ηε 

δηάξθεηα ηνπ θσηνειαζηηθνχ πεηξάκαηνο κε ηε ζεηξά πνπ αλαθέξεηαη ζηελ Παξάγξαθν 

2.9. 

 

Δικόνα 2.14. : Αθφξηηζην ζψκα. 

 

 

 

Δικόνα 2.15. : Φνξηηζκέλν ζψκα γξακκηθή πφισζε 0˚. 
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Δικόνα 2.16.:  Φνξηηζκέλν ζψκα γξακκηθή πφισζε 90˚. 

 

 

 

 

Δικόνα 2.17.:Φνξηηζκέλν ζψκα θπθιηθή πφισζε 0˚. 
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Δικόνα 2.18. : Φνξηηζκέλν ζψκα θπθιηθή πφισζε 90˚. 

 

 

 

Δικόνα 2.19. : Τπεξθνξηηζκέλν ζψκα  θπθιηθή πφισζε 90˚. 
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2.9.3. ΑΝΑΛΤ΢Η ΢ΤΜΜΔΣΡΙΚΟΤ ΢ΧΜΑΣΟ΢ ΜΔ ΣΟΞΑ ΑΠΟ PLM-4B. 

 

΢ηηο εηθφλεο 2.20 έσο 2.25 παξνπζηάδνληαη νη θσηνγξαθίεο πνπ ιήθζεζαλ θαηά ηε 

δηάξθεηα ηνπ θσηνειαζηηθνχ πεηξάκαηνο κε ηε ζεηξά πνπ αλαθέξεηαη ζηελ Παξάγξαθν 

2.9. 

 

Δικόνα 2.20. : Αθφξηηζην ζψκα. 

 

 

 

Δικόνα 2.21. : Φνξηηζκέλν ζψκα γξακκηθή πφισζε 0˚. 
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Δικόνα 2.22. : Φνξηηζκέλν ζψκα γξακκηθή πφισζε 90˚. 

 

 

 

Δικόνα 2.23. : Φνξηηζκέλν ζψκα  θπθιηθή πφισζε 0˚. 
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Δικόνα 2.24. : Φνξηηζκέλν ζψκα θπθιηθή πφισζε 90˚. 

 

 

 

 

Δικόνα 2.25. : Τπεξθνξηηζκέλν ζψκα θπθιηθή πφισζε 90˚. 
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2.9.4. ΑΝΑΛΤ΢Η ΢ΤΜΔΣΡΙΚΟΤ ΢ΧΜΑΣΟ΢ ΜΔ ΣΟΞΑ ΑΠΟ  PLEXIGLAS. 

 

΢ηηο εηθφλεο 2.26 έσο 2.31 παξνπζηάδνληαη νη θσηνγξαθίεο πνπ ιήθζεζαλ θαηά ηε 

δηάξθεηα ηνπ θσηνειαζηηθνχ πεηξάκαηνο κε ηε ζεηξά πνπ αλαθέξεηαη ζηελ Παξάγξαθν 

2.9. 

 

Δικόνα 2.26. : Αθφξηηζην ζψκα. 

 

 

 

Δικόνα 2.27. : Φνξηηζκέλν ζψκα γξακκηθή πφισζε 0˚. 
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Δικόνα 2.28. :Φνξηηζκέλν ζψκα γξακκηθή πφισζε 90˚. 

 

 

 

Δικόνα 2.29. : Φνξηηζκέλν ζψκα θπθιηθή πφισζε 0˚. 
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Δικόνα 2.30. : Φνξηηζκέλν ζψκα θπθιηθή πφισζε 90˚. 

 

 

 

 

Δικόνα 2.31. : Τπεξθνξηηζκέλν ζψκα θπθιηθή πφισζε 90˚. 
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2.9.5. ΑΝΑΛΤ΢Η ΟΡΘΟΓΧΝΙΑ΢ ΠΛΑΚΑ΢ ΜΔ 3 ΔΓΚΑΡ΢ΙΔ΢ ΟΠΔ΢. 

 

΢ηηο εηθφλεο 2.32 έσο 2.37 παξνπζηάδνληαη νη θσηνγξαθίεο πνπ ιήθζεζαλ θαηά ηε 

δηάξθεηα ηνπ θσηνειαζηηθνχ πεηξάκαηνο κε ηε ζεηξά πνπ αλαθέξεηαη ζηελ Παξάγξαθν 

2.9. 

 

Δικόνα 2.32. : Αθφξηηζην ζψκα. 

 

 

 

Δικόνα 2.33. : Φνξηηζκέλν ζψκα γξακκηθή πφισζε 0˚. 
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Δικόνα 2.34. : Φνξηηζκέλν ζψκα γξακκηθή πφισζε 90˚. 

 

 

 

 

Δικόνα 2.35. : Φνξηηζκέλν ζψκα θπθιηθή πφισζε 0˚. 
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Δικόνα 2.36. : Φνξηηζκέλν ζψκα θπθιηθή πφισζε 90˚. 

 

 

 

 

Δικόνα 2.37. : Τπεξθνξηηζκέλν ζψκα θπθιηθή πφισζε 90˚. 
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2.9.6. ΑΝΑΛΤ΢Η ΟΡΘΟΓΧΝΙΑ΢ ΠΛΑΚΑ΢ ΜΔ 2  ΟΠΔ΢. 

 

΢ηηο εηθφλεο 2.38 έσο 2.43 παξνπζηάδνληαη νη θσηνγξαθίεο πνπ ιήθζεζαλ θαηά ηε 

δηάξθεηα ηνπ θσηνειαζηηθνχ πεηξάκαηνο κε ηε ζεηξά πνπ αλαθέξεηαη ζηελ Παξάγξαθν 

2.9. 

 

Δικόνα 2.38. : Αθφξηηζην ζψκα. 

 

 

 

Δικόνα 2.39. : Φνξηηζκέλν ζψκα γξακκηθή πφισζε 0˚. 
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Δικόνα 2.40. : Φνξηηζκέλν ζψκα γξακκηθή πφισζε 90˚. 

 

 

 

 

Δικόνα 2.41. : Φνξηηζκέλν ζψκα θπθιηθή πφισζε 0˚. 
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Δικόνα 2.42. : Φνξηηζκέλν ζψκα θπθιηθή πφισζε 90˚. 

 

 

 

 

Δικόνα 2.43. : Τπεξθνξηηζκέλν ζψκα θπθιηθή πφισζε 90˚. 
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2.9.7. ΑΝΑΛΤ΢Η ΟΡΘΟΓΧΝΙΑ΢ ΠΛΑΚΑ΢ ΜΔ ΡΧΓΜΔ΢. 

 

΢ηηο εηθφλεο 2.44 έσο 2.49 παξνπζηάδνληαη νη θσηνγξαθίεο πνπ ιήθζεζαλ θαηά ηε 

δηάξθεηα ηνπ θσηνειαζηηθνχ πεηξάκαηνο κε ηε ζεηξά πνπ αλαθέξεηαη ζηελ Παξάγξαθν 

2.9. 

 

Δικόνα 2.44. : Αθφξηηζην ζψκα. 

 

 

 

Δικόνα 2.45. : Φνξηηζκέλν ζψκα γξακκηθή πφισζε 0˚. 
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Δικόνα 2.46. : Φνξηηζκέλν ζψκα γξακκηθή πφισζε 90˚. 

 

 

 

Δικόνα 2.47. : Φνξηηζκέλν ζψκα θπθιηθή πφισζε 0˚. 
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Δικόνα 2.48. : Φνξηηζκέλν ζψκα θπθιηθή πφισζε 90˚. 

 

 

Δικόνα 2.49. : Τπεξθνξηηζκέλν ζψκα θπθιηθή πφισζε 90˚. 
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΢ηηο εηθφλεο 2.50 παξνπζηάδνληαη νξηζκέλα δείγκαηα εηθφλσλ φπνπ ην 

πνισζηνζθφπην είλαη ζε ιεηηνπξγία θαη νη ιάκπεο αηκνχ Νάηξηνπ παξάγνπλ ζην ζχζηεκα 

κνλνρξσκαηηθφ θσο. 

 

 

 

Δικόνα 2.50. : Γείγκαηα εηθφλσλ φπνπ ην πνισζηνζθφπην είλαη ζε ιεηηνπξγία θαη νη 

ιάκπεο αηκνχ Νάηξηνπ παξάγνπλ ζην ζχζηεκα  κνλνρξσκαηηθφ θσο. 
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ΚΔΦΑΛΑΙΟ 3 : ΜΔΘΟΓΟ΢ ΠΔΠΔΡΑ΢ΜΔΝΧΝ ΢ΣΟΙΥΔΙΧΝ 
 

Ζ κέζνδνο ησλ πεπεξαζκέλσλ ζηνηρείσλ ρξεζηκνπνηείηαη επξέσο ζε πνιιά 
επηζηεκνληθά πξνβιήκαηα. Σα θπξηφηεξα πεδία εθαξκνγήο απηήο ηεο αξηζκεηηθήο 
κεζφδνπ είλαη γξακκηθά ή κε-γξακκηθά πξνβιήκαηα κεραληθψλ ζπλερψλ κέζσλ 
ξεπζηνκεραληθήο, κεηάδνζε ζεξκφηεηαο, ειεθηξνκαγλεηηζκνχ θιπ.  

Ζ βαζηθή αξρή ησλ πεπεξαζκέλσλ ζηνηρείσλ είλαη λα δηαηξέζνπκε έλα κεγάιν 
ζχζηεκα ζε κηθξέο ζπληζηψζεο ή ζηνηρεία ησλ νπνίσλ ηελ ζπκπεξηθνξά είλαη εχθνιν λα 
κειεηήζνπκε θαη θαηφπηλ λα αλαδεκηνπξγήζνπκε ην αξρηθφ ζχζηεκα απφ ηελ αλάιπζε 
ησλ ζπληζησζψλ ηνπ. Απηφο είλαη έλαο θπζηθφο ηξφπνο κε ηνλ νπνίν ν κεραληθφο, ν 
επηζηήκνλαο ή ν νηθνλνκνιφγνο αληηκεησπίδεη ηελ ιχζε πνιιψλ πξνβιεκάησλ. ΢ε πνιιέο 
πεξηπηψζεηο έλα κνληέιν ιακβάλεηαη κε ηε ρξήζε ελφο πεπεξαζκέλνπ αξηζκνχ 
ζπληζησζψλ. Ζ κέζνδνο ησλ πεπεξαζκέλσλ ζηνηρείσλ κπνξεί λα νξηζζεί σο ηελ ηερληθή 
ηεο πξνζέγγηζεο πξνβιεκάησλ ζπλερψλ κέζσλ έηζη ψζηε ην ζπλερέο κέζν λα δηαηξείηαη 
ζε νξηζκέλν αξηζκφ ζηνηρείσλ (πεπεξαζκέλσλ ζηνηρείσλ).  

 

 

3.1. ΠΡΟΓΡΑΜΜΑ ΠΔΠΔΡΑ΢ΜΔΝΧΝ ΢ΣΟΙΥΔΙΧΝ ANSYS 

 

3.1.1. ΓΤΝΑΣΟΣΗΣΔ΢ ΔΠΙΛΤ΢Η΢ 

 

Σν ANSYS είλαη έλα πξφγξακκα πεπεξαζκέλσλ ζηνηρείσλ γεληθνχ ζθνπνχ, 
ραξαθηεξηζηηθή είλαη ε Δηθ.3.1. Έρεη ηελ δπλαηφηεηα επίιπζεο ζηαηηθψλ θαη δπλακηθψλ 
πξνβιεκάησλ ξνήο ξεπζηψλ, αλάιπζεο θαηαζθεπψλ, κεηάδνζεο ζεξκφηεηαο, αθνπζηηθήο, 
ειεθηξηζκνχ θαη ειεθηξνκαγλεηηζκνχ. Με βάζε ηηο δπλαηφηεηεο επίιπζεο θαη ην κεξίδην 
πνπ θαηέρεη ζηελ αγνξά , ζεσξείηαη έλα απφ ηα ζεκαληηθφηεξα παθέηα πεπεξαζκέλσλ 
ζηνηρείσλ γηα πάλσ απφ 30 έηε. Έρεη ρξήζε ζε πνιινχο ηνκείο εθαξκνζκέλεο κεραληθήο, 
ζπκπεξηιακβαλνκέλεο ηεο αεξνδηαζηεκηθήο, απηνθίλεηεο, ειεθηξνληθήο θαη ππξεληθήο. 
΢ην ζεκείν απηφ φκσο πξέπεη λα επηζεκαλζεί φηη πξνθεηκέλνπ λα ρξεζηκνπνηήζεη θαλείο 
ην ANSYS ή γεληθφηεξα νπνηνδήπνηε άιιν πξφγξακκα πεπεξαζκέλσλ ζηνηρείσλ γεληθνχ 
ζθνπνχ, είλαη επηηαθηηθφ λα θαηαιαβαίλεη πιήξσο ηηο βαζηθέο έλλνηεο θαη ηνπο 
πεξηνξηζκνχο ηεο κεζφδνπ ησλ πεπεξαζκέλσλ ζηνηρείσλ.  

 

 
Δικόνα 3.1. : Άλνηγκα ηνπ ππνινγηζηηθνχ πξνγξάκκαηνο  ANSYS. 
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΢ηελ παξνχζα πηπρηαθή εξγαζία ρξεζηκνπνηήζεθε ε έθδνζε ANSYS 14.00. Σν 
πεξηβάιινλ απηήο ηεο έθδνζεο πεξηέρεη δχν παξάζπξα: ην θχξην παξάζπξν ,Δηθ.3.2. θαη 
έλα παξάζπξν πιεξνθνξηψλ, Δηθ. 3.3. . Σν θχξην παξάζπξν απνηειείηαη απφ πέληε 
ηκήκαηα :  

 

1. Μενού βοηθημάηων (Utility menu): Πεξηέρεη ηηο ιεηηνπξγίεο πνπ είλαη δηαζέζηκεο 
ζρεδφλ ζε φιν ην θάζκα ιεηηνπξγηψλ ηνπ ANSYS, φπσο νη έιεγρνη αξρείσλ (file), ε 
επηινγή (select), νη γξαθηθνί έιεγρνη (Plot Controls), ν νξηζκφο θαη ε δηαρείξηζε 
παξακέηξσλ (Parameters) θαη ην ζχζηεκα βνήζεηαο (help). Αλαιπηηθά ην utility 
menu πεξηέρεη ηηο εμήο ιεηηνπξγίεο: 

 

 File: Έρνπκε ηε δπλαηφηεηα λα εκθαλίζνπκε έλα αξρείν πνπ είλαη 
απνζεθεπκέλν ζηε βάζε δεδνκέλσλ ηνπ ππνινγηζηή ή λα δεκηνπξγήζνπκε έλα 
θαηλνχξην θαη λα ην απνζεθεχζνπκε. 

 Select: Δίλαη κηα δπλακηθή εληνιή κε ηελ νπνία έρνπκε ηε δπλαηφηεηα λα 
απνκνλψζνπκε θαη λα επεμεξγαζηνχκε έλα ηκήκα ηνπ κνληέινπ. Καηά ηελ 
επεμεξγαζία ην πξφγξακκα ιακβάλεη ππφςε κφλν ην επηιεγκέλν ηκήκα ηνπ 
κνληέινπ. 

 List: Έρνπκε ηε δπλαηφηεηα λα εκθαλίζνπκε θαηαιφγνπο πνπ είλαη 
απνζεθεπκέλνη ζηε βάζε δεδνκέλσλ ηνπ πξνγξάκκαηνο. Οη θαηάινγνη 
κπνξνχλ λα πεξηέρνπλ ζεκεία, γξακκέο, επηθάλεηεο, φγθνπο, ζηνηρεία θαη 
θφκβνπο, ηα νπνία αθνινπζνχληαη απφ κηα ζπγθεθξηκέλε αξίζκεζε πνπ γίλεηαη 
απηφκαηα απφ ην πξφγξακκα. 

 Plot: Μπνξνχκε λα πξνβάινπκε ζην παξάζπξν ζρεδίαζεο (αλάινγα κε ην ηη 
ζέινπκε λα επεμεξγαζηνχκε) ζεκεία, γξακκέο, επηθάλεηεο, θιπ. , ηνπ κνληέινπ. 

 Plot controls: Πεξηέρεη ιεηηνπξγίεο πνπ ειέγρνπλ ηα ραξαθηεξηζηηθά ησλ 
γξαθηθψλ επηδείμεσλ. 

 Work plane: Ζ ρξήζε ηεο εληνιήο απηήο πξνζθέξεη κεγάιε επθνιία ζηε 
δεκηνπξγία ζηεξεψλ πξφηππσλ κνληέισλ. Μαο δίλεη ηε δπλαηφηεηα λα 
κεηαθέξνπκε ή θαη λα πεξηζηξέςνπκε φπνπ επηζπκνχκε ηνπο άμνλεο 
ζπληεηαγκέλσλ. 

 Help: Δίλαη ην ζχζηεκα βνήζεηαο ηνπ πξνγξάκκαηνο ζην νπνίν κπνξνχκε λα 
αλαηξέμνπκε γηα νπνηαδήπνηε πιεξνθνξία.  

 

2. Κύριο μενού (Main menu): Πεξηέρεη ηηο φιεο ηηο εληνιέο ηνπ ANSYS πνπ 
ρξεζηκνπνηνχληαη γηα ηελ θαηαζθεπή ηνπ κνληέινπ, ηελ επίιπζε ηνπ πξνβιήκαηνο 
θαη ηελ επεμεξγαζία ησλ απνηειεζκάησλ. Οη εληνιέο έρνπλ νξγαλσζεί ζε ηξεηο 
βαζηθνχο επεμεξγαζηέο, ζηνλ Preprocessor ν νπνίνο πεξηιακβάλεη φιεο ηηο 
δηαζέζηκεο εληνιέο γηα ηελ θαηαζθεπή ηνπ κνληέινπ, ζηνλ Solution ν νπνίνο 
πεξηιακβάλεη φιεο ηηο δηαζέζηκεο εληνιέο γηα ηνλ νξηζκφ ηεο αλάιπζεο θαζψο 
επίζεο θαη ηηο εληνιέο επίιπζεο θαη ηέινο ζηνλ Post processor κέζσ ηνπ νπνίνπ ν 
ρξήζηεο επεμεξγάδεηαη ηα απνηειέζκαηα.  

 

3. Μπάρα εργαλείων (Toolbar): Πεξηέρεη θνπκπηά κε ηα νπνία κπνξνχκε λα 
εθηειέζνπκε εληνιέο θαη ιεηηνπξγίεο πνπ ρξεζηκνπνηνχληαη επαλεηιεκκέλα θαηά ηε 
δηαδηθαζία επίιπζεο ελφο πξνβιήκαηνο. Δπίζεο ε κπάξα εξγαιείσλ πεξηέρεη 
θνπκπηά επαλαθνξάο (Resume_db) ακέζσο πξνεγνχκελσλ απνζεθεπκέλσλ 
κνληέισλ.  
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4. Πεδίο ενηολών (Input field): Σν πεδίν εληνιψλ καο δίλεη ηε δπλαηφηεηα λα 
εηζάγνπκε άκεζα ηηο εληνιέο ηεο γιψζζαο πξνγξακκαηηζκνχ APDL πνπ δηαζέηεη ην 
ANSYS. Ζ ρξήζε εληνιψλ πξνγξακκαηηζκνχ είλαη έλαο ελαιιαθηηθφο ηξφπνο 
δεκηνπξγίαο ελφο κνληέινπ αληί απηνχ κέζσ ησλ θαξηειψλ εηζαγσγήο δεδνκέλσλ 
θαη ελδείθλπηαη ζηελ πεξίπησζε πνιχ κεγάισλ κνληέισλ θαζψο επίζεο θαη ζηελ 
πεξίπησζε ησλ παξακεηξηθψλ αλαιχζεσλ. ΋ιεο νη πξφζθαηα δαθηπινγξαθεκέλεο 
εληνιέο απνζεθεχνληαη ζε έλα κελνχ θαηαγξαθήο γηα εχθνιε πξφζβαζε. 

 

5. Γραθικό παράθσρο (Graphics Window): Δίλαη ην παξάζπξν, φπνπ ην κνληέιν 
αλαπαξίζηαηαη γξαθηθά ζηα δηάθνξα ζηάδηα ηεο θαηαζθεπήο θαζψο επίζεο θαη ηα 
απνηειέζκαηα πνπ πξνθχπηνπλ απφ ηελ αλάιπζε.  
 

 
 

 
Δικόνα 3.2. : Κχξην παξάζπξν εξγαζίαο. 
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Δικόνα 3.3. : Παξάζπξν πιεξνθνξηψλ. 

 

 

 

 

 

 

3.1.2. ΒΑ΢ΙΚΔ΢ ΛΔΙΣΟΤΡΓΙΔ΢ ΠΡΟΓΡΑΜΜΑΣΟ΢ 
 

Γηα ηελ αλάιπζε ελφο πξνβιήκαηνο κε ην ANSYS αθνινπζνχκε ηα εμήο βαζηθά 
βήκαηα : 

 

1. ΚΑΣΑ΢ΚΔΤΗ ΣΟΤ ΜΟΝΣΔΛΟΤ ΜΔ ΥΡΗ΢Η ΣΧΝ ΔΝΣΟΛΧΝ ΣΟΤ 
PREPROCESSOR 

 

Oη ζεκαληηθφηεξεο εξγαζίεο πνπ γίλνληαη γηα ηελ θαηαζθεπή ελφο κνληέινπ είλαη νη 
εμήο:  

 

 Οριζμός ηοσ ηύποσ ζηοιτείων (element type): Σν ANSYS αλάινγα κε ηε 
γεσκεηξία, ην θπζηθφ ραξαθηήξα ηνπ πξνβιήκαηνο (ζηαηηθφ, ζεξκηθφ, ξνή 
ξεπζηνχ, ειεθηξνκαγλεηηθφ) θαη ηελ κεραληθή ζπκπεξηθνξά ησλ πιηθψλ ηεο 
θαηαζθεπήο (γξακκηθά, κε-γξακκηθά, ηζφηξνπα, αληζφηξνπα) θαη ησλ 
ζπλαξηήζεσλ πνπ ζα ρξεζηκνπνηεζνχλ γηα ηελ πξνζέγγηζε ησλ αγλψζησλ 
πεδίσλ ηνπ πξνβιήκαηνο, δηαζέηεη 160 ζηνηρεία γηα ηελ αλάιπζε φισλ ησλ 
εηδψλ πξνβιεκάησλ. Δίλαη εχθνια θαηαλνεηφ φηη ε επηινγή ηνπ θαηάιιεινπ 
είδνπο ζηνηρείνπ είλαη πνιχ ζεκαληηθή γηα ηε δηαδηθαζία ηεο αλάιπζεο. Κάζε 
έλα απφ ηα ζηνηρεία πξνζδηνξίδεηαη απφ ηελ νλνκαζία κηαο θαηεγνξίαο θαη 
αθνινπζείηαη απφ έλαλ ραξαθηεξηζηηθφ αξηζκφ, π.ρ. link10, beam3, solid44. Οη 
βαζηθέο θαηεγνξίεο ησλ δηαζέζηκσλ ζηνηρείσλ είλαη νη εμήο: 
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 Γομικά ζηοιτεία (structural): ΢ε απηή ηελ νκάδα ζηνηρείσλ νη βαζκνί 
ειεπζεξίαο ζηνπο θφκβνπο, είλαη ζπλήζσο νη κεηαηνπίζεηο θαη νη ζηξνθέο. ΢ηηο 
δνκηθέο αλαιχζεηο πεξηιακβάλνληαη, επίπεδα ζηνηρεία (plane elements), 
ξαβδσηά ζηνηρεία (link elements), ζηνηρεία δνθνχ (beam elements), ζηεξεά 
ζηνηρεία (solid elements), ή θαη θειπθσηά ζηνηρεία (shell elements). ΋ια απηά 
ηα ζηνηρεία πεξηέρνπλ έλα πιήζνο ππνθαηεγνξηψλ ζηνηρείσλ κε δηαθνξεηηθνχο 
θφκβνπο ν αξηζκφο ησλ νπνίσλ θαζνξίδεηαη απφ ην είδνο θαη ην βαζκφ ησλ 
ζπλαξηήζεσλ πξνζέγγηζεο ησλ αγλψζησλ πεδίσλ. Γηα παξάδεηγκα ηα 
δηζδηάζηαηα ζηεξεά ζηνηρεία νξίδνληαη απφ ηελ θαηεγνξία plane. Δπηπιένλ ην 
ζηνηρείν plane 42 είλαη έλα ηεηξάπιεπξν ζηνηρείν ηεζζάξσλ θφκβσλ κε δχν 
βαζκνχο ειεπζεξίαο ζε θάζε θφκβν, κεηαθνξά ζε ρ θαη y θαηεπζχλζεηο θαη 
ρξεζηκνπνηείηαη γηα ηελ κνληεινπνίεζε δνκηθψλ ζηεξεψλ πξνβιεκάησλ 
(structural solid). ΢ηνλ πίλαθα 3.1. απεηθνλίδνληαη κεξηθά αληηπξνζσπεπηηθά 
δνκηθά ζηνηρεία. 

 

 
 

Σν ζηνηρείν 
(PLANE82) 
θαζνξίδεηαη απφ 8 
θφκβνπο, κε δχν 
βαζκνχο ειεπζεξίαο 
ζε θάζε θφκβν (ηηο 
κεηαηνπίζεηο ζηηο 
θνκβηθέο θαηεπζχλζεηο 
X θαη Y) 

 

 

Αμνληθά δηζδηάζηαηα 
ζηνηρεία (BEAM 3), ηα 
νπνία θαζνξίδνληαη 
απφ ηξεηο βαζκνχο 
ειεπζεξίαο ζε θάζε 
θφκβν (κεηαηνπίζεηο 
ζηηο θνκβηθέο 
θαηεπζχλζεηο Υ θαη Τ 
θαη πεξηζηξνθή γηα ηνλ 
θνκβηθφ Ε άμνλα). 

 

Σν ζηνηρείν PIPES 16 
είλαη έλα αμνληθφ 
ζηνηρείν θαη 
θαζνξίδεηαη απφ έμη 
βαζκνχο ειεπζεξίαο 
ζε δχν θφκβνπο 
(κεηαηνπίζεηο ζηηο 
θνκβηθέο θαηεπζχλζεηο 
X, Y θαη Z θαη ηηο 
πεξηζηξνθέο πεξί ηνπο 
θνκβηθνχο άμνλεο X, 
Y,θαη Z) 
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Ραβδσηά ζηνηρεία 
(LINK), ηα νπνία είλαη 
ηξηζδηάζηαηα ζηνηρεία 
γξακκήο κε δχν 
θφκβνπο θαη ηξεηο 
βαζκνχο ειεπζεξίαο 
αλά θφκβν 
(κεηαηνπίζεηο ζε θάζε 
άμνλα) 

 

Σν ζηνηρείν (SOLID 
187) έρεη 10 θφκβνπο 
κε ηξεηο βαζκνχο 
ειεπζεξίαο αλά θφκβν: 
ηηο κεηαηνπίζεηο ζηηο 
θνκβηθέο θαηεπζχλζεηο 
Υ, Τ, θαη Ε. Σν ζηνηρείν 
έρεη ηε δπλαηφηεηα 
επίιπζεο 
πξνβιεκάησλ 
πιαζηηθφηεηαο,  
ππεξειαζηηθφηεηαο, 
εξππζκνχ θαη 
πξνβιεκάησλ κε 
κεγάιεο κεηαηνπίζεηο. 

 

Σν ζηνηρείν (SHELL 
63) έρεη έμη βαζκνχο 
ειεπζεξίαο ζε θάζε 
θφκβν: κεηαηνπίζεηο 
ζηηο θνκβηθέο 
θαηεπζχλζεηο Υ, Τ θαη 
Ε θαη ηηο πεξηζηξνθέο 
πεξί ηνπο θνκβηθνχο 
άμνλεο Υ, Τ, θαη Ε. 

Πίνακα 3.1. : Αληηπξνζσπεπηηθά δνκηθά ζηνηρεία ηνπ ANSYS. 
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2. ΘΔΡΜΙΚΑ ΢ΣΟΙΥΔΙΑ (THERMAL): ΢ε απηή ηε νκάδα ζηνηρείσλ νη βαζκνί 
ειεπζεξίαο ζηνπο θφκβνπο, είλαη νη ζεξκνθξαζίεο. ΢ηηο ζεξκηθέο αλαιχζεηο 
πεξηιακβάλνληαη ζηνηρεία κάδαο (mass), ξαβδσηά (link), ζηεξεά (solid) ή θαη 
θειπθσηά (shell) ζηνηρεία. ΢ηνλ πίλαθα 3.2. απεηθνλίδνληαη κεξηθά απφ ηα ζεξκηθά 
ζηνηρεία. 

 

 

Σν ζηνηρείν (PLANE 44), είλαη 
έλα ηεηξάπιεπξν ζηνηρείν, έρεη 
ηέζζεξεηο ζεξκηθνχο βαζκνχο 
ειεπζεξίαο (ζεξκνθξαζία ζε 
θάζε θφκβν) θαη κπνξεί λα 
ρξεζηκνπνηεζεί κφλν γηα 
δηζδηάζηαην πξφβιεκα.  

 

Σν ηξηζδηάζηαην ζηνηρείν 
(SOLID 70), είλαη έλα θπβηθφ 
ζηνηρείν, έρεη νθηψ ζεξκηθνχο 
βαζκνχο ειεπζεξίαο 
(ζεξκνθξαζία ζε θάζε θφκβν). 

Πίνακας 3.2. : Αληηπξνζσπεπηηθά ζεξκηθά ζηνηρεία ηνπ ANSYS. 

 

 

3. ΢ΣΟΙΥΔΙΑ ΡΔΤ΢ΣΟΤ (FLUID ELEMENTS): Γηα απηήλ ηελ νκάδα ζηνηρείσλ, 
αλάινγα κε ηνλ ηχπν θαη ηνπο βαζκνχο ειεπζεξίαο εκθαλίδνληαη ζπλήζσο σο 
δεπγάξη ζηνπο θφκβνπο, ηαρχηεηα-πίεζε ή πίεζε-ζεξκνθξαζία.  

 

 Καθοριζμός ηων πραγμαηικών ζηαθερών (Real Constants): Οη πξαγκαηηθέο 
ζηαζεξέο ρξεζηκνπνηνχληαη γηα ηνλ νξηζκφ ησλ παξακέηξσλ ηνπ είδνπο ηνπ 
ζηνηρείνπ (element type) πνπ έρεη ήδε επηιεγεί. Αλάινγα κε ην ζηνηρείν πνπ 
ρξεζηκνπνηείηαη κπνξεί λα εθθξάδνπλ επηθάλεηα, πάρνο, εζσηεξηθή-εμσηεξηθή 
δηάκεηξνο, θ.ιπ. Δίλαη πξνθαλέο φηη κεξηθνί ηχπνη ζηνηρείσλ, φπσο γηα 
παξάδεηγκα ηα ζηεξεά (solids), δελ απαηηνχλ ηoλ νξηζκφ πξαγκαηηθψλ 
ζηαζεξψλ. 

 

 Καθοριζμός ηων ιδιοηήηων ηων σλικών (Material Properties): Αλάινγα κε 
ηνλ ηχπν ηεο αλάιπζεο πνπ ζα δηεμαρζεί, απαηηείηαη ν νξηζκφο θάπνησλ 
ζπγθεθξηκέλσλ κεραληθψλ ηδηνηήησλ ησλ πιηθψλ ηεο θαηαζθεπήο, φπσο είλαη 
γηα παξάδεηγκα ην κέηξν ειαζηηθφηεηαο, ν ιφγνο Poisson, ε ππθλφηεηα, ν 
ζπληειεζηήο ζεξκηθήο δηαζηνιήο, θ.α. Ζ κεραληθή ζπκπεξηθνξά ησλ πιηθψλ 
κπνξεί λα είλαη: 

 

- Γξακκηθή ή κε γξακκηθή. 

- Ηζφηξνπε ή αληζφηξνπε. 
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 ΢τεδιαζμός ηης πρόησπης γεωμεηρίας ηης καηαζκεσής: Απνηειεί ην 
ζρεδηαζηηθφ κέξνο ηεο θαηαζθεπήο ηνπ κνληέινπ, φπνπ κε ηηο θαηάιιειεο 
εληνιέο ηχπνπ CAD, δεκηνπξγνχκε ηελ γεσκεηξία ηεο θαηαζθεπήο πνπ ζέινπκε 
λα αλαιχζνπκε. Έρνπκε ηε δπλαηφηεηα λα δεκηνπξγήζνπκε ζεκεία, γξακκέο, 
επηθάλεηεο θαη φγθνπο.  

 

 

 Γιακριηοποίηζη (meshing). Ο ζρεδηαζκφο ηεο γεσκεηξίαο ηεο ππφ αλάιπζε 
θαηαζθεπήο γίλεηαη απνθιεηζηηθά θαη κφλν γηα λα δεκηνπξγεζεί ην πιέγκα ηεο 
γεσκεηξίαο, φζν δπλαηφλ πην εχρξεζηα θαη απνηειεζκαηηθά. Μφιηο 
νινθιεξσζεί ην ζηεξεφ πξφηππν, ν ρξήζηεο πξνβαίλεη ζηελ δηαθξηηνπνίεζε 
ηνπ κνληέινπ, αθνχ πξψηα έρεη νξίζεη ην ηχπν ησλ ζηνηρείσλ θαη ηηο 
πξαγκαηηθέο ζηαζεξέο αλ απηέο ρξεηάδνληαη θαζψο επίζεο θαη ην πιηθφ ηνπ ππφ 
δηαθξηηνπνίεζε ηκήκαηνο ηεο θαηαζθεπήο. Σν ANSYS πξνζθέξεη δηάθνξεο 
επηινγέο γηα λα επηηεπρζεί ε ηδαληθφηεξε δηαθξηηνπνίεζε. Απηέο είλαη ε ειεχζεξε 
(free) θαη ραξηνγξαθεκέλε (mapped) δηαθξηηνπνίεζε. Δπίζεο παξέρνληαη ζηνλ 
ρξήζηε πνιιέο δπλαηφηεηεο γηα ηελ ξχζκηζε ηνπ κεγέζνπο ηνπ πιέγκαηνο. 
Γεληθά, έλαο κεγάινο αξηζκφο ζηνηρείσλ παξέρεη κηα θαιχηεξε πξνζέγγηζε ηεο 
ιχζεο. Δληνχηνηο, ζε κεξηθέο πεξηπηψζεηο, έλαο ππεξβνιηθφο αξηζκφο ζηνηρείσλ 
κπνξεί απμήζεη ηελ πηζαλφηεηα ιάζνπο. Δπνκέλσο, είλαη ζεκαληηθφ ην κέγεζνο 
ηνπ πιέγκαηνο λα είλαη επαξθψο αξαηφ ή ππθλφ ζηηο θαηάιιειεο πεξηνρέο. 
Πφζν αξαηφ ή ππθλφ πξέπεη λα είλαη ην πιέγκα ζε απηέο ηηο πεξηνρέο είλαη κηα 
ζεκαληηθή εξψηεζε. Γπζηπρψο, δελ ππάξρεη κηα ζπγθεθξηκέλε απάληεζε γηα 
ηνλ θαζνξηζκφ εμ’ αξρήο ηνπ θαηάιιεινπ πιέγκαηνο, δεδνκέλνπ φηη εμαξηάηαη 
απφ ην ζπγθεθξηκέλν θπζηθφ πξφβιεκα πνπ αλαιχεηαη θάζε θνξά. Δληνχηνηο, 
ππάξρνπλ κεξηθέο ηερληθέο πνπ λα είλαη ρξήζηκεο γηα ηνλ θαζνξηζκφ ηνπ 
θαηάιιεινπ κεγέζνπο ηνπ πιέγκαηνο. Mηα απφ απηέο ηηο ηερληθέο είλαη ε εμήο: 
Σν κνληέιν αλαιχεηαη κε έλα αξρηθφ κέγεζνο πιέγκαηνο θαη θαηφπηλ αλαιχεηαη 
μαλά κε έλα δηαθνξεηηθφ κέγεζνο πιέγκαηνο (ζπλήζσο κηάκηζε έσο δχν θνξέο 
πην ππθλφ). Οη δχν ιχζεηο ζπγθξίλνληαη θαη εάλ ηα απνηειέζκαηα ζπγθιίλνπλ 
κεηαμχ ηνπο, ε αξρηθή δηακφξθσζε πιέγκαηνο ζεσξείηαη επαξθήο. Δάλ 
ππάξρνπλ νπζηαζηηθέο δηαθνξέο κεηαμχ ησλ δχν, ε αλάιπζε πξέπεη λα 
ζπλερηζηεί κε πην ππθλά κεγέζε πιεγκάησλ θαη λα ζπγθξίλνληαη ηα 
απνηειέζκαηα κέρξη λα επηηεπρζεί ε ζχγθιηζε.  
 

 

 

4. ΟΡΙ΢ΜΟ΢ ΣΗ΢ ΑΝΑΛΤ΢Η΢ ΚΑΙ ΔΠΙΛΤ΢Η ΣΟΤ ΠΡΟΒΛΗΜΑΣΟ΢ ΜΔ ΥΡΗ΢Η 
ΣΧΝ ΔΝΣΟΛΧΝ ΣΟΤ ΔΠΔΞΔΡΓΑ΢ΣΗ SOLUTION. 

 

Oη ζεκαληηθφηεξεο εξγαζίεο πνπ γίλνληαη ζην ζηάδην απηφ είλαη νη εμήο:  

 

 Οξηζκφο ηνπ είδνπο ηεο αλάιπζεο (analysis type) πνπ ζα δηεμαρζεί. Σν ANSYS 
σο πξφγξακκα γεληθνχ ζθνπνχ έρεη ηε δπλαηφηεηα λα επηιχζεη έλα επξχ θάζκα 
πξνβιεκάησλ εθαξκνζκέλεο κεραληθήο. Με έκθαζε ηα πξνβιήκαηα ηνπ 
ελδηαθέξνληνο ελφο Μεραλνιφγνπ Μεραληθνχ εζηηάδνπκε ζηα παξαθάησ είδε 
αλάιπζεο: 
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I. Γομική ανάλσζη: ΢ηηο αλαιχζεηο απηέο δεηνχκελν είλαη ε εχξεζε ηεο θαηαλνκήο 
ησλ ηάζεσλ, παξακνξθψζεσλ, πηέζεσλ επηθαλείαο, θαζψο επίζεο θαη ησλ 
δπλάκεσλ αληίδξαζεο ζε έλα ζηεξεφ ζψκα. Μεξηθέο ππνθαηεγνξίεο δηαζέζηκσλ 
αλαιχζεσλ είλαη νη εμήο: 

 

 ΢ηαηηθή αλάιπζε: Σα εθαξκνζκέλα θνξηία θαη νη ζπλζήθεο ζηήξημεο ηνπ 
ζηεξενχ ζψκαηνο δελ αιιάδνπλ κε ην ρξφλν.  

 Ιδηνκνξθηθή αλάιπζε: Με απηφ ηνλ ηχπν αλάιπζεο ππνινγίδνληαη νη θπζηθέο 
ζπρλφηεηεο ηεο ειεχζεξεο ηαιάλησζεο ηεο θαηαζθεπήο θαζψο επίζεο θαη νη 
αληίζηνηρεο ηδηνκνξθίεο.  

 Αξκνληθή αλάιπζε: Με ηελ αλάιπζε απηή κειεηνχκε ηε ζπκπεξηθνξά κφληκεο 
θαηάζηαζεο κηαο θαηαζθεπήο πνπ ππνβάιιεηαη ζε θνξηία αξκνληθά ζε ζρέζε 
κε ην ρξφλν. 

 Μεηαβαηηθή αλάιπζε: Σα εθαξκνζκέλα θνξηία ή θαη νη ζπλζήθεο ζηήξημεο ηνπ 
ζηεξενχ ζψκαηνο αιιάδνπλ σο ζπλαξηήζεηο ηνπ ρξφλνπ. Απηφο ν ηχπνο ησλ 
αλαιχζεσλ είλαη ζπλήζσο θαη ν πην ρξνλνβφξνο κηαο ε ιχζε πξνθχπηεη 
θαηφπηλ νινθιεξψζεσο ζε φιν ην ρξφλν εμέιημεο ηνπ θαηλνκέλνπ ηνπ 
πξνβιήκαηνο.  

 

II. Οριζμός ζσνοριακών ζσνθηκών (Boundary conditions). Σν ANSYS έρεη ηε 
δπλαηφηεηα λα νξίζεη ζε έλα πξφβιεκα θνξηία, πηέζεηο, ζηεξίμεηο θαη αληηδξάζεηο, 
αλάινγα κε ην είδνο ηεο αλάιπζεο. ΋ια απηά γηα ιφγνπο επρξεζηίαο κπνξνχλ λα 
νξηζηνχλ πάλσ ζε ζεκεία, γξακκέο, επηθάλεηεο, θφκβνπο θαη ζε ζηνηρεία θαη λα 
κεηαθεξζνχλ απηφκαηα ηειηθά ζηνπο θφκβνπο ηνπ πιέγκαηνο, φπσο απαηηείηαη απφ 
ηε κέζνδν ησλ πεπεξαζκέλσλ ζηνηρείσλ. 
 

III. Δπίλσζη ηοσ προβλήμαηος. Σν ANSYS επηιχεη ην πξφηππν πεπεξαζκέλν 
κνληέιν. Ο ρξφλνο επίιπζεο ηνπ πξνβιήκαηνο εμαξηάηαη θάζε θνξά απφ ην είδνο 
ηεο αλάιπζεο, ηελ ηδηαηηεξφηεηα ηεο γεσκεηξίαο ηνπ κνληέινπ, ην κέγεζνο ηνπ 
πιέγκαηνο θαη απφ ηε πνιππινθφηεηα ησλ νξηαθψλ ζπλζεθψλ. 

 
 
 

5. ΔΠΔΞΔΡΓΑ΢ΙΑ ΣΧΝ ΑΠΟΣΔΛΔ΢ΜΑΣΧΝ ΜΔ ΥΡΗ΢Η ΣΧΝ ΔΝΣΟΛΧΝ ΣΟΤ 
ΔΠΔΞΔΡΓΑ΢ΣΗ POST PROCESSOR: 

 

΢ε απηφλ ηνλ επεμεξγαζηή παξαηίζεληαη ηα απνηειέζκαηα ηα νπνία κπνξεί λα είλαη 
δηαλπζκαηηθέο επηδείμεηο, ιίζηεο απνηειεζκάησλ, ην παξακνξθσκέλν ζψκα, θαηαλνκή 
κεηαηνπίζεσλ θαη ηάζεσλ. 
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ΚΔΦΑΛΑΙΟ 4 : ΔΠΙΛΤ΢Η ΥΑΡΑΚΣΗΡΙ΢ΣΗΚΧΝ ΠΡΟΒΛΗΜΑΣΧΝ  
ΜΔ ΣΗ ΥΡΗ΢Η ANSYS 

 

4.  ΔΠΙΛΤ΢Η ΥΑΡΑΚΣΗΡΙ΢ΣΗΚΧΝ ΠΡΟΒΛΗΜΑΣΧΝ  ΜΔ ΣΗ ΥΡΗ΢Η 

ANSYS. 

 

΢ην θεθάιαην απηφ πεξηγξάθεηαη αλαιπηηθά ε ζρεδίαζε θαη ε επίιπζε επηά 
ραξαθηεξηζηηθψλ παξαδεηγκάησλ κε ηε ρξήζε ηνπ πξνγξάκκαηνο ANSYS, σο 
αληηπξνζσπεπηηθφ δείγκα ησλ πξνβιεκάησλ πνπ επηιχζεθαλ ζηα αληίζηνηρα πεηξάκαηα. 

 

 

 

4.1. ΑΝΑΛΤ΢Η ΔΠΙΠΔΓΗ΢ ΟΡΘΟΓΧΝΙΑ΢ ΠΛΑΚΑ΢ ΜΔ ΟΠΗ 

 

ΠΔΡΙΓΡΑΦΗ ΣΟΤ ΠΡΟΒΛΗΜΑΣΟ΢ 

 

Έζησ κηα νξζνγψληα πιάθα απφ πιηθφ PLM-4B δηαηάζεσλ 40 mm x 170 mm x 5 
mm , ε νπνία είλαη θαηαζθεπαζκέλε απφ ηζφηξνπν νκνγελέο πιηθφ κε κέηξν 
Διαζηηθφηεηαο Δ=0.13 GPa θαη ιφγν Poisson λ = 0.45. ΢ην θέληξν ηεο πιάθαο ππάξρεη κηα 
θπθιηθή νπή δηακέηξνπ 18 mm, φπσο θαίλεηαη ζην ζρήκα 4.1.1. 

 

 
΢τήμα 4.1.1. : Δθειθπζκφο νξζνγψληαο πιάθαο κε θπθιηθή νπή ζην θέληξν ηεο. 

 

Ζ πιάθα ζηελ επάλσ πιεπξά ηεο είλαη παθησκέλε ελψ ζηελ θάησ πιεπξά ηεο 
εθειθχεηαη κε κηα νξζή ηάζε 4 Ν.  
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΢θνπφο ηνπ  πξνβιήκαηνο είλαη ν ππνινγηζκφο ηεο ζπγθέληξσζεο ησλ ηάζεσλ πνπ 
αλαπηχζζνληαη, ιφγσ ηεο χπαξμεο ηεο νπήο, γχξσ απφ απηή. ΢πλνπηηθά φια ηα δεδνκέλα 
ηνπ πξνβιήκαηνο παξνπζηάδνληαη  ζηνλ πίλαθα 4.1.1. 

 

 

Γεωμεηρικά ταρακηηριζηικά πλάκας (mm) 

Όςνο (height) 170 

Πιάηνο (width) 40 

Πάρνο (thickness) 5 

Αθηίλα νπήο (radius) 9 

Ιδιόηηηες σλικού: 

Μέηξν ειαζηηθφηεηαο Δ 0.13 GPa 

VΛφγνο Poisson λ  0.45 

Φόρηιζη 

Δθειθπζηηθή νξζή ηάζε  4 Ν 

Πίνακας 4.1.1.: Γεδνκέλα ηνπ πξνβιήκαηνο 

 

 

ΜΟΝΣΔΛΟ ΠΔΠΔΡΑ΢ΜΔΝΧΝ ΢ΣΟΙΥΔΙΧΝ 

 

Λφγσ ηνπ κηθξνχ πάρνπο ηεο πιάθαο ζε ζρέζε κε ηηο άιιεο δηαζηάζεηο ηεο, γηα ηελ 
κνληεινπνίεζε ζεσξνχκε φηη θαηά ηελ θαηαπφλεζε ηεο αλαπηχζζεηαη επίπεδε θαηάζηαζε 
ηάζεσλ (plane stress). Γηα ην ιφγν απηφ γηα ηελ θαηαζθεπή ηνπ κνληέινπ ησλ 
πεπεξαζκέλσλ ζηνηρείσλ ρξεζηκνπνηνχληαη επηθαλεηαθά ηξηζδηάζηαηα  ζηνηρεία (PLANE 
183), δηαθξηηνπνηψληαο ηελ κέζε επηθάλεηα ηεο πιάθαο θαη ην πάρνο ηεο ιακβάλεηαη 
ππφςε σο ηδηφηεηα ηνπ ζηνηρείνπ (ζην ANSYS κέζσ ηνπ νξηζκνχ ελφο real constant). Σν 
ζηνηρείν (PLANE 183) θαζνξίδεηαη απφ 18 θφκβνπο, κε ηξεηο  βαζκνχο ειεπζεξίαο ζε θάζε 
θφκβν. ΢ην ζρήκα 4.1.2 πνπ αθνινπζεί θαίλεηαη ε γεσκεηξία, ε ηνπνζεζία ησλ θφκβσλ, 
θαη ην ζχζηεκα ζπληεηαγκέλσλ γηα ην ζηνηρείν PLANE 183.  

 

΢τήμα 4.1.2.: Απεηθφληζε ηνπ ζηνηρείνπ PLANE 183. 
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Με ζθνπφ ηελ πηζηνπνίεζε ηεο ζχγθιηζεο ησλ απνηειεζκάησλ ε πιάθα 
δηαθνξνπνηήζεθε κε δπν δηαθνξεηηθά κεγέζε πιέγκαηνο. Σν πιέγκα 1 (ην πην αξαηφ), 
ζρήκα 4.1.3.a, απνηειείηαη απφ 75 PLANE 183 ζηνηρεία ελψ ην πιέγκα 2 (ην πην ππθλφ), 
ζρήκα 4.1.3.b, απφ 272 PLANE 183. 

 

  
(a) (b) 

΢τήμα 4.1.3. : (a) Πιέγκα 1 (75 elements) θαη (b) Πιέγκα 2 (272 elements). 

 

 

ΑΠΟΣΔΛΔ΢ΜΑΣΑ 

 

΢ηα ζρήκαηα 4.1.4. θαη 4.1.5. παξνπζηάδνληαη ε παξακνξθσκέλε πιάθα θαη ε 
θαηαλνκή ησλ κεηαηνπίζεσλ, αληίζηνηρα, φπσο πξνθχπηεη απφ ηελ επίιπζε ηνπ 
πξνβιήκαηνο κε ηε ρξήζε ησλ δχν πιεγκάησλ. Παξαηεξψληαο ην ζρήκα ηεο 
παξακνξθσκέλεο πιάθαο, δηαπηζηψλεη θαλείο φηη ιφγσ ηεο νπήο ππάξρεη ζην κέζν ηεο 
πιάθαο κηα κέγηζηε εγθάξζηα κεηαηφπηζε, ελψ ην ζρήκα ηεο νπήο απφ θπθιηθφ γίλεηαη 
νβάι κε ην κεγάιν άμνλα ηεο έιιεηςεο λα είλαη παξάιιεινο κε ηε θφξηηζε.    

 

  
  (a)   (b) 

΢τήμα 4.1.4. : Παξακνξθσκέλε πιάθα. 
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  (a)   (b) 

΢τήμα 4.1.5. : Καηαλνκή ησλ κεηαηνπίζεσλ. 

 

΢ην ζρήκα 4.1.6. , παξνπζηάδεηαη ε θαηαλνκή ηεο ηζνδχλακεο ηάζεο φπσο απηή 
πξνθχπηεη απφ ην θξηηήξην αζηνρίαο Von Misses γηα ηα πιέγκαηα 1 θαη 2, αληίζηνηρα.  

  
  (a)   (b) 

΢τήμα 4.1.6.: Καηαλνκή ησλ ηάζεσλ. 
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4.2. ΑΝΑΛΤ΢Η ΢ΤΜΜΔΣΡΙΚΟΤ ΢ΧΜΑΣΟ΢ 

 

ΠΔΡΙΓΡΑΦΗ ΣΟΤ ΠΡΟΒΛΗΜΑΣΟ΢ 

 

Έζησ έλα ζπκκεηξηθφ ζψκα απφ πιηθφ PLM-4B, σο πξνο ηε γεσκεηξία, ζρήκα κε 
δηαζηάζεηο φπσο θαίλνληαη ζην ζρήκα 4.2.1. ΋ια ηα κέιε ηνπ είλαη θαηαζθεπαζκέλα απφ 
ηζφηξνπν νκνγελέο πιηθφ κε κέηξν ειαζηηθφηεηαο Δ=0.13 GPa θαη ιφγν Poisson v=0.45. 

                                                                                
΢τήμα 4.2.1.: ΢πκκεηξηθφ ζρήκα. 

 

Ζ πιάθα ζηελ επάλσ πιεπξά ηεο είλαη παθησκέλε ελψ ζηελ θάησ πιεπξά ηεο 
εθειθχεηαη κε κηα νξζή ηάζε 4 Ν. ΢θνπφο ηνπ  πξνβιήκαηνο είλαη ν ππνινγηζκφο ηεο 
ζπγθέληξσζεο ησλ ηάζεσλ πνπ αλαπηχζζνληαη, ιφγσ ηεο χπαξμεο ησλ νπψλ, γχξσ απφ 
απηή. ΢πλνπηηθά φια ηα δεδνκέλα ηνπ πξνβιήκαηνο παξνπζηάδνληαη  ζηνλ πίλαθα 4.2.1. 
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ΓΔΧΜΔΣΡΙΚΑ ΥΑΡΑΚΣΗΡΙ΢ΣΙΚΑ 
ΠΛΑΚΑ΢ 

(mm) 

Όςνο (height) 120 

Πιάηνο (width) 35 

Πάρνο (thickness) 5 

Αθηίλα  νπψλ (radius) 2 

Σφμν (Arc) 5 

Ππθλφηεηα 2680 gr/cm3 

Ιδιόηηηες σλικού: 

Μέηξν ειαζηηθφηεηαο Ε 0.13 GPa 

VΛφγνο Poisson λ  0.45 

Φόρηιζη 

Δθειθπζηηθή νξζή ηάζε  4 Ν 

Πίνακας 4.2.1. : Γεδνκέλα ηνπ πξνβιήκαηνο. 

 

 

 

 

ΜΟΝΣΔΛΟ ΠΔΠΔΡΑ΢ΜΔΝΧΝ ΢ΣΟΙΥΔΙΧΝ 

 

  
  (a)   (b) 

΢τήμα 4.2.2. : (a) Πιέγκα 1 (56 elements) θαη (b) Πιέγκα 2 (154 elements). 
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ΑΠΟΤΕΛΕΣΜΑΤΑ 

 
΢ηα ζρήκαηα 4.2.3  θαη 4.2.4 παξνπζηάδνληαη ε παξακνξθσκέλε πιάθα θαη ε 

θαηαλνκή ησλ κεηαηνπίζεσλ, αληίζηνηρα, φπσο πξνθχπηεη απφ ηελ επίιπζε ηνπ 
πξνβιήκαηνο κε ηε ρξήζε ησλ δχν πιεγκάησλ. Παξαηεξψληαο ην ζρήκα ηεο 
παξακνξθσκέλεο πιάθαο, δηαπηζηψλεη θαλείο φηη ιφγσ ησλ νπψλ ππάξρεη ζην θάησ άθξν 
πιάθαο κηα κέγηζηε εγθάξζηα κεηαηφπηζε, επίζεο ππάξρεη θαη παξακφξθσζε ζηα ηφμα ηνπ 
ζψκαηνο ιφγσ ησλ γσληψλ πνπ έρνπλ δεκηνπξγεζεί , ελψ ην ζρήκα ησλ νπψλ απφ 
θπθιηθφ γίλεηαη νβάι κε ην κεγάιν άμνλα ηεο έιιεηςεο λα είλαη παξάιιεινο κε ηε θφξηηζε.    

 

  
 

  (a)   (b) 

΢τήμα 4.2.3. : Παξακνξθσκέλε πιάθα. 

 

  

  (a)   (b) 

΢τήμα 4.2.4. : Καηαλνκή ησλ κεηαηνπίζεσλ.  
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΢ην ζρήκα 4.2.5., παξνπζηάδεηαη ε θαηαλνκή ηεο ηζνδχλακεο ηάζεο φπσο απηή 
πξνθχπηεη απφ ην θξηηήξην αζηνρίαο Von Misses γηα ηα πιέγκαηα 1 θαη 2, αληίζηνηρα.  

 

  
  (a)   (b) 

΢τήμα 4.2.5. : Καηαλνκή ησλ ηάζεσλ. 
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4.3. ΑΝΑΛΤ΢Η ΢ΤΜΔΣΡΙΚΟΤ ΢ΧΜΑΣΟ΢ ΜΔ ΣΟΞΑ ΑΠΟ PLM-4B 

 

ΠΔΡΙΓΡΑΦΗ ΣΟΤ ΠΡΟΒΛΗΜΑΣΟ΢ 

 

Σν παξαθάησ  ζπκκεηξηθφ ζρήκα έρεη 2 ηφμα ζηηο θάζεηεο πιεπξέο ηνπο, θαη κηα 

νπή γηα ηελ ηνπνζέηεζε ηνπ βαξηδίνπ. Ζ πιάθα είλαη θαηαζθεπαζκέλε απφ ηζφηξνπν πιηθφ 

PLM-4B κε κέηξν ειαζηηθφηεηαο Δ=0.13 GPa θαη ιφγν Poisson V=0.45. 

 

                                                                    
΢τήμα 4.3.1.: ΢πκκεηξηθφ ζρήκα. 

 

Ζ πιάθα είλαη παθησκέλε ελψ ζηελ θάησ πιεπξά , απφ ηελ νπή, εθειθχεηαη κε κηα 
νξζή ηάζε 4 Ν. ΢θνπφο ηνπ  πξνβιήκαηνο είλαη ν ππνινγηζκφο ηεο ζπγθέληξσζεο ησλ 
ηάζεσλ πνπ αλαπηχζζνληαη, ιφγσ ηεο χπαξμεο ησλ νπψλ, γχξσ απφ απηή. ΢πλνπηηθά 
φια ηα δεδνκέλα ηνπ πξνβιήκαηνο παξνπζηάδνληαη  ζηνλ πίλαθα 4.3.1. 
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ΓΔΧΜΔΣΡΙΚΑ ΥΑΡΑΚΣΗΡΙ΢ΣΙΚΑ 
ΠΛΑΚΑ΢ 

(mm) 

Όςνο (height) 140 

Πιάηνο (width) 28 

Πάρνο (thickness) 5 

Αθηίλα  νπψλ (radius) 2 

Ππθλφηεηα 2680 gr/cm3 

Ιδιόηηηες σλικού: 

Μέηξν ειαζηηθφηεηαο Δ 0.13 GPa 

VΛφγνο Poisson λ  0.45 

Φόρηιζη 

Δθειθπζηηθή νξζή ηάζε  4 Ν 

Πίνακας 4.3.1.: Γεδνκέλα ηνπ πξνβιήκαηνο. 

 

 

 

ΜΟΝΣΔΛΟ ΠΔΠΔΡΑ΢ΜΔΝΧΝ ΢ΣΟΙΥΔΙΧΝ 

 

  
  (a)   (b) 

΢τήμα 4.3.2. : (a) Πιέγκα 1 (50 elements) θαη (b) Πιέγκα 2 (145 elements). 
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ΑΠΟΤΕΛΕΣΜΑΤΑ 
 

  
 

  (a)   (b) 

΢τήμα 4.3.3. : Παξακνξθσκέλε πιάθα. 

 

  

  (a)   (b) 

΢τήμα 4.3.4. : Καηαλνκή ησλ κεηαηνπίζεσλ. 
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΢ην ζρήκα 4.3.5., παξνπζηάδεηαη ε θαηαλνκή ηεο ηζνδχλακεο ηάζεο φπσο απηή 
πξνθχπηεη απφ ην θξηηήξην αζηνρίαο Von Misses γηα ηα πιέγκαηα 1 θαη 2, αληίζηνηρα.  

 

 
 

 

  (a)   (b) 

΢τήμα 4.3.5. : Καηαλνκή ησλ ηάζεσλ. 

 

 

 

 

 

 

 

 

 

 

 



76 
 

4.4. ΑΝΑΛΤ΢Η ΢ΤΜΔΣΡΙΚΟΤ ΢ΧΜΑΣΟ΢ ΜΔ ΣΟΞΑ ΑΠΟ PLEXIGLAS 

 

ΠΔΡΙΓΡΑΦΗ ΣΟΤ ΠΡΟΒΛΗΜΑΣΟ΢ 

 

΢ε έλα ζπκκεηξηθφ ζρήκα απφ πιηθφ Plexiglas κε 2 ηφμα ζηηο θάζεηεο πιεπξέο ηνπο, 

φπσο θαίλεηε ζην παξαθάησ ζρήκα. Ζ πιάθα είλαη θαηαζθεπαζκέλε απφ ηζφηξνπν πιηθφ 

κε κέηξν ειαζηηθφηεηαο Δ=3 GPa θαη ιφγν Poisson v=0.35. 

 

       
 ΢τήμα 4.4.1.: ΢πκκεηξηθφ ζρήκα. 

 

Ζ πιάθα ζηελ θάησ πιεπξά ηεο είλαη παθησκέλε ελψ ζηελ πάλσ πιεπξά ηεο 
εθειθχεηαη κε κηα νξζή ηάζε 10 Ν. ΢θνπφο ηνπ  πξνβιήκαηνο είλαη ν ππνινγηζκφο ηεο 
ζπγθέληξσζεο ησλ ηάζεσλ πνπ αλαπηχζζνληαη, ιφγσ ηεο χπαξμεο ησλ ηφμσλ, γχξσ απφ 
απηά. ΢πλνπηηθά φια ηα δεδνκέλα ηνπ πξνβιήκαηνο παξνπζηάδνληαη  ζηνλ πίλαθα 4.4.1. 
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ΓΔΧΜΔΣΡΙΚΑ ΥΑΡΑΚΣΗΡΙ΢ΣΙΚΑ 
ΠΛΑΚΑ΢ 

(mm) 

Όςνο (height) 330 

Πιάηνο (width) 30 

Πάρνο (thickness) 3 

Αθηίλα  ηφμσλ (radius) 5 

Ππθλφηεηα 1200 gr/cm3 

Ιδιόηηηες σλικού: 

Μέηξν ειαζηηθφηεηαο Ε 3 GPa 

V Λφγνο Poisson λ  0.35 

Φόρηιζη 

Δθειθπζηηθή νξζή ηάζε  10 Ν 

Πίνακας 4.4.1: Γεδνκέλα ηνπ πξνβιήκαηνο. 

 

 

 

 

ΜΟΝΣΔΛΟ ΠΔΠΔΡΑ΢ΜΔΝΧΝ ΢ΣΟΙΥΔΙΧΝ 

 

  
  (a)   (b) 

΢τήμα 4.4.2. : (a) Πιέγκα 1 (109 elements) θαη (b) Πιέγκα 2 (404 elements). 
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ΑΠΟΤΕΛΕΣΜΑΤΑ 

 
 

  
  (a)   (b) 

΢τήμα 4.4.3. : Παξακνξθσκέλε πιάθα. 

 

 

  

  (a)   (b) 

΢τήμα 4.4.4. : Καηαλνκή ησλ κεηαηνπίζεσλ. 
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΢ην ζρήκα 4.4.5., παξνπζηάδεηαη ε θαηαλνκή ηεο ηζνδχλακεο ηάζεο φπσο απηή 
πξνθχπηεη απφ ην θξηηήξην αζηνρίαο Von Misses γηα ηα πιέγκαηα 1 θαη 2, αληίζηνηρα. 

 

 
 

 

  (a)   (b) 

΢τήμα 4.4.5. : Καηαλνκή ησλ ηάζεσλ. 
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4.5. ΑΝΑΛΤ΢Η ΟΡΘΟΓΧΝΙΑ΢ ΠΛΑΚΑ΢ ΜΔ 3 ΔΓΚΑΡ΢ΙΔ΢ ΟΠΔ΢ 

 

ΠΔΡΙΓΡΑΦΗ ΣΟΤ ΠΡΟΒΛΗΜΑΣΟ΢ 

 

Ζ παξαθάησ νξζνγψληα πιάθα έρεη δηαζηάζεηο 30 mm x 340 mm x 3 mm  ε νπνία 
είλαη θαηαζθεπαζκέλε απφ ηζφηξνπν νκνγελέο πιηθφ κε κέηξν Διαζηηθφηεηαο Δ=3 GPa θαη 
ιφγν Poisson λ = 0.35. ΢ην θέληξν ηεο πιάθαο ππάξρνπλ 3 θπθιηθέο νπέο δηακέηξνπ 14 
mm, φπσο θαίλεηαη ζην ζρήκα 4.5.1. 

 

 
΢τήμα 4.5.1. : Δθειθπζκφο νξζνγψληαο πιάθαο . 

 

 

Ζ πιάθα είλαη παθησκέλε ζηελ πάλσ πιεπξά ηεο ελψ ζηελ θάησ πιεπξά ηεο 
εθειθχεηαη κε κηα νξζή ηάζε 10 Ν. ΢θνπφο ηνπ  πξνβιήκαηνο είλαη ν ππνινγηζκφο ηεο 
ζπγθέληξσζεο ησλ ηάζεσλ πνπ αλαπηχζζνληαη, ιφγσ ηεο χπαξμεο ηεο νπήο, γχξσ απφ 
απηή. ΢πλνπηηθά φια ηα δεδνκέλα ηνπ πξνβιήκαηνο παξνπζηάδνληαη  ζηνλ πίλαθα 4.5.1. 
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ΓΔΧΜΔΣΡΙΚΑ ΥΑΡΑΚΣΗΡΙ΢ΣΙΚΑ 
ΠΛΑΚΑ΢ 

(mm) 

Όςνο (height) 340 

Πιάηνο (width) 30 

Πάρνο (thickness) 3 

Αθηίλα νπήο (radius) 7 

Ππθλφηεηα 1200 gr/cm3 

Ιδιόηηηες σλικού: 

Μέηξν ειαζηηθφηεηαο Ε 3 GPa 

V Λφγνο Poisson λ  0.35 

Φόρηιζη 

Δθειθπζηηθή νξζή ηάζε  10 Ν 

Πίνακαs 4.5.1. : Γεδνκέλα ηνπ πξνβιήκαηνο. 

 

 

 

ΜΟΝΣΔΛΟ ΠΔΠΔΡΑ΢ΜΔΝΧΝ ΢ΣΟΙΥΔΙΧΝ 

  
(a) (b) 

΢τήμα4.5.2. : (a) Πιέγκα 1 (96 elements) θαη (b) Πιέγκα 2 (398 elements). 
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ΑΠΟΣΔΛΔ΢ΜΑΣΑ 

 

΢ηα ζρήκαηα 4.5.3 θαη 4.5.4., παξνπζηάδνληαη ε παξακνξθσκέλε πιάθα θαη ε 
θαηαλνκή ησλ κεηαηνπίζεσλ, αληίζηνηρα, φπσο πξνθχπηεη απφ ηελ επίιπζε ηνπ 
πξνβιήκαηνο κε ηε ρξήζε ησλ δχν πιεγκάησλ. Παξαηεξψληαο ην ζρήκα ηεο 
παξακνξθσκέλεο πιάθαο, δηαπηζηψλεη θαλείο φηη ιφγσ ηεο νπψλ πνπ  ππάξρνπλ ζην 
κέζν ηεο πιάθαο ππάξρεη κηα κέγηζηε εγθάξζηα κεηαηφπηζε, ελψ ην ζρήκα ηεο νπήο απφ 
θπθιηθφ γίλεηαη νβάι κε ην κεγάιν άμνλα ηεο έιιεηςεο λα είλαη παξάιιεινο κε ηε θφξηηζε.    

 

  
  (a)   (b) 

΢τήμα 4.5.3. : Παξακνξθσκέλε πιάθα. 

 

  

  (a)   (b) 

΢τήμα 4.5.4. : Καηαλνκή ησλ κεηαηνπίζεσλ. 
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΢ην ζρήκα 4.5.5. , παξνπζηάδεηαη ε θαηαλνκή ηεο ηζνδχλακεο ηάζεο φπσο απηή 
πξνθχπηεη απφ ην θξηηήξην αζηνρίαο Von Misses γηα ηα πιέγκαηα 1 θαη 2, αληίζηνηρα.  

 

  
  (a)   (b) 

΢τήμα 4.5.5. : Καηαλνκή ησλ ηάζεσλ. 
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4.6. ΑΝΑΛΤ΢Η ΟΡΘΟΓΧΝΙΑ΢ ΠΛΑΚΑ΢ ΜΔ 2 ΟΠΔ΢ 

 

ΠΔΡΙΓΡΑΦΗ ΣΟΤ ΠΡΟΒΛΗΜΑΣΟ΢ 

 

Ζ παξαθάησ πιάθα έρεη δηαζηάζεηο 30 mm x 340 mm x 3 mm  ε νπνία είλαη 
θαηαζθεπαζκέλε απφ ηζφηξνπν νκνγελέο πιηθφ κε κέηξν Διαζηηθφηεηαο Δ= 3 GPa θαη 
ιφγν Poisson λ = 0.35. ΢ην θέληξν ηεο πιάθαο ππάξρνπλ 2 θπθιηθέο νπέο δηακέηξνπ 6 
mm, φπσο θαίλεηαη ζην ζρήκα 4.6.1. 

 

 
΢τήμα 4.6.1. : Δθειθπζκφο νξζνγψληαο πιάθαο . 

 

 

Ζ πιάθα είλαη παθησκέλε ελψ ζηελ θάησ πιεπξά ηεο εθειθχεηαη κε κηα νξζή ηάζε 
10 Ν. ΢θνπφο ηνπ  πξνβιήκαηνο είλαη ν ππνινγηζκφο ηεο ζπγθέληξσζεο ησλ ηάζεσλ πνπ 
αλαπηχζζνληαη, ιφγσ ηεο χπαξμεο ησλ νπψλ ζηελ ίδηα ζέζε, γχξσ απφ απηέο. ΢πλνπηηθά 
φια ηα δεδνκέλα ηνπ πξνβιήκαηνο παξνπζηάδνληαη  ζηνλ πίλαθα 4.6.1. 
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ΓΔΧΜΔΣΡΙΚΑ ΥΑΡΑΚΣΗΡΙ΢ΣΙΚΑ 
ΠΛΑΚΑ΢ 

(mm) 

Όςνο (height) 340 

Πιάηνο (width) 30 

Πάρνο (thickness) 3 

Αθηίλα νπήο (radius) 3 

Ιδιόηηηες σλικού: 

Μέηξν ειαζηηθφηεηαο Ε 3 GPa 

V Λφγνο Poisson λ  0.35 

Φόρηιζη 

Δθειθπζηηθή νξζή ηάζε  10 Ν 

Πίνακας 4.6.1. : Γεδνκέλα ηνπ πξνβιήκαηνο. 

 

 

 

ΜΟΝΣΔΛΟ ΠΔΠΔΡΑ΢ΜΔΝΧΝ ΢ΣΟΙΥΔΙΧΝ 

 

  
(a) (b) 

΢τήμα 4.6.2. : (a) Πιέγκα 1 (115 elements) θαη (b) Πιέγκα 2 (421 elements). 
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ΑΠΟΣΔΛΔ΢ΜΑΣΑ 

 

΢ηα ζρήκαηα 4.6.3. θαη 4,6,4., παξνπζηάδνληαη ε παξακνξθσκέλε πιάθα θαη ε 
θαηαλνκή ησλ κεηαηνπίζεσλ, αληίζηνηρα, φπσο πξνθχπηεη απφ ηελ επίιπζε ηνπ 
πξνβιήκαηνο κε ηε ρξήζε ησλ δχν.  

 

  
      (a)        (b) 

΢τήμα 4.6.3. : Παξακνξθσκέλε πιάθα. 

 

 

  

  (a)   (b) 

΢τήμα 4.6.4. : Καηαλνκή ησλ κεηαηνπίζεσλ. 
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΢ην ζρήκα 4.6.5., παξνπζηάδεηαη ε θαηαλνκή ηεο ηζνδχλακεο ηάζεο φπσο απηή 
πξνθχπηεη απφ ην θξηηήξην αζηνρίαο Von Misses γηα ηα πιέγκαηα 1 θαη 2, αληίζηνηρα.  

 

  
  (a)   (b) 

΢τήμα 4.6.5. : Καηαλνκή ησλ ηάζεσλ.  
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4.7. ΑΝΑΛΤ΢Η ΟΡΘΟΓΧΝΙΑ΢ ΠΛΑΚΑ΢ ΜΔ ΡΧΓΜΔ΢ 

 

ΠΔΡΙΓΡΑΦΗ ΣΟΤ ΠΡΟΒΛΗΜΑΣΟ΢ 

 

Ζ παξαθάησ  νξζνγψληα πιάθα έρεη δηαζηάζεηο 85 mm x 340 mm x 3 mm  ε νπνία 
είλαη θαηαζθεπαζκέλε απφ ηζφηξνπν νκνγελέο πιηθφ κε κέηξν Διαζηηθφηεηαο Δ=3 GPa θαη 
ιφγν Poisson λ = 0.35. ΢ηελ πιάθα ππάξρνπλ 3 ξσγκέο κήθνπο 16 mmθαη πάρνπο 2 mm , 
φπσο θαίλεηαη ζην ζρήκα 4.7.1. 

 

 
΢τήμα 4.7.1 : Δθειθπζκφο νξζνγψληαο πιάθαο . 

 

 

Ζ πιάθα είλαη παθησκέλε ελψ ζηελ θάησ πιεπξά ηεο εθειθχεηαη κε κηα νξζή ηάζε  

10 Ν. ΢θνπφο είλαη ν ππνινγηζκφο ηεο ζπγθέληξσζεο ησλ ηάζεσλ πνπ αλαπηχζζνληαη, 
ιφγσ ηεο χπαξμεο ηεο νπήο, γχξσ απφ απηή. ΢πλνπηηθά φια ηα δεδνκέλα ηνπ 
πξνβιήκαηνο παξνπζηάδνληαη  ζηνλ πίλαθα 4.7.1. 
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Γεωμεηρικά ταρακηηριζηικά 
πλάκας 

(mm) 

Όςνο (height) 340 

Πιάηνο (width) 85 

Πάρνο (thickness) 3 

Ιδιόηηηες σλικού: 

Μέηξν ειαζηηθφηεηαο Ε 3 GPa 

V Λφγνο Poisson λ  0.35 

Φόρηιζη 

Δθειθπζηηθή νξζή ηάζε  10 Ν 

Πίνακας 4.7.1. : Γεδνκέλα ηνπ πξνβιήκαηνο. 

 

 

 

ΜΟΝΣΔΛΟ ΠΔΠΔΡΑ΢ΜΔΝΧΝ ΢ΣΟΙΥΔΙΧΝ 

 

  
(a) (b) 

΢τήμα 4.7.2. : (a) Πιέγκα 1 (319 elements) θαη (b) Πιέγκα 2 (1174 elements). 
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ΑΠΟΣΔΛΔ΢ΜΑΣΑ 

 

΢ηα ζρήκαηα 4.7.3 θαη 4.7.4., παξνπζηάδνληαη ε παξακνξθσκέλε πιάθα θαη ε 
θαηαλνκή ησλ κεηαηνπίζεσλ, αληίζηνηρα, φπσο πξνθχπηεη απφ ηελ επίιπζε ηνπ 
πξνβιήκαηνο κε ηε ρξήζε ησλ δχν πιεγκάησλ. Παξαηεξψληαο ην ζρήκα ηεο 
παξακνξθσκέλεο πιάθαο, δηαπηζηψλεη θαλείο φηη ιφγσ ησλ ξσγκψλ ππάξρεη ζηα άθξα 
ηεο πιάθαο κηα κέγηζηε εγθάξζηα κεηαηφπηζε, ελψ ην πάρνο ηεο ξσγκήο απμάλεηε  θαηά 
ηελ δηεχζπλζε ηνπ θνξηίνπ. 

 

  
  (a)   (b) 

΢τήμα 4.7.3. : Παξακνξθσκέλε πιάθα. 

 

 

  

  (a)   (b) 

΢τήμα 4.7.4.: Καηαλνκή ησλ κεηαηνπίζεσλ. 
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΢ην ζρήκα 4.7.5. , παξνπζηάδεηαη ε θαηαλνκή ηεο ηζνδχλακεο ηάζεο φπσο απηή 
πξνθχπηεη απφ ην θξηηήξην αζηνρίαο Von Misses γηα ηα πιέγκαηα 1 θαη 2, αληίζηνηρα.  

 

  
  (a)   (b) 

΢τήμα  4.7.5. : Καηαλνκή ησλ ηάζεσλ. 
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4.8. ΢ΤΓΚΡΙ΢Η ΓΟΚΙΜΙΧΝ ΣΟΤ ΢ΥΔΓΙΑ΢ΣΙΚΟΤ- ΠΔΙΡΑΜΑΣΙΚΟΤ ΜΔΡΟΤ΢  

Παξαθάησ απεηθνλίδεηαη κηα ζχγθξηζε κεηαμχ δνθηκίσλ κέζσ ηνπ πεηξάκαηνο ηεο 
θσηνειαζηηθφηεηαο κε απηά νπνχ ζρεδηάζηεθαλ ζην ινγηζκηθφ πξφγξακκα ANSYS. Πην 
ζπγθεθξηκέλα επηιέρηεθαλ ηα δνθίκηα πνπ αζθείηαη εθειθχζηεθα θνξηίν, ε πεηξακαηηθή 
ζπζθεπή είλαη ξπζκηζκέλε κε θπθιηθή πφισζε θαη ν δίζθνο L/4 είλαη ηνπνζεηεκέλνο ζηηο 
90°. ΋ζνλ αθνξά ην ζρεδηαζηηθφ κέξνο επηιέρηεθαλ ηα δνθίκηα πνπ είλαη δηαθξηηνπνηεκέλα 
κε ην ππθλφηεξν 2ν πιέγκα. 

΢ηελ Δηθφλα 4.1 παξνπζηάδεηαη ε ζχγθξηζε ηεο θαηαλνκήο ησλ ηάζεσλ γηα ηελ 
επίπεδε νξζνγψληα πιάθαο κε νπή.  

 

 
 

Δικόνα 4.1.: ΢χγθξηζε επίπεδεο νξζνγψληαο πιάθαο κε νπή. 
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΢ηελ Δηθφλα 4.2 παξνπζηάδεηαη ε ζχγθξηζε ηεο θαηαλνκήο ησλ ηάζεσλ γηα ην 
ζπκκεηξηθφ ζψκα.  

 

  

Δικόνα 4.2. : ΢χγθξηζε ζπκκεηξηθνχ ζψκαηνο. 
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΢ηελ Δηθφλα 4.3 παξνπζηάδεηαη ε ζχγθξηζε ηεο θαηαλνκήο ησλ ηάζεσλ ηνπ 
ζπκκεηξηθνχ ζψκαηνο  κε ηφμα απφ PLM-4B.  

 

  

Δικόνα 4.3. : ΢χγθξηζε ζπκκεηξηθνχ ζψκαηνο κε ηφμα απφ PLM-4B. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



95 
 

΢ηελ Δηθφλα 4.4. παξνπζηάδεηαη ε ζχγθξηζε ηεο θαηαλνκήο ησλ ηάζεσλ γηα ην 
ζπκκεηξηθφ ζψκα κε ηφμα απφ PLEXIGLAS. 

 

 
 

Δικόνα 4.4. : ΢χγθξηζε ζπκκεηξηθνχ ζψκαηνο κε ηφμα απφ PLEXIGLAS. 
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΢ηελ Δηθφλα 4.5. παξνπζηάδεηαη ε ζχγθξηζε ηεο θαηαλνκήο ησλ ηάζεσλ γηα ηελ 
νξζνγψληα πιάθα κε 3 εγθάξζηεο νπέο. 

 

 
 

Δικόνα 4.5. : ΢χγθξηζε νξζνγψληαο πιάθαο κε 3 εγθάξζηεο νπέο. 
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΢ηελ Δηθφλα 4.6. παξνπζηάδεηαη ε ζχγθξηζε ηεο θαηαλνκήο ησλ ηάζεσλ γηα ηελ 
νξζνγψληα πιάθα κε 2  νπέο. 

 

  

Δικόνα 4.6. : ΢χγθξηζε νξζνγψληαο πιάθαο κε 2  νπέο. 
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΢ηελ Δηθφλα 4.7. παξνπζηάδεηαη ε ζχγθξηζε ηεο θαηαλνκήο ησλ ηάζεσλ γηα ηελ 
νξζνγψληα πιάθαο κε ξσγκέο. 

 

 

  

Δικόνα 4.7. : ΢χγθξηζε νξζνγψληαο πιάθαο κε ξσγκέο. 
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΢ΤΜΠΔΡΑ΢ΜΑΣΑ 

 

΢ηελ παξνχζα πηπρηαθή εξγαζία πξνζδηνξίζηεθε πεηξακαηηθά θαη αξηζκεηηθά ε 

θαηαλνκή ησλ ηάζεσλ ζε 3 πιάθεο απφ PLM-4B θαη 4 πιάθεο απφ Plexiglas ζε απιέο 

πεξηπηψζεηο ζηαηηθψλ θαηαπνλήζεσλ. Ο πεηξακαηηθφο πξνζδηνξηζκφο έγηλε κε ηε κέζνδν 

ηεο θσηνειαζηηθνηεηαο κε ηε ρξήζε πνισζηνζθνπίνπ, ελψ ν αξηζκεηηθφο κε ηε κέζνδν 

ησλ πεπεξαζκέλσλ ζηνηρείσλ. Οη πεηξακαηηθέο θαηαλνκέο πξνζδηνξίζηεθαλ γηα δηάθνξεο 

γσλίεο πφισζεο ηνπ θσηφο θαη δηάθνξεο ζπλζήθεο πφισζεο, επηζεκαίλνληαο φηη ηα 

θαιχηεξα απνηειέζκαηα ήηαλ απηά κε θπθιηθή πφισζε ζηηο 90ν.  

Ζ απφ ηε ζχγθξηζε ησλ πεηξακαηηθψλ θαη αξηζκεηηθψλ θαηαλνκψλ πξνθχπηεη φηη 

ππάξρεη αξθεηά ηθαλνπνηεηηθή ζχγθιηζε φζνλ αθνξά ηα πνηνηηθά ραξαθηεξηζηηθά ησλ 

θαηαλνκψλ, εηδηθά ζηηο θξίζηκεο πεξηνρέο ηεο ζπγθέληξσζεο ηάζεσλ.   
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ΠΑΡΑΡΣΗΜΑTA 

Π.1.  ΟΓΗΓΙΔ΢ ΥΡΗ΢Η΢ ΠΟΛΧ΢ΙΟ΢ΚΟΠΔΙΟΤ 

 
 

5. Ηλεκηρική Δνέργεια: 220 V, 50 Ηz.  

Σν πνισζηνζθφπην είλαη έλαο εξεπλεηήο ηάζεσλ κε δηάρπην θσο γηα δηαθαλή 
κνληέια, ζπλδέεηαη κε ειεθηξηθφ ξεχκα 200 V, ζπρλφηεηα  50 Ζz θαη ηέινο έλαο 
αλεκηζηήξαο μεθηλά απηνκάησο ζηνλ πνισηή γηα ηελ ςχμε. 

 

6. Φωηιζμός: Λεσκός ή μονοτρωμαηικός.  

Oη δηαθφπηεο γηα ηνπο θσηηζκνχο είλαη ζηε βάζε ηνπ αλαιπηή .Ο δηαθφπηεο ηνπ 
ιεπθνχ θσηφο έρεη ην γξάκκα “L” θαη γηα ην κνλνρξσκαηηθφ θσο ην γξάκκα “Ν” .Οη ιάκπεο 
αηκψλ Ναηξίνπ ζέινπλ 5 ιεπηά γηα λα παξάγνπλ κνλνρξσκαηηθφ θσο θαη νη δπν θσηεηλέο 
πήγεο κπνξνχλ ακέζσο λα αλάςνπλ χζηεξα απφ ζβήζηκν ρσξίο θίλδπλν. ΋ δηαθφπηεο “Α” 
είλαη γηα ην SYNCHRO.  

 

6.  Η τρήζη ηοσ SYNCHRO 
Γηα λα ρξεζηκνπνηήζνπκε ηo SYNCHRO :  
 

 πνισηήο θαη αλαιπηήο πξέπεη λα είλαη ζηε ζέζε κεδέλ (γξακκηθή πφισζε) ή 
ζηελ δηαγψληα ζέζε (θπθιηθή πφισζε)  

 ηα ζπλδεηηθά ηζηκπηδάθηα ζηνλ αλαιπηή θαη ζηνλ πνισηή πξέπεη λα είλαη ζηελ 
θαηάιιειε ζέζε.  

 νη θνριίεο ζηνλ πνισηή θαη ζηνλ αλαιπηή πξέπεη λα είλαη ραιαξσκέλνη.  

 

Πηέδνπκε ηνλ δηαθφπηε Α ζηε βάζε ηνπ αλαιπηή. ΋ηαλ ζηξέθνπκε ηνλ ζπλδεδεκέλν 
δίζθν L/4 θαη ηνλ πνισηή ζηνλ αλαιπηή κε ην ρέξη, ν δίζθνο L/4 θαη ν πνισηήο επίζεο 
ζπλδεδεκέλα ζηνλ πνισηή αθνινπζνχλ απηνκάησο θαη ζπγρξφλσο ηελ ίδηα δηεχζπλζε θαη 
ή γσλία παξακέλεη ή ίδηα.  

 

ΠΡΟ΢ΟΧΗ: Απηή ή κεηαθίλεζε πξέπεη λα είλαη αξγή θαη απαιή.  

΢ηελ πεξίπησζε ιάζνπο ζβήλνπκε ην SYΝCHRO θαη θάλνπκε επαλεθθίλεζε  

 

7. Δίδος πόλωζης: Γραμμική και κσκλική. 

Σν είδνο ηεο πφισζεο είλαη δπλαηφ λα κεηαβιεζεί κε ηελ πεξηζηξνθή ησλ 
ηεζζάξσλ ζηνηρείσλ πφισζεο. Γηα θάζε ζέζε ππάξρνπλ κεξηθά ελδεηθηηθά ζεκεία θαη 
θιίκαθεο.  Kαη’ αξράο ππάξρνπλ δχν ζηαζεξέο ελδεηθηηθέο νπέο  ζηελ θνξπθή ηνπ πνισηή 
θαη αλαιπηή γηα γσλίεο ζηελ πεξηθέξεηα απφ 0˚ έσο 180˚ πξνο ηηο δχν δηεπζχλζεηο 
ππνδηαηξεκέλεο ζε ζέζεηο αλά 10 βαζκνχο. ΢ηελ πεξηζηξεθφκελε πιάθα L/4 ηνπ πνισηή 
νη ζέζεηο πεξηθεξεηαθά ησλ 0 θαη 45 βαζκψλ γσλίεο. Δπί ηεο πεξηζηξεθφκελεο πιάθαο L/4 
ηνπ αλαιπηή ππάξρεη πεξηθεξεηαθά κηα θιίκαθα απφ 0˚ έσο 180˚ πξνο ηηο δχν δηεπζχλζεηο 
ππνδηαηξεκέλεο ζε 1/1˚. Οη πεξηζηξεθφκελνη πνισηέο ζηνλ πνισηή θαη ηνλ αλαιπηή 
δείρλνπλ κφλν έλα βέινο ζηελ πεξηθέξεηα ηνπο. Απηά ηα βέιε είλαη δηεπζεηεκέλα κε ηέηνην 
ηξφπν ψζηε φηαλ ζπκπέζνπλ ε ζέα ηνπ πεδίνπ γίλεηαη καχξε.  
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iii. Γξακκηθή πόιωζε (ζέζε 0) 
Πξηλ ελεξγνπνηήζνπκε ηε γξακκηθή πφισζε ραιαξψλνπκε ηηο δπν βίδεο θαη 

ζέηνπκε φια ηα ζεκεία ησλ πνισηψλ θαη ησλ πιαθψλ L/4 ζηελ ζέζε κεδέλ ησλ θιηκάθσλ. 
Δάλ φια ηα ζεκεία κεδέλ ζπκπίπηνπλ , έρνπκε γξακκηθή πφισζε θαη ζέα καχξνπ πεδίνπ. 
Γηα θαιχηεξν έιεγρν κπνξνχκε λα ρξεζηκνπνηήζνπκε ηνπο ξπζκηδφκελνπο θνριίεο ζηε 
βάζε ηνπ αλαιπηή. Οη πνισηέο ζηνλ πνισηή θαη αλαιπηή είλαη πνισκέλνη ζηαπξσηά θαη νη 
δίζθνη L/4 απνδεηθλχνληαη κε επαξθείο.  

 Λακβάλνληαο ππφςε ηελ ζπνπδαηφηεηα απηήο ηεο ζέζεσο έλα ηζηκπηδάθη  
αζθαιείαο ζε κνξθή θνξηηζκέλνπ ζπλδεηηθνχ ειαηεξίνπ πξνζηίζεηαη ζηνλ πνισηή θαη 
αλαιπηή. Δθφζνλ ηα ειαηεξησηά ηζηκπηδάθηα δξνπλ, νη πνισηέο θαη νη πιάθεο L/4 
ζηξέθνληαη κφλν ζπγρξφλσο. Έηζη είλαη απαξαίηεην γηα λα πάξνπκε ζπγρξνληζκέλε 
πεξηζηξνθηθή θίλεζε.  

 

iv. Κπθιηθή πόιωζε(δηαγώληνο ζέζε) 
Γηα ηελ θπθιηθή πφισζε ν πνισηήο ζηνλ πνισηή θαη ε πιάθα L/4 ζηνλ αλαιπηή 

πξέπεη λα είλαη ζηε ζέζε κεδέλ.  Γηα λα θξαηήζνπκε απηά ηα ζηνηρεία ζε απηέο ηηο ζέζεηο 
ρξεζηκνπνηνχκε ηνπο δχν θνριίεο ζηνλ πνισηή θαη αλαιπηή. Σφηε απνκαθξχλνπκε ηα δχν 
ζπλδεηηθά ηζηκπηδάθηα θαη ζηξέθνπκε ηηο πιάθεο L/4 ζηνλ πνισηή θαη ηνλ πνισηή ζηνλ 
αλαιπηή 45 βαζκνχο θαηά δηεχζπλζε αληίζεηε πξνο ηελ θνξά ησλ δεηθηψλ ηνπ ξνινγηνχ. 
΢ε απηέο ηηο ζέζεηο ζα βξνχκε ηφηε λέεο νπέο γηα ηα ζπλδεηηθά ηζηκπηδάθηα, γηα λα 
δηαηεξήζνπκε ηε θιίζε γηα θπθιηθά πνισκέλν θσο.  
 
 

8. Μεηρήζεις ηων θωηοελαζηικών δεδομένων με ηην βοήθεια ηων δίζκων 
L/4(μέθοδος SENARMONT) 

Γηα λα αξρίζνπκε ηηο κεηξήζεηο ησλ θσηνειαζηηθψλ δεδνκέλσλ ζε δηαθαλέο 
κνληέιν κε ην πνισζηνζθφπην πξέπεη:  

 ΋ιεο νη ζέζεηο πξέπεη λα είλαη ζην κεδέλ.  

 Σν θσο πξέπεη λα είλαη κνλνρξσκαηηθφ.  

 ΋ δηαθφπηεο Α πξέπεη λα είλαη ζηε ζέζε ΟΝ. 

 

 Παξαηεξψληαο κέζα απφ ηνλ  αλαιπηή ζα αλαγλσξίζεηε ηφηε γξακκέο έγρξσκεο 
θαη καχξεο ζην κνληέιν πνχ ζα εμεηαζηεί. Τπάξρεη έλα καχξν πεδίν γχξσ απφ ην 
αληηθείκελν. ΢ηξέθνληαο ην αληηθείκελν νη έγρξσκεο γξακκέο δελ αιιάδνπλ, νη καχξεο 
γξακκέο φκσο θηλνχληαη. Απηέο είλαη νη ηζνθιηλείο γξακκέο.  

΢ηελ πξάμε δελ πξέπεη λα ζηξέθεηαη ην κνληέιν πνπ εμεηάδεηαη. Σν πνισζηνζθφπην 
επηηξέπεη λα ζηξέθεηαη ν αλαιπηήο. Πξψηα ζηξέθνπκε ηνλ αλαιπηή έσο φηνπ κηα 
ηζνθιηλείο επαλεκθαληζζεί ζην ζεκείν εξεπλάο ηνπ κνληέινπ. Σφηε ζηξέθνπκε ην 
SYΝCHRO θαηά 45˚ θαηά ηελ δηεχζπλζε ησλ δεηθηψλ ηνπ ξνινγηνχ θαη ζβήλνπκε ην 
SYΝCHRO. Απηφ θαηαιήγεη ζε θπθιηθά πνισκέλν θσο. Μεηά ζθίγγνπκε ηηο βίδεο ζηνλ 
αλαιπηή, ηξαβάκε έμσ ηα ειαηήξηα ζπλδέζεσο θαη ζηξέθνπκε ηνλ πνισηή ζηνλ αλαιπηή 
έσο φηνπ ε ηζνθιηλήο επαλεκθαληζζεί ζην πξνο εξεπλά ζεκείν.  

Ή γσλία ζηξνθήο W κπνξεί λα δηαβαζηεί ζηνλ αλαιπηή θαη ρξεζηκνπνηνχκε ηνλ 
αθφινπζν ηχπν γηα ηνλ ππνινγηζκφ ηνπ: 

 

𝑔 = 589 ∗
10−6

180
∗ 𝑊  (𝑚𝑚)                                                                           (2.6.1) 
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Σελ  δηαθνξά ησλ θξνζζψλ  ζην πξνο εξεπλά ζεκείν ηνπ κνληέινπ ηελ 
ππνινγίδνπκε σο εμήο. : 

𝑛1 − 𝑛2 = 589 ∗
10−6

180
∗

𝑊

𝑑
  (𝑚𝑚)                                                                 (2.6.2) 

 

ΠΟΛΧ΢ΙΟ΢ΚΟΠΔΙΟ 
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Π.2. ΒΗΜΑ ΠΡΟ΢ ΒΗΜΑ ΚΑΣΑ΢ΚΔΤΗ ΣΧΝ ΜΟΝΣΔΛΧΝ (TUTORIALS) 
TΧΝ ΠΡΟΒΛΗΜΑΣΧΝ ΣΟΤ ΚΔΦ. 4 

 

΢πγθεθξηκέλα ζηα πεηξάκαηα καο αλαπηχζζεηαη ν ζρεδηαζκφο ηνπ πξαγκαηηθψλ 
δνθηκίσλ. Με ηελ βνήζεηα ηνπ πεξηβάιινληνο ηνπ πξνγξάκκαηνο Ansys 14 
πξνζνκνηψλεηαη ν ηξφπνο θφξηηζεο ηνπο, κε βάζε ηηο πξαγκαηηθέο θνξηίζεηο. Σα βήκαηα 
πνπ αθνινπζήζεθαλ είλαη ηα παξαθάησ:  

I. Καηαζθεπή ηεο γεσκεηξίαο ησλ δνθηκίσλ ζην ζρεδηαζηηθφ πεξηβάιινλ ηνπ 
πξνγξάκκαηνο.  

II. Οξηζκφο ησλ θπζηθψλ θαη ησλ κεραληθψλ ηδηνηήησλ ησλ πιηθψλ κε βάζε ηα 
δεδνκέλα ηεο βηβιηνγξαθίαο.  

III. Δπηινγή ηνπ είδνπο ησλ πεπεξαζκέλσλ ζηνηρείσλ πνπ ζα ρξεζηκνπνηεζνχλ γηα 
ηελ δηαθξηηνπνίεζε ηεο γεσκεηξίαο, θαη πιεγκαηνπνίεζε.  

IV. Δπηινγή ηνπ είδνπο ησλ νξηαθψλ ζπλζεθψλ θαη επηβνιή δηαθφξσλ θνξηίζεσλ.  
V. Δπηινγή ηνπ ηξφπνπ επίιπζεο ηνπ πξνβιήκαηνο θαη επίιπζε.  

 

Π.1.  ΠΡΟΒΛΗΜΑ 4 .1: ΑΝΑΛΤ΢Η ΔΠΙΠΔΓΗ΢ ΟΡΘΟΓΧΝΙΑ΢ 
 ΠΛΑΚΑ΢ 

Αλνίγνπκε ην ANSYS.14. Αξρηθά ζην file management=>working directory θαη 
απνζεθεχνπκε ζε έλα θάθειν κε φλνκα job name γηα λα απνζεθεπηεί ε εξγαζία καο. ΢ηε 
ζπλέρεηα επηιέγνπκε RUN θαη εκθαλίδεηε ην πεξηβάιινλ εξγαζίαο ηνπ ππνινγηζηηθνχ 
πξνγξάκκαηνο πεπεξαζκέλσλ  ζηνηρείσλ ANSYS 14. 
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1.ΓΔΧΜΔΣΡΙΑ ΚΑΣΑ΢ΚΔΤΗ΢ 

 

ΒΗΜΑ1Ο: ΓΗΜΙΟΤΡΓΙΑ ΣΔΣΡΑΓΧΝΟΤ. 

 

΢ην main menu επηιέγνπκε γηα λα δεκηνπξγήζνπκε ην ηεηξάγσλν : 

Preprocessor =>Modeling =>Create => Areas => Rectangle=>by 2 Corners 

Δκθαλίδεηαη ε παξαθάησ θαξηέια, δίλνληαο δηαζηάζεηο 40 mm Υ 170 mm: 
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ΒΗΜΑ 2Ο: ΓΗΜΙΟΤΡΓΙΑ ΟΠΗ΢ ΑΚΣΙΝΑ΢ 9 mm. 

 

Γηα λα δεκηνπξγήζνπκε ηελ νπή αθνινπζνχκε ηελ εμήο δηαδηθαζία. Απφ ην αξηζηεξφ 
κελνχ επηιέγνπκε: 

Preprocessor =>Modelling=>Create=>Areas=>Circle=>Solid circle 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



106 
 

 

ΒΗΜΑ 3Ο: ΑΦΑΙΡΔ΢Η ΟΠΗ΢ 

 

΢ηελ ζπλέρεηα αθαηξνχκε ηελ νπή κε ηελ παξαθάησ δηαδηθαζία : 

Preprocessor =>Modelling =>Operate=>Booleans=>Subtract => Areas 

Δπηιεγνχκε  ηελ βαζηθή επηθάλεηα θαη κε ηελ εληνιή Apply επηιέγνπκε ηελ 
αθαηξνχκελε επηθάλεηα.  
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ΒΗΜΑ 4Ο: ΟΡΙ΢ΜΟ΢ ΢ΣΟΙΥΔΙΧΝ 

 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

Preprocessor =>Element Type =>Add/Edit/Delete 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Add. ΢ε απηήλ ηελ θαξηέια  κπνξνχκε λα 
πξνζζέζνπκε έλα ζηνηρείν (Add), λα δηαγξάςνπκε έλα επηιεγκέλν ζηνηρείν (Delete) ή λα 
ειέγμνπκε ηα ραξαθηεξηζηηθά ηνπ ζηνηρείνπ (Options). 

 

 

Έπεηηα ζηελ θαξηέια πνπ εκθαλίδεηαη απφ ην κελνχ solid επηιέγνπκε ην ζηνηρείν 
8note183 θαη παηάκε ΟΚ. 

 

 
 

΢ηελ ζπλέρεηα , εθφζνλ επηιέμνπκε ην ΟΚ απφ ηελ επηινγή ηνπ ζηνηρείνπ  
εκθαλίδεηαη ε παξαθάησ θαξηέια , φπνπ πξέπεη λα ηνπ δψζνπκε ηηο Υαξαθηεξηζηηθέο 
ηδηφηεηεο ηνπ πιηθνχ, δειαδή ην ζρήκα (Κ1), εκείο επηιέμακε ηεηξάπιεπξν .΢ηελ ζπλέρεηα 
αλαθέξνπκε πσο ζπκπεξηθέξεηαη ην πιηθφ (Κ3) κε επίπεδε εληαηηθή θαηάζηαζε ηφζν ζην 
πάρνο φζν θαη ζην κήθνο  θαη ηέινο πσο δηαηππψλεηαη ην ζηνηρεηφ , δειαδή πσο 
κεηαηνπίδεηαη (Κ5 ). 
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ΒΗΜΑ 5Ο: ΚΑΘΟΡΙ΢ΜΟ΢ ΓΔΧΜΔΣΡΙΚΧΝ ΙΓΙΟΣΗΣΧΝ 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

Preprocessor =>Element Type =>Add/Edit/Delete 

Δπηιέγνπκε Add θαη ζηελ ζπλέρεηα ΟΚ ζηελ θαξηέια πνπ εκθαλίδεηαη. 

 
 

΢ηελ ζπλέρεηα επηιεγνχκε ηα γεσκεηξηθά ραξαθηεξηζηηθά ηνπ πιηθνχ. Γηα ηελ 
ζπγθεθξηκέλε πεξίπησζε ην πάρνο είλαη 5 mm. 
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ΒΗΜΑ 6O: ΙΓΙΟΣΗΣΔ΢ ΤΛΙΚΟΤ. 

 

Ο νξηζκφο ηνπ πιηθνχ ζα γίλεη σο εμήο: Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

Preprocessor => Material Props => Material Models =>Structural =>Linear =>Elastic 
=>Isotropic 

΋πσο θαίλεηαη παξαθάησ Δπηιέγνπκε ηελ ζπκπεξηθνξά ηνπ πιηθνχ (Η΢ΟΣΡΟΠΟ ΤΛΗΚΟ). 

 

 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παξαθάησ ζπκπιεξψλνπκε ην κέηξν ειαζηηθφηεηαο 
ΕΧ  θαη ην ιφγν Poisson PRXY θαη επηιέγνπκε ην OK .΋πνπ  ΔΥ=0,13 GPa θαη  
PRXY=0,45 
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Δπίζεο ζηελ ίδηα θαξηέια επηιέγνπκε ηελ εληνιή Density θαη νξίδνπκε ηελ 
ππθλφηεηα πιηθνχ: DENS=2680 kg/m³  . 
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ΒΗΜΑ 7Ο: ΜΔΓΔΘΟ΢ ΠΡΧΣΟΤ ΠΛΔΓΜΑΣΟ΢ 

 

Ζ επηινγή ηνπ κήθνπο ησλ ζηνηρείσλ γίλεηαη σο εμήο: Απφ ην αξηζηεξφ κελνχ 
επηιέγνπκε : 

Preprocessor =>Meshing=>Size Controls=>Manual Size=>Areas 

=>All Areas 

Δκθαλίδεηαη ε παξαθάησ θαξηέια φπνπ ζπκπιεξψλνπκε ζε πφζα ηκήκαηα ζα 
δηαρσξηζηεί ην ζηνηρείν θαη παηάκε ΟΚ, εκείο επηιέμακε 10 ηκήκαηα. 

 

 

ΒΗΜΑ 8Ο: ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η (ΠΡΧΣΟ ΠΛΔΓΜΑ ΢Δ 10 ΣΜΗΜΑΣΑ). 

 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

Preprocessor=>Meshing=>Mesh=>Volumes=>Free 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παηάκε pick all γηα λα επηιεγεί νιφθιεξε ε 
επηθάλεηα.  
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ΒΗΜΑ 9Ο: ΟΡΙ΢ΜΟ΢ ΔΙΓΟΤ΢ ΑΝΑΛΤ΢Η΢ 

Σν είδνο ηεο αλάιπζεο νξίδεηαη σο εμήο, Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

Solution =>Analysis Type => New Analysis 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παηάκε static.  

 

 
 

 

 

ΒΗΜΑ 10Ο: ΟΡΙ΢ΜΟ΢ ΢ΣΗΡΙΞΔΧΝ 

Γηα λα νξίζνπκε ηηο ζηεξίμεηο αθνινπζνχκε ηελ εμήο δηαδηθαζία: Απφ ην αξηζηεξφ 
κελνχ επηιέγνπκε : 

Solution =>Define Loads =>Apply =>Structural =>Displacement 

Δπηιέγνπκε ηελ εληνιή  On Areas θαη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Pick 
All. Αθνχ επηιέμνπκε ηελ επηθάλεηα πνπ ζέινπκε λα παθηψζνπκε, έπεηηα ζηε λέα θαξηέια 
πνπ εκθαλίδεηαη επηιέγνπκε All Dof θαη παηάκε ΟΚ. 
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ΒΗΜΑ 11Ο: ΟΡΙ΢ΜΟ΢ ΓΤΝΑΜΔΧΝ 

Γηα λα νξίζνπκε ηελ ηηκή θαη ηελ δηεχζπλζε ηνπ θνξηίνπ αθνινπζνχκε ηηο εμήο 
εληνιέο:  

Solution =>Define Loads =>Apply =>Structural =>Pressure =>On Lines. 

΢ηε ζπλέρεηα επηιέγνπκε ηε θάησ γξακκή ηεο πιάθαο, παηάκε OK θαη ζηελ θαξηέια 
πνπ εκθαλίδεηαη ζπκπιεξψλνπκε ηελ ηηκή ηνπ θνξηίνπ (-4 KP). Σν θνξηίν έρεη αξλεηηθφ 
πξφζεκν δηφηη ην ANSYS αληηιακβάλεηαη ηα εθειθπζηηθά θνξηία σο αξλεηηθά θαη ηα 
ζιηπηηθά σο ζεηηθά. 

 
 

 

ΒΗΜΑ 12Ο: ΔΠΙΛΤ΢Η ΣΟΤ ΠΡΟΒΛΗΜΑΣΟ΢. 

Δθηεινχκε ηελ επίιπζε απφ ην αξηζηεξφ κελνχ : 

Solution=>Solve=>Current LS. 

 ΋ηαλ ηειεηψζνπλ νη ππνινγηζκνί ην πξφγξακκα καο ελεκεξψλεη κε ην παξαθάησ 
κήλπκα: 
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ΒΗΜΑ 13ο: ΠΡΟΒΟΛΗ ΑΠΟΣΔΛΔ΢ΜΑΣΧΝ. 

 

Α) ΠΑΡΑΜΟΡΦΧΜΔΝΟ ΢ΧΜΑ 

 

Σν ANSYS καο δίλεη ηελ δπλαηφηεηα απεηθφληζεο ηνπ παξακνξθσκέλνπ ζψκαηνο. 
Απφ ην αξηζηεξφ κελνχ αθνινπζνχκε ηελ γλσζηή αθνινπζία : 

General Postproc =>Plot Results=>Deformed Shape=>def + underformed 

 

 
 

Καη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε OK. Έπεηηα εκθαλίδεηαη ην 
παξακνξθσκέλν ζψκα . 
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Β) ΚΑΣΑΝΟΜΗ ΣΧΝ ΜΔΣΑΣΟΠΙ΢ΔΧΝ 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

General Postproc=>Plot Results=>Contour Plot=>Nodal Solution 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παξαθάησ επηιέγνπκε:   

DOF Solution =>Displacement vector sum θαη έπεηηα επηιέγνπκε ΟΚ  

Οπφηε εκθαλίδεηαη ην ζρήκα ησλ κεηαηνπίζεσλ.  
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Γ) ΚΑΣΑΝΟΜΗ ΣΧΝ ΣΑ΢ΔΧΝ 

Δθηεινχκε πάιη ηελ ίδηα δηαδηθαζία απφ ην αξηζηεξφ κελνχ:  

General Postproc =>Plot Results =>Contour Plot =>Nodal Solution 

 

Kαη ζηελ ίδηα θαξηέια πνπ εκθαλίδεηαη απηή ηε θνξά επηιέγνπκε:  

Stress =>Von Misses Stress θαη παηάκε ΟΚ. 
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ΒΗΜΑ 13Ο: ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η (ΓΔΤΣΔΡΟ ΠΛΔΓΜΑ). 

Με ζθνπφ ηελ ζχγθξηζε ησλ απνηειεζκάησλ ην δνθίκην δηαθξηηνπνηείηαη πάιη κε 
δηαθνξεηηθφ κέγεζνο ζηνηρείσλ. Οπφηε αθνινπζνχκε ηελ εμήο δηαδηθαζία:  

Preprocessor =>Meshing =>Size Controls=>Manual Size =>Areas>All Areas 

΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξψλνπκε ην λέν κήθνο ζηνηρείσλ. 

 

 

 

ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η: 

 

Λχλνπκε ην ζχζηεκα θαη παίξλνπκε ηα δεχηεξα απνηειέζκαηα: 
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Α) ΠΑΡΑΜΟΡΦΧΜΔΝΟ ΢ΧΜΑ: 

 

Β) ΜΔΣΑΣΟΠΙ΢ΔΙ΢: 
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Γ) ΚΑΣΑΝΟΜΗ ΣΑ΢ΔΧΝ 
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Π.2. ΠΡΟΒΛΗΜΑ 4 .2: ΑΝΑΛΤ΢Η ΢ΤΜΜΔΣΡΙΚΟΤ ΢ΧΜΑΣΟ΢. 

Αλνίγνπκε ην ANSYS.14. Αξρηθά ζην File management=>working directory θαη 
απνζεθεχνπκε ζε έλα θάθειν κε φλνκα job name γηα λα απνζεθεπηεί ε εξγαζία καο. ΢ηε 
ζπλέρεηα επηιέγνπκε RUN θαη εκθαλίδεηε ην ζρεδηαζηηθφ πεξηβάιινλ ηνπ πξνγξάκκαηνο 
ANSYS. 
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1. ΓΔΧΜΔΣΡΙΑ ΚΑΣΑ΢ΚΔΤΗ΢ 

 

ΒΗΜΑ 1ο:  ΣΟΠΟΘΔΣΗ΢Η ΢ΗΜΔΙΧΝ 

 

΢ην main menu επηιέγνπκε: 

Preprocessor =>modelling =>create =>key points =>in active CS 

Καη ζηελ θαξηέια πνπ εκθαλίδεηε δίλνπκε ηα παξαθάησ ζεκεία . 

Δπηιέγνπκε ην  Apply βάδνληαο φια ηα ζεκεία θαη αληίζηνηρα επηιέγνπκε ην ΟΚ. 

 

΢ηνλ παξαθάησ πίλαθα αλαιχνληαη νη ζπληεηαγκέλεο γηα ηελ δεκηνπξγία ηνπ 
ζρεδίνπ.  

 

α/α X Y 

0 0 0 

1 0 20 

2 5 25 

3 5 120 

4 30 120 

5 30 25 

5 35 20 

7 35 0 

8 0 0 
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ΒΗΜΑ 2Ο: ΓΗΜΙΟΤΡΓΙΑ ΢ΗΜΔΙΧΝ  

 

Σα ζεκεία ηα ελψλνπκε σο εμήο: 

Preprocessor =>modelling =>create=>Lines=>Lines=>Straight line. 

Δκθαλίδεηαη έλα καρηελάκι θαη ν θέξζνξαο γίλεηαη έλα ελεξγφ βέινο. Έπεηηα 
επηιέγνπκε ηα ζεκεία ησλ επζεηψλ γξακκψλ, θαη πξνθχπηεη : 

 

 

ΒΗΜΑ 3Ο: ΢ΥΔΓΙΑ΢Η ΣΧΝ ΣΟΞΧΝ. 

 

 Απφ ην αξηζηεξφ κελνχ : 

Preprocessor =>Modelling =>Create =>Lines =>Arcs =>By End KPs & Rad 

Δκθαλίδεηαη ε παξαθάησ θαξηέια φπνπ Γεκηνπξγνχκε ηφμν ζηα ζεκεία 1 θαη 2 : 
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΋πνπ RAD : Αθηίλα ηνπ ηφμνπ  (5 mm) 

P1, P2: Σα ζεκεία έλσζεο (10-20) κε ηφμν θαη ζηελ ζπλέρεηα ελψλνληαη ηα ζεκεία (50-60)  

PC   ΚΡ: Σν θέληξν ηεο θπξηφηεηαο ηνπ ηφμνπ σο πξνο ην ζεκείν (30) θαη ζηελ ζπλέρεηα κε 
ηελ ηδία δηαδηθαζία επηιέγνπκε ην ζεκείν (40). 

Δπηιέγνπκε ην επφκελν ζεκείν, φπνπ είλαη ην θέληξν ηεο θπξηφηεηαο θαη παηάκε ΟΚ. 

 

Παξαθάησ απεηθνλίδεηαη ε νινθιήξσζε ησλ ηφμσλ . 
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ΒΗΜΑ 4Ο: ΓΗΜΙΟΤΡΓΙΑ ΔΠΙΦΑΝΔΙΑ΢ 

 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε: 

Preprocessor =>Modelling =>Create =>Areas =>Arbitrary=>Βy lines 

Δπηιέγνπκε  ην πεξίγξακκα ηνπ ζρήκαηνο θαη παηάκε ΟΚ. 

 

 

 

ΒΗΜΑ 5Ο: ΓΗΜΙΟΤΡΓΙΑ ΟΠΗ΢ 

 

Γηα λα δεκηνπξγήζνπκε ηελ νπή αθνινπζνχκε ηελ εμήο δηαδηθαζία. Απφ ην αξηζηεξφ 
κελνχ επηιέγνπκε: 

Preprocessor =>Modelling =>Create =>Areas=>Circle=>Solid circle 

Σνπνζεηνχκε  ηα  παξαθάησ ζεκεία κε ηελ εληνιή Apply θαη ηέινο επηιέγνπκε ην 
ΟΚ γηα λα απνζεθεπηνχλ. 

 

α/α X Y R 

1 5 8 2 

2 17.5 8 2 

3 30 8 2 
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ΒΗΜΑ 5Ο: ΑΦΑΙΡΔ΢Η ΟΠΧΝ. 

Γηα λα αθαηξέζνπκε ηελ νπή αθνινπζνχκε ηελ εμήο δηαδηθαζία. Απφ ην αξηζηεξφ 
κελνχ επηιέγνπκε: 

Preprocessor =>Modelling =>Operate =>Booleans =>Subtract =>Areas 

Δπηιέγνπκε ηελ βαζηθή επηθάλεηα θαη κε ηελ εληνιή Apply επηιέγνπκε ηηο 
αθαηξνχκελεο επηθάλεηεο. 
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ΒΗΜΑ 7Ο: ΟΡΙ΢ΜΟ΢ ΢ΣΟΙΥΔΙΧΝ 

 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

Preprocessor => Element Type =>Add/Edit/Delete 

Δκθαλίδεηαη ε παξαθάησ θαξηέια φπνπ κπνξνχκε λα πξνζζέζνπκε έλα ζηνηρείν 
(Add) , λα δηαγξάςνπκε έλα επηιεγκέλν ζηνηρείν (Delete) ή λα ειέγμνπκε ηα 
ραξαθηεξηζηηθά ηνπ ζηνηρείνπ (Options). 

 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Add θαη ζηελ λέα θαξηέια απφ ην κελνχ 
Solid ,επηιέγνπκε 8note183 θαη ζηελ ζπλέρεηα παηάκε ΟΚ  

 

 

΢ηελ ζπλέρεηα απφ ηελ παξαπάλσ θαξηέια πνπ εκθαλίζηεθε ,επηιέγνπκε ηελ 

εληνιή options θαη ειέγρνπκε ηα ραξαθηεξηζηηθά ηνπ ζηέξενπ ζψκαηνο . Πξνθχπηεη ε 

παξαθάησ θαξηέια. 
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Γηα λα νξίζνπκε ηελ ζπκπεξηθνξά ηνπ πιηθνχ πξέπεη λα ηνπ δψζνπκε αξρηθά ην 
ζρήκα (Κ1) , εκείο επηιέμακε ηεηξάπιεπξν .΢ηελ ζπλέρεηα αλαθέξνπκε πσο 
ζπκπεξηθέξεηαη ην πιηθφ (Κ3) κε επίπεδε εληαηηθή θαηάζηαζε ηφζν ζην πάρνο φζν θαη ζην 
κήθνο  θαη ηέινο πσο δηαηππψλεηαη ην ζηνηρεηφ , δειαδή πσο κεηαηνπίδεηαη (Κ5 ). 

 

 

ΒΗΜΑ 8Ο: ΚΑΘΟΡΙ΢ΜΟ΢ ΓΔΧΜΔΣΡΙΚΧΝ ΙΓΙΟΣΗΣΧΝ 

Απφ ην αξηζηεξφ κελνχ : 

Preprocessor => Real Constants => Add/Edit/Delete 

Δπηιέγνπκε Add θαη ζηελ ζπλέρεηα ΟΚ ζηελ θαξηέια πνπ εκθαλίδεηαη επηιεγνχκε ην 
ζηνηρείν. 

 

 

΢ηελ παξαθάησ θαξηέια θαζνξίδνπκε ηα γεσκεηξηθά ραξαθηεξηζηηθά ηνπ ζηνηρείνπ 

PLANE 183, κε πάρνο πιάθαο 5 mm. 
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ΒΗΜΑ 9O: ΙΓΙΟΣΗΣΔ΢ ΤΛΙΚΟΤ 

 

Ο νξηζκφο ηνπ πιηθνχ ζα γίλεη σο εμήο:  Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

Preprocessor => Material Props => Material Models => Structural => Linear => 
Elastic => Isotropic 

φπσο θαίλεηαη παξαθάησ: 

 

 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παξαθάησ ζπκπιεξψλνπκε ην κέηξν ειαζηηθφηεηαο 
ΔΥ  θαη ην ιφγν Poisson PRXY. ΋πνπ  ΔΥ=0,13 GPa θαη  PRXY=0,45 

 

 

 

 



129 
 

 
 

 

Δπίζεο ζηελ ίδηα θαξηέια επηιέγνπκε ηελ εληνιή Density θαη νξίδνπκε ηελ 

ππθλφηεηα ηνπ πιηθνχ: DENS=2680 kg/m³ 
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ΒΗΜΑ 10Ο: ΜΔΓΔΘΟ΢ ΠΡΧΣΟΤ ΠΛΔΓΜΑΣΟ΢ (10 ΣΜΗΜΑΣΑ) 

 

Ζ επηινγή ηνπ κήθνπο ησλ ζηνηρείσλ γίλεηαη σο εμήο: Απφ ην αξηζηεξφ κελνχ 
επηιέγνπκε : 

Preprocessor =>Meshing =>Size Controls =>Manual Size =>Areas =>All Areas 

Δκθαλίδεηαη ε παξαθάησ θαξηέια φπνπ ζπκπιεξψλνπκε ην κήθνο ησλ ζηνηρείσλ 
θαη παηάκε ΟΚ. 

 

 

ΒΗΜΑ 11Ο: ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η (ΠΡΧΣΟ ΠΛΔΓΜΑ) 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

Preprocessor=>Meshing=>Mesh=>Volumes=>Free 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Pick All γηα λα επηιεγεί νιφθιεξε ε επηθάλεηα θαη 
πξνθχπηεη. 
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ΒΗΜΑ 12Ο: ΟΡΙ΢ΜΟ΢ ΔΙΓΟΤ΢ ΑΝΑΛΤ΢Η΢ 

Σν είδνο ηεο αλάιπζεο νξίδεηαη σο εμήο: Απφ ην αξηζηεξφ κελνχ επηιέγνπκε:  

Solution=>Analysis Type=>New Analysis 

θαη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Static. 

 

 
 

 

ΒΗΜΑ 13Ο: ΟΡΙ΢ΜΟ΢ ΢ΣΗΡΙΞΔΧΝ 

Γηα λα νξίζνπκε ηηο ζηεξίμεηο αθνινπζνχκε ηελ εμήο δηαδηθαζία:  

Solution =>Define Loads =>Apply =>Structural =>Displacement 

Δπηιέγνπκε On Areas θαη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Pick All. 

Αθνχ επηιέμνπκε ηελ επηθάλεηα πνπ ζέινπκε λα παθηψζνπκε έπεηηα ζηε λέα 
θαξηέια πνπ εκθαλίδεηαη επηιέγνπκε All Dof θαη παηάκε ΟΚ. 
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ΒΗΜΑ 14Ο: ΟΡΙ΢ΜΟ΢ ΓΤΝΑΜΔΧΝ 

Γηα λα νξίζνπκε ηελ ηηκή θαη ηελ δηεχζπλζε ηνπ θνξηίνπ αθνινπζνχκε ηηο εμήο 
εληνιέο:  

Solution =>Define Loads =>Apply =>Structural =>Force/Moment=> 

On Key points 

Δπηιέγνπκε ην θάησ κέξνο ηεο κεζαίαο νπήο, επηιέγνπκε ηνλ άμνλα εθαξκνγήο ηεο 
δχλακεο (FY) θαη εθαξκφδνπκε δχλακε 4N (κε πξφζεκν κείσλ(-)). 

 

 
 

΢ηελ παξαθάησ εηθφλα απεηθνλίδνληαη νη δπλάκεηο θαη ηα ζεκεία ζηήξημεο.  
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ΒΗΜΑ 15Ο: ΔΠΙΛΤ΢Η ΣΟΤ ΠΡΟΒΛΗΜΑΣΟ΢ 

Δθηεινχκε ηελ επίιπζε απφ ην αξηζηεξφ κελνχ : 

Solution=>Solve=>Current LS. 

 ΋ηαλ ηειεηψζνπλ νη ππνινγηζκνί ην πξφγξακκα καο ελεκεξψλεη κε ην παξαθάησ 
κήλπκα: 

 

 

 

ΒΗΜΑ 16Ο: ΠΡΟΒΟΛΗ ΑΠΟΣΔΛΔ΢ΜΑΣΧΝ 

 

Α) ΠΑΡΑΜΟΡΦΧΜΔΝΟ ΢ΧΜΑ 

Σν ANSYS καο δίλεη ηελ δπλαηφηεηα απεηθφληζεο ηνπ παξακνξθσκέλνπ ζψκαηνο. 
Απφ ην αξηζηεξφ κελνχ αθνινπζνχκε ηελ γλσζηή αθνινπζία : 

General Postproc=>Plot Results=>Deformed Shape=>def + underformed 

Καη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε ΟΚ. 

 

΢ηελ ζπλέρεηα θάλνπκε εθαξκνγή κε ηελ εληνιή APPLY  θαη επηιέγνπκε ην ζρέδην , 
έπεηηα επηιέγνπκε ην ΟΚ θαη εκθαλίδεηαη ην παξαθάησ ζρέδην: 
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Β) ΚΑΣΑΝΟΜΗ ΣΧΝ ΜΔΣΑΣΟΠΙ΢ΔΧΝ 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε  

General postproc =>Plot Results=>Contour Plot=>Nodal Solution  

΢ηελ θαξηέια πνπ εκθαλίδεηαη παξαθάησ επηιέγνπκε : 

 

DOF Solution=>Displacement vector Sum παηάκε ΟΚ θαη εκθαλίδεηαη ην ζρήκα ησλ 
κεηαηνπίζεσλ. 

 

΋ηαλ επηιέμνπκε  ην ΟΚ .Σν ζρήκα ησλ κεηαηνπίζεσλ γίλεηε: 
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Γ) ΚΑΣΑΝΟΜΗ ΣΧΝ ΣΑ΢ΔΧΝ 

Δθηεινχκε πάιη ηελ ίδηα δηαδηθαζία απφ ην αξηζηεξφ κελνχ : 

General postproc >Plot Results>Contour Plot>Nodal Solution  

Καη ζηελ ίδηα θαξηέια πνπ εκθαλίδεηαη απηή ηε θνξά επηιέγνπκε : 

 

Stress>Von Misses Stress θαη παηάκε ΟΚ .Σν παξαθάησ ζρήκα είλαη ην ζρήκα ησλ 
ηάζεσλ. 
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ΒΗΜΑ 17Ο: ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η (ΓΔΤΣΔΡΟ ΠΛΔΓΜΑ) 

Με ζθνπφ ηελ ζχγθιηζε ησλ απνηειεζκάησλ ην δνθίκην καο δηαθξηηνπνηείηαη πάιη 
κε δηαθνξεηηθφ κέγεζνο ζηνηρείσλ. Οπφηε αθνινπζνχκε ηελ εμήο δηαδηθαζία:  

Preprocessor =>Meshing =>Size Controls => Manual Size =>Areas =>All Areas 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παξαθάησ ζπκπιεξψλνπκε ην λέν κήθνο ζηνηρείσλ. 

 

΢ην παξαθάησ ζρήκα απεηθνλίδεηαη ην δνθίκην κε ην δεχηεξν κέγεζνο πιέγκαηνο 
φπνηε κε ηελ ίδηα δηαδηθαζία έρνπκε: 

 

ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η: 
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Λχλνπκε ην ζχζηεκα θαη παίξλνπκε ηα δεχηεξα απνηειέζκαηα: 

Α) ΠΑΡΑΜΟΡΦΧΜΔΝΟ ΢ΧΜΑ: 

 

Β) ΜΔΣΑΣΟΠΙ΢ΔΙ΢: 
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Γ) ΚΑΣΑΝΟΜΗ ΣΑ΢ΔΧΝ: 
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Π.3. ΠΡΟΒΛΗΜΑ : ΑΝΑΛΤ΢Η ΢ΤΜΔΣΡΙΚΟΤ ΢ΧΜΑΣΟ΢ ΜΔ ΣΟΞΑ ΑΠΟ 
PLM-4B 

Αλνίγνπκε ην ANSYS 14. Αξρηθά ζην File management=>working directory θαη 
απνζεθεχνπκε ζε έλα θάθειν κε φλνκα job name γηα λα απνζεθεπηεί ε εξγαζία καο. ΢ηε 
ζπλέρεηα επηιέγνπκε RUN θαη εκθαλίδεηε ην ζρεδηαζηηθφ πεξηβάιινλ ηνπ πξνγξάκκαηνο 
ANSYS. 
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2. ΓΔΧΜΔΣΡΙΑ ΚΑΣΑ΢ΚΔΤΗ΢ 

 

ΒΗΜΑ 1ο: ΣΟΠΟΘΔΣΗ΢Η ΢ΗΜΔΙΧΝ 

 

Γηα ηελ ηνπνζέηεζε ησλ ζεκείσλ επηιεγνχκε ην main menu θαη ζηελ ζπλερεία : 

Pre-processor=>modelling=>create=>key points=>in active CS 

Kαη ζηελ θαξηέια πνπ εκθαλίδεηε δίλνπκε ηα παξαθάησ ζεκεία: 

 

α/α Υ Τ 

1 0 0 

2 0 82 

3 4 90 

4 0 98 

5 0 140 

6 28 140 

7 28 98 

8 24 90 

9 28 82 

10 28 0 

11 0 0 

Αξρηθά βάδνπκε ζηελ θαξηέια ηελ θάζε κηα ζπληεηαγκέλε φπνπ εκθαλίδεηαη ζηνλ 
παξαπάλσ πίλαθα (x,y,z location in active CS ) .Έπεηηα βάδνπκε ηνλ αχμνληα αξηζκφ γηα 
θάζε κηα ζπληεηαγκέλε ( NPT key point number) ,επηιέγνπκε ηελ εληνιή apply θαη 
αληίζηνηρα επηιέγνπκε ην νθ γηα φια ηα ζεκεία. 
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ΒΗΜΑ 2Ο: ΓΗΜΙΟΤΡΓΙΑ ΢ΗΜΔΙΧΝ  

 

Δλψλνπκε  ηα ζεκεία σο εμήο: 

Pre-processor=>modelling=>create =>Lines =>Lines =>Straight line. 

Δκθαλίδεηαη έλα θαξηειάθη θαη ν θέξζνξαο γίλεηαη έλα ελεξγφ βέινο. Έπεηηα 
επηιέγνπκε  ηα ζεκεία ησλ επζεηψλ γξακκψλ. 
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ΒΗΜΑ 3Ο: ΢ΥΔΓΙΑ΢Η ΣΧΝ ΣΟΞΧΝ. 

 

Απφ ην αξηζηεξφ κελνχ: 

Pre-processor=>Modelling=>Create =>Lines => Arcs =>By End KPs & Rad 
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ΒΗΜΑ 4Ο: ΓΗΜΙΟΤΡΓΙΑ ΔΠΙΦΑΝΔΙΑ΢ 

 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε: 

Pre-processor=>Modelling=>Create =>Areas =>Arbitrary => by lines 

θιηθάξνπκε ην πεξίγξακκα θαη παηάκε ΟΚ. 
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ΒΗΜΑ 5Ο: ΓΗΜΙΟΤΡΓΙΑ ΟΠΗ΢- ΑΦΑΙΡΔ΢Η ΟΠΗ΢ 

 

Γηα λα δεκηνπξγήζνπκε ηελ νπή αθνινπζνχκε ηελ εμήο δηαδηθαζία. Απφ ην αξηζηεξφ 
κελνχ επηιέγνπκε: 

Pre-processor=>Modelling=>Create=>Areas=>Circle=>Solid circle 

Δκθαλίδεηε έλα θαξηειάθη θαη βάδνπκε ηα παξαθάησ ζεκεία: 
 

α/α X Y R 

0 14 8 2 

 

Έπεηηα κε ηελ ίδηα δηαδηθαζία αθαηξνχκε ηελ νπή.: 

Pre-processor=>Modelling=>Operate =>Booleans=> Subtract Areas 

Δπηιέγνπκε ηελ βαζηθή επηθάλεηα θαη κε Apply επηιέγνπκε ηελ αθαηξνχκελε 
επηθάλεηα. ΢ηελ παξαθάησ εηθφλα απεηθνλίδεηαη ε νπή. 
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ΒΗΜΑ 6Ο: ΟΡΙ΢ΜΟ΢ ΢ΣΟΙΥΔΙΧΝ 

 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

Preprocessor=>Element Type=>Add/Edit/Delete 

΢ηελ θαξηέια πνπ εκθαλίδεηαη κπνξνχκε λα επεμεξγαζηνχκε ηα ραξαθηεξηζηηθά ηνπ 
επηιεγκέλνπ  ζηνηρεηνχ. Δπηιέγνπκε ην add θαη εκθαλίδεηαη ε παξαθάησ θαξηέια. 

 

 

΢ηελ θαξηέια πνπ εκθαλίδεηαη απφ ην κελνχ solid επηιέγνπκε 8note183 θαη παηάκε ΟΚ. 

 

Δπίζεο κπνξνχκε λα επεμεξγαζηνχκε ηα γεσκεηξηθά ραξαθηεξηζηηθά ηνπ 

επηιεγκέλνπ ζηνηρεηνχ. 
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ΒΗΜΑ 7Ο: ΚΑΘΟΡΙ΢ΜΟ΢ ΓΔΧΜΔΣΡΙΚΧΝ ΙΓΙΟΣΗΣΧΝ 

 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε. 

Preprocessor =>Real Constants =>Add/Edit/Delete 

Δπηιέγνπκε Add θαη ζηελ ζπλέρεηα ΟΚ  ζηελ θαξηέια πνπ εκθαλίδεηαη.  

 

 

Δθφζνλ επηιέμνπκε ΟΚ εκθαλίδεηε ε αθφινπζε θαξηέια φπνπ βάδνπκε πάρνο 5 mm. 
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ΒΗΜΑ 8O: ΙΓΙΟΣΗΣΔ΢ ΤΛΙΚΟΤ 

Ο νξηζκφο ηνπ πιηθνχ ζα γίλεη σο εμήο: Απφ ην αξηζηεξφ κελνχ επηιέγνπκε  

Preprocessor =>Material Props =>Material Models =>Structural =>Linear =>Elastic 
=>Isotropic 

΋πσο θαίλεηαη παξαθάησ: 

 

΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξψλνπκε ην κέηξν ειαζηηθφηεηαο θαη ην ιφγν 
Poisson. ΋πνπ ΔΥ=0,13 GPa θαη PRXY=0,45. 

 

 

Δπίζεο ζηελ ίδηα θαξηέια επηιέγνπκε ηελ εληνιή Density θαη νξίδνπκε θαη 

ππθλφηεηα πιηθνχ: DENS=2680 kg/m³. 
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ΒΗΜΑ 9Ο: ΜΔΓΔΘΟ΢ ΠΡΧΣΟΤ ΠΛΔΓΜΑΣΟ΢ 

Ζ επηινγή ηνπ κήθνπο ησλ ζηνηρείσλ γίλεηαη σο εμήο: Απφ ην αξηζηεξφ κελνχ επηιέγνπκε  

Pre-processor=>Meshing =>Size Controls =>Manual Size =>Areas =>All Areas 

θαη εκθαλίδεηαη ε παξαθάησ θαξηέια φπνπ ζπκπιεξψλνπκε ην κήθνο ησλ ζηνηρείσλ θαη 
παηάκε ΟΚ. 
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ΒΗΜΑ 10Ο: ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η (ΠΡΧΣΟ ΠΛΔΓΜΑ) 

 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε: 

Pre-processor=>Meshing=>Mesh=>Volumes=>Free 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Pick all γηα λα επηιεγεί νιφθιεξε ηελ 
επηθάλεηα. 

 

 

 

ΒΗΜΑ 11Ο: ΟΡΙ΢ΜΟ΢ ΔΙΓΟΤ΢ ΑΝΑΛΤ΢Η΢ 

 

Σν είδνο ηεο αλάιπζεο νξίδεηαη σο εμήο: Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

Solution=>Analysis Type=>New Analysis 

Kαη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε static .  
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ΒΗΜΑ 12Ο: ΟΡΙ΢ΜΟ΢ ΢ΣΗΡΙΞΔΧΝ 

Γηα λα νξίζνπκε ηηο ζηεξίμεηο αθνινπζνχκε ηελ εμήο δηαδηθαζία: Απφ ην αξηζηεξφ 
κελνχ επηιέγνπκε : 

Solution =>Define Loads =>Apply=> Structural =>Displacement 

Παηάκε On Areas  θαη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Pick All. 

Αθνχ θιηθάξνπκε ηελ επηθάλεηα πνπ ζέινπκε λα παθηψζνπκε έπεηηα ζηε λέα 
θαξηέια πνπ εκθαλίδεηαη επηιέγνπκε All Dof θαη παηάκε ΟΚ. 

 

 

ΒΗΜΑ 13Ο: ΟΡΙ΢ΜΟ΢ ΓΤΝΑΜΔΧΝ 

 

Γηα λα νξίζνπκε ηελ ηηκή θαη ηελ δηεχζπλζε ηνπ θνξηίνπ αθνινπζνχκε ηηο εμήο 
εληνιέο:  

Solution =>Define Loads =>Apply =>Structural =>Force/Moment=> On Key points 

Δπηιέγνπκε ην θάησ κέξνο ηεο κεζαίαο νπήο, επηιέγνπκε ηνλ άμνλα εθαξκνγήο ηεο 
δχλακεο (FY) θαη εθαξκφδνπκε δχλακε 4N (κε πξφζεκν κείσλ(-)). 
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ΒΗΜΑ 14Ο: ΔΠΙΛΤ΢Η ΣΟΤ ΠΡΟΒΛΗΜΑΣΟ΢. 

Δθηεινχκε ηελ επίιπζε απφ ην αξηζηεξφ κελνχ: 

Solution =>Solve =>Current LS. 

΋ηαλ ηειεηψζνπλ νη ππνινγηζκνί ην πξφγξακκα καο ελεκεξψλεη κε ην παξαθάησ κήλπκα: 

 

 

 

ΒΗΜΑ 15Ο: ΠΡΟΒΟΛΗ ΑΠΟΣΔΛΔ΢ΜΑΣΧΝ 

Α) ΠΑΡΑΜΟΡΦΧΜΔΝΟ ΢ΧΜΑ 

 

Σν ANSYS καο δίλεη ηελ δπλαηφηεηα απεηθφληζεο ηνπ παξακνξθσκέλνπ ζψκαηνο. 
Απφ ην αξηζηεξφ κελνχ αθνινπζνχκε ηελ γλσζηή αθνινπζία : 

General Postproc =>Plot Results=>Deformed Shape=>def+underformed 

Καη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε ΟΚ. 
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ΔΜΦΑΝΙ΢Η ΠΑΡΑΜΟΡΦΧΜΔΝΟΤ ΢ΧΜΑΣΟ΢ 

 

 

Β) ΚΑΣΑΝΟΜΗ ΣΧΝ ΜΔΣΑΣΟΠΙ΢ΔΧΝ 

 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

General Postproc=>Plot Results=>Contour Plot=>Nodal Solution 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παξαθάησ επηιέγνπκε : 

DOF Solution => Displacement  vector sum παηάκε ΟΚ θαη εκθαλίδεηαη ην ζρήκα ησλ 
κεηαηνπίζεσλ. 
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ΜΔΣΑΣΟΠΙ΢ΔΙ΢ 

 

Γ) ΚΑΣΑΝΟΜΗ ΣΧΝ ΣΑ΢ΔΧΝ 

Δθηεινχκε πάιη ηελ ίδηα δηαδηθαζία απφ ην αξηζηεξφ κελνχ  

General Postproc =>Plot Results =>Contour Plot =>Nodal Solution 

Καη  ζηελ ίδηα θαξηέια πνπ εκθαλίδεηαη απηή ηε θνξά επηιέγνπκε: 

Stress =>Von Misses Stress θαη παηάκε ΟΚ. Σν παξαθάησ είλαη ην ζρήκα ησλ ηάζεσλ. 
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ΚΑΣΑΝΟΜΗ ΣΑ΢ΔΧΝ 

 

 

ΒΗΜΑ 16Ο: ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η (ΓΔΤΣΔΡΟ ΠΛΔΓΜΑ) 

 

Με ζθνπφ ηελ ζχγθιηζε ησλ απνηειεζκάησλ ην δνθίκην δηαθξηηνπνηείηαη πάιη κε 
δηαθνξεηηθφ κέγεζνο ζηνηρείσλ. Οπφηε αθνινπζνχκε ηελ εμήο δηαδηθαζία:  

Pre-processor=>Meshing=>Size Controls=>Manual Size=>Areas=>All Areas. 

΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξψλνπκε ην λέν κήθνο ζηνηρείσλ. 

 

 

΢ην παξαθάησ ζρήκα απεηθνλίδεηαη ην δνθίκην κε ην δεχηεξν κέγεζνο πιέγκαηνο 
φπνηε κε ηελ ίδηα δηαδηθαζία έρνπκε: 
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ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η: 

 

 

Α) ΠΑΡΑΜΟΡΦΧΜΔΝΟ ΢ΧΜΑ: 
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B )ΚΑΣΑΝΟΜΗ ΣΧΝ ΜΔΣΑΣΟΠΙ΢ΔΧΝ: 

 

 

Γ) ΚΑΣΑΝΟΜΗ ΣΧΝ ΣΑ΢ΔΧΝ: 
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Π.4. ΠΡΟΒΛΗΜΑ : ΑΝΑΛΤ΢Η ΢ΤΜΔΣΡΙΚΟΤ ΢ΧΜΑΣΟ΢ ΜΔ ΣΟΞΑ ΑΠΟ 
PLEXIGLAS 

 

Αλνίγνπκε ην ANSYS 14. Αξρηθά ζην File management=>working directory θαη 
απνζεθεχνπκε ζε έλα θάθειν κε φλνκα job name γηα λα απνζεθεπηεί ε εξγαζία καο. ΢ηε 
ζπλέρεηα επηιέγνπκε RUN θαη εκθαλίδεηε ην ζρεδηαζηηθφ πεξηβάιινλ ηνπ πξνγξάκκαηνο 
ANSYS. 
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1. ΓΔΧΜΔΣΡΙΑ ΚΑΣΑ΢ΚΔΤΗ΢ 

ΒΗΜΑ 1Ο:ΣΟΠΟΘΔΣΗ΢Η ΢ΗΜΔΙΧΝ. 

 ΢ην main menu επηιέγνπκε: 

Pre-processor=>modelling=>create =>key points=>in active CS 

Kαη ζηελ θαξηέια πνπ εκθαλίδεηε δίλνπκε ηα παξαθάησ ζεκεία: 

 

α/α Υ Τ 

1 0 0 

2 0 160 

3 5 170 

4 0 180 

5 0 340 

6 30 340 

7 30 180 

8 25 170 

9 30 160 

10 30 0 

11 0 0 

Αξρηθά βάδνπκε ζηελ θαξηέια ηελ θάζε κηα ζπληεηαγκέλε φπνπ εκθαλίδεηαη ζηνλ 
παξαπάλσ πίλαθα (x,y,z location in active CS ) .Έπεηηα βάδνπκε ηνλ αχμνληα αξηζκφ γηα 
θάζε κηα ζπληεηαγκέλε ( NPT key point number) ,επηιέγνπκε ηελ εληνιή apply θαη 
αληίζηνηρα επηιέγνπκε ην νθ γηα φια ηα ζεκεία. 
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ΒΗΜΑ 2Ο: ΓΗΜΙΟΤΡΓΙΑ ΢ΗΜΔΙΧΝ  

Δλψλνπκε ηα ζεκεία σο εμήο : 

Pre-processor=>modelling=>create =>Lines => Lines =>Straight line. 

Δκθαλίδεηαη έλα θαξηειάθη θαη ν θέξζνξαο γίλεηαη έλα ελεξγφ βέινο. Έπεηηα θιηθάξνπκε ηα 
ζεκεία ησλ επζεηψλ γξακκψλ. 
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ΒΗΜΑ 3Ο: ΢ΥΔΓΙΑ΢Η ΣΧΝ ΣΟΞΧΝ 

 

 Απφ ην αξηζηεξφ κελνχ 

Pre-processor =>Modelling=>Create =>Lines =>Arcs =>By End KPs & Rad 
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ΒΗΜΑ 4Ο: ΓΗΜΙΟΤΡΓΙΑ ΔΠΙΦΑΝΔΙΑ΢ 

 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε 

Pre-processor=>Modelling=>Create =>Areas =>Arbitrary =>By lines 

θιηθάξνπκε ην πεξίγξακκα θαη παηάκε ΟK. 
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ΒΗΜΑ 5Ο: ΟΡΙ΢ΜΟ΢ ΢ΣΟΙΥΔΙΧΝ 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

Pre-processor=>Element Type=>Add/Edit/Delete 

 

 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Add θαη ζηελ λέα θαξηέια απφ ην κελνχ 
solid επηιέγνπκε 8note183 θαη παηάκε ΟΚ. 

 

΢ηελ ζπλέρεηα επεμεξγαδφκαζηε ηηο ηδηφηεηεο ηνπο ζηνηρεηνχ. 
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ΒΗΜΑ 6Ο: ΚΑΘΟΡΙ΢ΜΟ΢ ΓΔΧΜΔΣΡΙΚΧΝ ΙΓΙΟΣΗΣΧΝ. 

Απφ ην αξηζηεξφ κελνχ 

Pre-processor =>Real Constants =>Add/Edit/Delete 

επηιέγνπκε Add θαη ζηελ ζπλέρεηα ΟΚ ζηελ θαξηέια πνπ εκθαλίδεηαη.  

 

 

 

΢ηελ αθφινπζε θαξηέια βάδνπκε πάρνο 3mm 
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ΒΗΜΑ 7O: ΙΓΙΟΣΗΣΔ΢ ΤΛΙΚΟΤ. 

Ο νξηζκφο ηνπ πιηθνχ ζα γίλεη σο εμήο: Απφ ην αξηζηεξφ κελνχ επηιέγνπκε  

Pre-processor =>Material Props =>Material Models =>Structural =>Linear => Elastic 
=>Isotropic 

΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξψλνπκε ην κέηξν ειαζηηθφηεηαο θαη ην ιφγν 
Poisson. ΋πνπ ΔΥ=3 GPa θαη PRXY=0,35 

 

Δπίζεο ζηελ ίδηα θαξηέια επηιέγνπκε ηελ εληνιή Density θαη νξίδνπκε θαη ππθλφηεηα 

πιηθνχ: DENS=1200 kg/m³ 
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ΒΗΜΑ 8Ο:ΜΔΓΔΘΟ΢ ΠΡΧΣΟΤ ΠΛΔΓΜΑΣΟ΢ 

Ζ επηινγή ηνπ κήθνπο ησλ ζηνηρείσλ γίλεηαη σο εμήο: Απφ ην αξηζηεξφ κελνχ 
επηιέγνπκε  

Pre-processor=>Meshing =>Size Controls => Manual Size =>Areas => All Areas 

Καη εκθαλίδεηαη ε παξαθάησ θαξηέια φπνπ ζπκπιεξψλνπκε ην κήθνο ησλ 
ζηνηρείσλ θαη παηάκε ΟΚ. 

 

 

 ΒΗΜΑ 9Ο: ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η (ΠΡΧΣΟ ΠΛΔΓΜΑ) 

 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε: 

Pre-processor=>Meshing=>Mesh=>Volumes=>Free 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Pick all γηα λα επηιεγεί νιφθιεξε ηελ 
επηθάλεηα 
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ΒΗΜΑ 10Ο: ΟΡΙ΢ΜΟ΢ ΔΙΓΟΤ΢ ΑΝΑΛΤ΢Η΢ 

Σν είδνο ηεο αλάιπζεο νξίδεηαη σο εμήο: Απφ ην αξηζηεξφ κελνχ επηιέγνπκε: 

Solution=>Analysis Type=>New Analysis 

Καη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε static.  

 

 

 

ΒΗΜΑ 11Ο: ΟΡΙ΢ΜΟ΢ ΢ΣΗΡΙΞΔΧΝ 

 

Γηα λα νξίζνπκε ηηο ζηεξίμεηο αθνινπζνχκε ηελ εμήο δηαδηθαζία: Απφ ην αξηζηεξφ κελνχ 
επηιέγνπκε : 

Solution =>Define Loads =>Apply=>Structural =>Displacement 

παηάκε On Areas θαη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Pick All. 

 Αθνχ θιηθάξνπκε ηελ επηθάλεηα πνπ ζέινπκε λα παθηψζνπκε έπεηηα ζηε λέα θαξηέια 
πνπ εκθαλίδεηαη επηιέγνπκε All Dof θαη παηάκε ΟΚ. 
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ΒΗΜΑ 12Ο: ΟΡΙ΢ΜΟ΢ ΓΤΝΑΜΔΧΝ 

 

Γηα λα νξίζνπκε ηελ ηηκή θαη ηελ δηεχζπλζε ηνπ θνξηίνπ αθνινπζνχκε ηηο εμήο 
εληνιέο:  

Solution =>Define Loads =>Apply =>Structural =>Force/Moment=> On Key points 

Δπηιέγνπκε ην θάησ κέξνο ηεο επηθάλεηαο ζε δπν ζεκεία(κε Apply), επηιέγνπκε ηνλ 
άμνλα εθαξκνγήο ηεο δχλακεο (FY) θαη εθαξκφδνπκε δχλακε 10 N (κε πξφζεκν κείσλ(-)) 
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ΒΗΜΑ 13Ο: ΔΠΙΛΤ΢Η ΣΟΤ ΠΡΟΒΛΗΜΑΣΟ΢ 

Δθηεινχκε ηελ επίιπζε απφ ην αξηζηεξφ κελνχ  

Solution =>Solve =>Current LS. 

 

΋ηαλ ηειεηψζνπλ νη ππνινγηζκνί ην πξφγξακκα καο ελεκεξψλεη κε ην παξαθάησ 
κήλπκα: 
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ΒΗΜΑ 14Ο: ΠΡΟΒΟΛΗ ΑΠΟΣΔΛΔ΢ΜΑΣΧΝ 

Α) ΠΑΡΑΜΟΡΦΧΜΔΝΟ ΢ΧΜΑ 

Σν ANSYS καο δίλεη ηελ δπλαηφηεηα απεηθφληζεο ηνπ παξακνξθσκέλνπ ζψκαηνο. 
Απφ ην αξηζηεξφ κελνχ αθνινπζνχκε ηελ γλσζηή αθνινπζία: 

General Postproc=>Plot Results=>Deformed Shape=>def+underformed 

θαη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε ΟΚ. 

 

 

ΠΑΡΑΜΟΡΦΧΜΔΝΟ ΢ΧΜΑ. 
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Β) ΚΑΣΑΝΟΜΗ ΣΧΝ ΜΔΣΑΣΟΠΙ΢ΔΧΝ 

 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

General Postproc => Plot Results=>Contour Plot=>Nodal Solution 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παξαθάησ επηιέγνπκε  

DOF Solution > Displacement vector sum παηάκε ΟΚ θαη εκθαλίδεηαη ην ζρήκα ησλ 
κεηαηνπίζεσλ. 

 

ΣΟ ΢ΥΗΜΑ ΣΧΝ ΜΔΣΑΣΟΠΙ΢ΔΧΝ : 
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Γ) ΚΑΣΑΝΟΜΗ ΣΧΝ ΣΑ΢ΔΧΝ: 

 

Δθηεινχκε πάιη ηελ ίδηα δηαδηθαζία απφ ην αξηζηεξφ κελνχ : 

General Postproc => Plot Results =>Contour Plot =>Nodal Solution 

Kαη ζηελ ίδηα θαξηέια πνπ εκθαλίδεηαη απηή ηε θνξά επηιέγνπκε: 

Stress =>Von Misses Stress θαη παηάκε ΟΚ. Σν παξαθάησ είλαη ην ζρήκα ησλ ηάζεσλ. 
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ΒΗΜΑ 15Ο: ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η (ΓΔΤΣΔΡΟ ΠΛΔΓΜΑ) 

 

Με ζθνπφ ηελ ζχγθιηζε ησλ απνηειεζκάησλ ην δνθίκην δηαθξηηνπνηείηαη πάιη κε 
δηαθνξεηηθφ κέγεζνο ζηνηρείσλ. Οπφηε αθνινπζνχκε ηελ εμήο δηαδηθαζία:  

Pre-processor=>Meshing=>Size Controls=>Manual Size=>Areas=>All Areas. 

΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξψλνπκε ην λέν κήθνο ζηνηρείσλ. 

 

 

΢ην παξαθάησ ζρήκα απεηθνλίδεηαη ην δνθίκην κε ην δεχηεξν κέγεζνο πιέγκαηνο 
φπνηε κε ηελ ίδηα δηαδηθαζία έρνπκε: 

ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η: 

 

Λχλνπκε ην ζχζηεκα θαη παίξλνπκε ηα δεχηεξα απνηειέζκαηα: 
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Α) ΠΑΡΑΜΟΡΦΧΜΔΝΟ ΢ΧΜΑ: 

 

Β) ΜΔΣΑΣΟΠΙ΢ΔΙ΢: 
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Γ) ΚΑΣΑΝΟΜΗ ΣΑ΢ΔΧΝ: 
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Π.5.ΠΡΟΒΛΗΜΑ : ΑΝΑΛΤ΢Η ΟΡΘΟΓΧΝΙΑ΢ ΠΛΑΚΑ΢ ΜΔ 3 ΔΓΚΑΡ΢ΙΔ΢ 
ΟΠΔ΢ 

 

Αλνίγνπκε ην ANSYS 14. Αξρηθά ζην File management=>working directory θαη 
απνζεθεχνπκε ζε έλα θάθειν κε φλνκα job name γηα λα απνζεθεπηεί ε εξγαζία καο. ΢ηε 
ζπλέρεηα επηιέγνπκε RUN θαη εκθαλίδεηε ην ζρεδηαζηηθφ πεξηβάιινλ ηνπ πξνγξάκκαηνο 
ANSYS. 
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1.ΓΔΧΜΔΣΡΙΑ ΚΑΣΑ΢ΚΔΤΗ΢ 

 

ΒΗΜΑ1Ο: ΓΗΜΙΟΤΡΓΙΑ ΣΔΣΡΑΓΧΝΟΤ 

 

΢ην main menu επηιέγνπκε γηα λα δεκηνπξγήζνπκε ην ηεηξάγσλν. 

Pre-processor =>Modeling =>Create =>Areas =>Rectangle =>by 2 Corners 

Δκθαλίδεηαη ε παξαθάησ θαξηέια φπνπ βάδνπκε ηηο ίδηεο αθξηβψο δηαζηάζεηο: 
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ΒΗΜΑ 2Ο: ΓΗΜΙΟΤΡΓΙΑ ΟΠΧΝ 

 

Γηα λα δεκηνπξγήζνπκε ηηο νπέο αθνινπζνχκε ηελ εμήο δηαδηθαζία. Απφ ην αξηζηεξφ 
κελνχ επηιέγνπκε: 

Pre-processor=>Modelling=>Create=>Areas=>Circle=>Solid circle 

 

α/α Υ Τ R 

1 15 110 7 

2 15 170 7 

3 15 230 7 

 

 

 

βάδνπκε ηα ζεκεία πνπ ππνινγίζακε κε Apply θαη ηέινο ΟΚ. 
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ΒΗΜΑ 3Ο:ΓΗΜΙΟΤΡΓΙΑ ΟΠΧΝ 

 

Γηα λα δεκηνπξγήζνπκε ηηο νπέο αθνινπζνχκε ηελ εμήο δηαδηθαζία. Απφ ην αξηζηεξφ 
κελνχ επηιέγνπκε: 

Pre-processor=>Modelling=>Operate =>Booleans=>Subtract =>Areas 

Κιηθάξνπκε ηελ βαζηθή επηθάλεηα θαη κε Apply επηιέγνπκε ηηο αθαηξνχκελεο 
επηθάλεηεο. 
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ΒΗΜΑ 4Ο: ΟΡΙ΢ΜΟ΢ ΢ΣΟΙΥΔΙΧΝ 

 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

Pre-processor=>Element Type=>Add/Edit/Delete 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παηάκε addθαη ζηελ λέα θαξηέια απφ ην κελνχ solid 
επηιέγνπκε 8note183 θαη παηάκε ΟΚ. 

 

΢ηελ ζπλέρεηα κπνξνχκε λα επεμεξγαζηνχκε ηα ραξαθηεξηζηηθά ηνπ ζηνηρεηνχ. 
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ΒΗΜΑ 5Ο: ΚΑΘΟΡΙ΢ΜΟ΢ ΓΔΧΜΔΣΡΙΚΧΝ ΙΓΙΟΣΗΣΧΝ 

Απφ ην αξηζηεξφ κελνχ : 

Preprocessor => Real Constants => Add/Edit/Delete 

επηιέγνπκε Add θαη ζηελ ζπλέρεηα ΟΚ ζηελ θαξηέια πνπ εκθαλίδεηαη.  

 

 

 

Δθφζνλ επηιέμνπκε ην ΟΚ , εηζάγνπκε ζηελ αθφινπζε θαξηέια ην πάρνο 3 mm. 
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ΒΗΜΑ 6O: ΙΓΙΟΣΗΣΔ΢ ΤΛΙΚΟΤ 

Ο νξηζκφο ηνπ πιηθνχ ζα γίλεη σο εμήο: Απφ ην αξηζηεξφ κελνχ επηιέγνπκε: 

Pre-processor =>Material Props =>Material Models =>Structural =>Linear => Elastic 
=>Isotropic 

΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξψλνπκε ην κέηξν ειαζηηθφηεηαο θαη ην ιφγν 
Poisson. ΋πνπ ΔΥ=3 GPa θαη PRXY=0,35. 

 

Δπίζεο ζηελ ίδηα θαξηέια επηιέγνπκε ηελ εληνιή Density θαη νξίδνπκε θαη 

ππθλφηεηα πιηθνχ: DENS=1200 kg/m³ 
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ΒΗΜΑ 7Ο: ΜΔΓΔΘΟ΢ ΠΡΧΣΟΤ ΠΛΔΓΜΑΣΟ΢ 

Ζ επηινγή ηνπ κήθνπο ησλ ζηνηρείσλ γίλεηαη σο εμήο: Απφ ην αξηζηεξφ κελνχ 
επηιέγνπκε  

Pre-processor=>Meshing =>Size Controls =>Manual Size =>Areas > All Areas 

Καη εκθαλίδεηαη ε παξαθάησ θαξηέια φπνπ ζπκπιεξψλνπκε ην κήθνο ησλ 
ζηνηρείσλ θαη παηάκε ΟΚ. 

 

 

 ΒΗΜΑ 8Ο: ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η (ΠΡΧΣΟ ΠΛΔΓΜΑ) 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε: 

Pre-processor=>Meshing=>Mesh=>Volumes=>Free 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Pick all γηα λα επηιεγεί νιφθιεξε ηελ 
επηθάλεηα. 
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ΒΗΜΑ 9Ο: ΟΡΙ΢ΜΟ΢ ΔΙΓΟΤ΢ ΑΝΑΛΤ΢Η΢ 

Σν είδνο ηεο αλάιπζεο νξίδεηαη σο εμήο: Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

Solution=>Analysis Type=>New Analysis 

Καη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε static.  

 

 

 

 

ΒΗΜΑ 10Ο: ΟΡΙ΢ΜΟ΢ ΢ΣΗΡΙΞΔΧΝ 

 

Γηα λα νξίζνπκε ηηο ζηεξίμεηο αθνινπζνχκε ηελ εμήο δηαδηθαζία: Απφ ην αξηζηεξφ 
κελνχ επηιέγνπκε: 

Solution =>Define Loads =>Apply=>Structural =>Displacement 

Παηάκε On Areas θαη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Pick All. 

 Αθνχ θιηθάξνπκε ηελ επηθάλεηα πνπ ζέινπκε λα παθηψζνπκε έπεηηα ζηε λέα 
θαξηέια πνπ εκθαλίδεηαη επηιέγνπκε All Dof θαη παηάκε ΟΚ. 
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ΒΗΜΑ 11Ο: ΟΡΙ΢ΜΟ΢ ΓΤΝΑΜΔΧΝ 

Γηα λα νξίζνπκε ηελ ηηκή θαη ηελ δηεχζπλζε ηνπ θνξηίνπ αθνινπζνχκε ηηο εμήο 
εληνιέο:  

Solution =>Define Loads =>Apply =>Structural =>Pressure=>On Lines 

Δπηιέγνπκε ην θάησ κέξνο ηεο επηθάλεηαο ζε δπν ζεκεία (κε Apply), επηιέγνπκε ηνλ 
άμνλα εθαξκνγήο ηεο δχλακεο (FY) θαη εθαξκφδνπκε δχλακε 10 N (κε πξφζεκν κείσλ(-)). 

 

 

 

ΒΗΜΑ 12Ο: ΔΠΙΛΤ΢Η ΣΟΤ ΠΡΟΒΛΗΜΑΣΟ΢ 

Δθηεινχκε ηελ επίιπζε απφ ην αξηζηεξφ κελνχ : 

Solution =>Solve =>Current LS. 
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΋ηαλ ηειεηψζνπλ νη ππνινγηζκνί ην πξφγξακκα καο ελεκεξψλεη κε ην παξαθάησ 
κήλπκα: 

 

 

ΒΗΜΑ 13Ο: ΠΡΟΒΟΛΗ ΑΠΟΣΔΛΔ΢ΜΑΣΧΝ 

Α) ΠΑΡΑΜΟΡΦΧΜΔΝΟ ΢ΧΜΑ: 

Σν ANSYS καο δίλεη ηελ δπλαηφηεηα απεηθφληζεο ηνπ παξακνξθσκέλνπ ζψκαηνο. 
Απφ ην αξηζηεξφ κελνχ αθνινπζνχκε ηελ γλσζηή αθνινπζία : 

General Postproc=>Plot Results=>Deformed Shape=>def+underformed 

Καη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε ΟΚ. 
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ΔΜΦΑΝΙ΢Η ΠΑΡΑΜΟΡΦΧΜΔΝΟΤ ΢ΧΜΑΣΟ΢ 
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Β) ΚΑΣΑΝΟΜΗ ΣΧΝ ΜΔΣΑΣΟΠΙ΢ΔΧΝ: 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε  

General Postproc =>Plot Results=>Contour Plot=>Nodal Solution 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παξαθάησ επηιέγνπκε : 

DOF Solution =>Displacement vector sum παηάκε ΟΚ θαη εκθαλίδεηαη ην ζρήκα ησλ 
κεηαηνπίζεσλ. 

 

 

ΣΟ ΢ΥΗΜΑ ΣΧΝ ΜΔΣΑΣΟΠΙ΢ΔΧΝ  
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Γ) ΚΑΣΑΝΟΜΗ ΣΧΝ ΣΑ΢ΔΧΝ: 

Δθηεινχκε πάιη ηελ ίδηα δηαδηθαζία απφ ην αξηζηεξφ κελνχ: 

General Postproc =>Plot Results =>Contour Plot =>Nodal Solution 

Καη ζηελ ίδηα θαξηέια πνπ εκθαλίδεηαη απηή ηε θνξά επηιέγνπκε: 

Stress =>Von Misses Stress θαη παηάκε ΟΚ.  

 

 

ΚΑΣΑΝΟΜΗ ΣΑ΢ΔΧΝ 
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ΒΗΜΑ 14Ο: ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η (ΓΔΤΣΔΡΟ ΠΛΔΓΜΑ) 

 

Με ζθνπφ ηελ ζχγθιηζε ησλ απνηειεζκάησλ ην δνθίκην δηαθξηηνπνηείηαη πάιη κε 
δηαθνξεηηθφ κέγεζνο ζηνηρείσλ. Οπφηε αθνινπζνχκε ηελ εμήο δηαδηθαζία:  

Pre-processor=>Meshing=>Size Controls =>Manual Size=>Areas=>All Areas. 

΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξψλνπκε ην λέν κήθνο ζηνηρείσλ. 

 

 

΢ην παξαθάησ ζρήκα απεηθνλίδεηαη ην δνθίκην κε ην δεχηεξν κέγεζνο πιέγκαηνο 
φπνηε κε ηελ ίδηα δηαδηθαζία έρνπκε: 

 

ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η: 
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Λχλνπκε ην ζχζηεκα θαη παίξλνπκε ηα δεχηεξα απνηειέζκαηα: 

Α) ΠΑΡΑΜΟΡΦΧΜΔΝΟ ΢ΧΜΑ: 

 

Β) ΜΔΣΑΣΟΠΙ΢ΔΙ΢: 
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Γ) ΚΑΣΑΝΟΜΗ ΣΑ΢ΔΧΝ: 
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Π.6. ΠΡΟΒΛΗΜΑ : ΑΝΑΛΤ΢Η ΟΡΘΟΓΧΝΙΑ΢ ΠΛΑΚΑ΢ ΜΔ 2 ΟΠΔ΢ 

Αλνίγνπκε ην ANSYS 14. Αξρηθά ζην File management=>working directory θαη 
απνζεθεχνπκε ζε έλα θάθειν κε φλνκα job name γηα λα απνζεθεπηεί ε εξγαζία καο. ΢ηε 
ζπλέρεηα επηιέγνπκε RUN θαη εκθαλίδεηε ην ζρεδηαζηηθφ πεξηβάιινλ ηνπ πξνγξάκκαηνο 
ANSYS. 
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1.ΓΔΧΜΔΣΡΙΑ ΚΑΣΑ΢ΚΔΤΗ΢ 

ΒΗΜΑ1Ο: ΓΗΜΙΟΤΡΓΙΑ ΣΔΣΡΑΓΧΝΟΤ 

΢ην main menu επηιέγνπκε γηα λα δεκηνπξγήζνπκε ην ηεηξάγσλν. 

Pre-processor =>Modeling =>Create =>Areas =>Rectangle =>by 2 Corners 

Δκθαλίδεηαη ε παξαθάησ θαξηέια φπνπ βάδνπκε ηηο ίδηεο αθξηβψο δηαζηάζεηο: 
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ΒΗΜΑ 2Ο: ΓΗΜΙΟΤΡΓΙΑ ΟΠΧΝ 

 

Γηα λα δεκηνπξγήζνπκε ηηο νπέο αθνινπζνχκε ηελ εμήο δηαδηθαζία. Απφ ην αξηζηεξφ 
κελνχ επηιέγνπκε: 

Pre-processor =>Modelling =>Create =>Areas =>Circle =>Solid circle 

Σνπνζεηνχκε ηηο ζπληεηαγκέλεο ζηνλ πίλαθα πνπ εκθαλίδεηαη θαη επηιέγνπκε apply 
θαη ζηελ ζπλέρεηα νθ. 

 

α/α X Y R 

1 8 170 3 

2 22 170 3 
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ΒΗΜΑ 3Ο:ΓΗΜΙΟΤΡΓΙ ΑΟΠΧΝ 

Γηα λα αθαηξέζνπκε νπέο αθνινπζνχκε ηελ εμήο δηαδηθαζία. Απφ ην αξηζηεξφ κελνχ 
επηιέγνπκε: 

Pre-processor=>Modelling=>Operate =>Booleans =>Subtract =>Areas 

Κιηθάξνπκε ηελ βαζηθή επηθάλεηα θαη κε Apply επηιέγνπκε ηηο αθαηξνχκελεο επηθάλεηεο. 
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ΒΗΜΑ 4Ο: ΟΡΙ΢ΜΟ΢ ΢ΣΟΙΥΔΙΧΝ 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε  

Pre-processor=>Element Type =>Add/Edit/Delete 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Add θαη ζηελ λέα θαξηέια απφ ην κελνχ 
solid επηιέγνπκε 8note183 θαη παηάκε ΟΚ. 

 

Έπεηηα επεμεξγαδφκαζηε ηα γεσκεηξηθά ραξαθηεξηζηηθά ηνπ επηιεγκέλνπ ζηνηρεηνχ. 
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ΒΗΜΑ 5Ο:  ΚΑΘΟΡΙ΢ΜΟ΢ ΓΔΧΜΔΣΡΙΚΧΝ ΙΓΙΟΣΗΣΧΝ 

Απφ ην αξηζηεξφ κελνχ: 

Pre-processor =>Real Constants=> Add/Edit/Delete 

Δπηιέγνπκε Add θαη ζηελ ζπλέρεηα ΟΚ ζηελ θαξηέια πνπ εκθαλίδεηαη.  

 

 

 

΢ηελ αθφινπζε θαξηέια βάδνπκε πάρνο 3mm 
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ΒΗΜΑ 6O: ΙΓΙΟΣΗΣΔ΢ ΤΛΙΚΟΤ 

Ο νξηζκφο ηνπ πιηθνχ ζα γίλεη σο εμήο: Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

Pre-processor =>Material Props =>Material Models =>Structural => Linear =>     
Elastic =>Isotropic 

΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξψλνπκε ην κέηξν ειαζηηθφηεηαο θαη ην ιφγν 
Poisson. ΋πνπ ΔΥ=3 GPa θαη PRXY=0,35. 
 

 

Δπίζεο ζηελ ίδηα θαξηέια επηιέγνπκε ηελ εληνιή Density θαη νξίδνπκε θαη ππθλφηεηα 

πιηθνχ: DENS=1200 kg/m³. 
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ΒΗΜΑ 7Ο: ΜΔΓΔΘΟ΢ ΠΡΧΣΟΤ ΠΛΔΓΜΑΣΟ΢ 

Ζ επηινγή ηνπ κήθνπο ησλ ζηνηρείσλ γίλεηαη σο εμήο: Απφ ην αξηζηεξφ κελνχ 
επηιέγνπκε : 

Pre-processor=>Meshing =>Size Controls =>Manual Size =>Areas =>All Areas 

Καη εκθαλίδεηαη ε παξαθάησ θαξηέια φπνπ ζπκπιεξψλνπκε ην κήθνο ησλ 
ζηνηρείσλ θαη παηάκε ΟΚ. 

 

 

 ΒΗΜΑ 8Ο: ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η (ΠΡΧΣΟ ΠΛΔΓΜΑ) 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε: 

Pre-processor =>Meshing =>Mesh =>Volumes => Free 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Pick all γηα λα επηιεγεί νιφθιεξε ηελ 

επηθάλεηα. 
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ΒΗΜΑ 9Ο: ΟΡΙ΢ΜΟ΢ ΔΙΓΟΤ΢ ΑΝΑΛΤ΢Η΢ 

Σν είδνο ηεο αλάιπζεο νξίδεηαη σο εμήο: Απφ ην αξηζηεξφ κελνχ επηιέγνπκε. 

Solution=>Analysis Type=>New Analysis 

Καη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε static.  

 

 

 

ΒΗΜΑ 10Ο: ΟΡΙ΢ΜΟ΢ ΢ΣΗΡΙΞΔΧΝ 

Γηα λα νξίζνπκε ηηο ζηεξίμεηο αθνινπζνχκε ηελ εμήο δηαδηθαζία: Απφ ην αξηζηεξφ 
κελνχ επηιέγνπκε : 

Solution=>Define Loads=>Apply=>Structural=>Displacement 

Παηάκε On Areas θαη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Pick All. 

 Αθνχ θιηθάξνπκε ηελ επηθάλεηα πνπ ζέινπκε λα παθηψζνπκε έπεηηα ζηε λέα 
θαξηέια πνπ εκθαλίδεηαη επηιέγνπκε All Dof θαη παηάκε ΟΚ. 
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ΒΗΜΑ 11Ο: ΟΡΙ΢ΜΟ΢ ΓΤΝΑΜΔΧΝ 

Γηα λα νξίζνπκε ηελ ηηκή θαη ηελ δηεχζπλζε ηνπ θνξηίνπ αθνινπζνχκε ηηο εμήο 
εληνιέο:  

Solution =>Define Loads =>Apply =>Structural =>Pressure=>On Lines. 

Δπηιέγνπκε ην θάησ κέξνο ηεο επηθάλεηαο ζε δπν ζεκεία(κε Apply), επηιέγνπκε ηνλ άμνλα 
εθαξκνγήο ηεο δχλακεο (FY) θαη εθαξκφδνπκε δχλακε 10N(κε πξφζεκν κείσλ(-)) 

 

 

 

ΒΗΜΑ 12Ο: ΔΠΙΛΤ΢Η ΣΟΤ ΠΡΟΒΛΗΜΑΣΟ΢ 

Δθηεινχκε ηελ επίιπζε απφ ην αξηζηεξφ κελνχ: 

Solution =>Solve =>Current LS. 

΋ηαλ ηειεηψζνπλ νη ππνινγηζκνί ην πξφγξακκα καο ελεκεξψλεη κε ην παξαθάησ 
κήλπκα: 
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ΒΗΜΑ 13Ο: ΠΡΟΒΟΛΗ ΑΠΟΣΔΛΔ΢ΜΑΣΧΝ 

Α) ΠΑΡΑΜΟΡΦΧΜΔΝΟ ΢ΧΜΑ: 

Σν ANSYS καο δίλεη ηελ δπλαηφηεηα απεηθφληζεο ηνπ παξακνξθσκέλνπ ζψκαηνο. 
Απφ ην αξηζηεξφ κελνχ αθνινπζνχκε ηελ γλσζηή αθνινπζία : 

General Postproc=>Plot Results =>Deformed Shape=>def+underformed 

Καη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε ΟΚ. 

 

 

 

ΔΜΦΑΝΙ΢Η ΠΑΡΑΜΟΡΦΧΜΔΝΟΤ ΢ΧΜΑΣΟ΢: 
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Β) ΚΑΣΑΝΟΜΗ ΣΧΝ ΜΔΣΑΣΟΠΙ΢ΔΧΝ: 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε: 

General Postproc =>Plot Results=>Contour Plot=>Nodal Solution 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παξαθάησ επηιέγνπκε : 

DOF Solution =>Displacement vector sum παηάκε ΟΚ θαη εκθαλίδεηαη ην ζρήκα ησλ 
κεηαηνπίζεσλ. 

 

ΣΟ ΢ΥΗΜΑ ΣΧΝ ΜΔΣΑΣΟΠΙ΢ΔΧN 
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Γ) ΚΑΣΑΝΟΜΗ ΣΧΝ ΣΑ΢ΔΧΝ: 

Δθηεινχκε πάιη ηελ ίδηα δηαδηθαζία απφ ην αξηζηεξφ κελνχ : 

General Postproc =>Plot Results =>Contour Plot =>Nodal Solution θαη ζηελ ίδηα 
θαξηέια πνπ εκθαλίδεηαη απηή ηε θνξά επηιέγνπκε: 

Stress =>Von Misses Stress θαη παηάκε ΟΚ. Σν παξαθάησ είλαη ην ζρήκα ησλ ηάζεσλ. 

 

 

 

ΚΑΣΑΝΟΜΗ ΣΑ΢ΔΧΝ: 
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ΒΗΜΑ 14Ο: ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η (ΓΔΤΣΔΡΟ ΠΛΔΓΜΑ): 

Με ζθνπφ ηελ ζχγθιηζε ησλ απνηειεζκάησλ ην δνθίκην δηαθξηηνπνηείηαη πάιη κε 
δηαθνξεηηθφ κέγεζνο ζηνηρείσλ. Οπφηε αθνινπζνχκε ηελ εμήο δηαδηθαζία:  

Pre-processor=>Meshing=>Size Controls=>Manual Size=>Areas=>All Areas. 

΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξψλνπκε ην λέν κήθνο ζηνηρείσλ. 
 

 

΢ην παξαθάησ ζρήκα απεηθνλίδεηαη ην δνθίκην κε ην δεχηεξν κέγεζνο πιέγκαηνο 
φπνηε κε ηελ ίδηα δηαδηθαζία έρνπκε: 

ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η

 

Λχλνπκε ην ζχζηεκα θαη παίξλνπκε ηα δεχηεξα απνηειέζκαηα: 
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Α) ΠΑΡΑΜΟΡΦΧΜΔΝΟ  ΢ΧΜΑ: 

 

 

Β) ΜΔΣΑΣΟΠΙ΢ΔΙ΢: 
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Γ) ΚΑΣΑΝΟΜΗ ΣΑ΢ΔΧΝ: 
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Π.7. ΠΡΟΒΛΗΜΑ : ΑΝΑΛΤ΢Η ΟΡΘΟΓΧΝΙΑ΢ ΠΛΑΚΑ΢ ΜΔ ΡΧΓΜΔ΢ 

 

Αλνίγνπκε ην ANSYS 14. Αξρηθά ζην File management=>working directory θαη 
απνζεθεχνπκε ζε έλα θάθειν κε φλνκα job name γηα λα απνζεθεπηεί ε εξγαζία καο. ΢ηε 
ζπλέρεηα επηιέγνπκε RUN θαη εκθαλίδεηε ην ζρεδηαζηηθφ πεξηβάιινλ ηνπ πξνγξάκκαηνο 
ANSYS. 
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1. ΓΔΧΜΔΣΡΙΑ ΚΑΣΑ΢ΚΔΤΗ΢ 

ΒΗΜΑ 1Ο:ΣΟΠΟΘΔΣΗ΢Η ΢ΗΜΔΙΧΝ. 

 ΢ην main menu επηιέγνπκε: 

Pre-processor =>modelling =>create =>key points =>in active CS 

Kαη ζηελ θαξηέια πνπ εκθαλίδεηε δίλνπκε ηα παξαθάησ ζεκεία: 

 

α/α Υ Τ 

1 0 0 

2 0 150 

3 15 150 

4 16 151 

5 15 152 

6 0 152 

7 0 190 

8 15 190 

9 16 191 

10 15 192 

11 0 192 

12 0 340 

13 85 340 

14 85 170 

15 70 170 

16 69 169 

17 70 168 

18 85 168 

19 85 0 

Αξρηθά βάδνπκε ζηελ θαξηέια ηελ θάζε κηα ζπληεηαγκέλε φπνπ εκθαλίδεηαη ζηνλ 
παξαπάλσ πίλαθα (x,y,z location in active CS ) .Έπεηηα βάδνπκε ηνλ αχμνληα αξηζκφ γηα 
θάζε κηα ζπληεηαγκέλε ( NPT key point number) ,επηιέγνπκε ηελ εληνιή apply θαη 
αληίζηνηρα επηιέγνπκε ην νθ γηα φια ηα ζεκεία. 
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ΒΗΜΑ 2Ο: ΓΗΜΙΟΤΡΓΙΑ ΢ΗΜΔΙΧΝ  

 

Δλψλνπκε ηα ζεκεία σο εμήο : 

Pre-processor =>modelling =>create =>Lines => Lines =>Straight line. 

Δκθαλίδεηαη έλα θαξηειάθη θαη ν θέξζνξαο γίλεηαη έλα ελεξγφ βέινο. Έπεηηα θιηθάξνπκε ηα 
ζεκεία ησλ επζεηψλ γξακκψλ. 
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ΒΗΜΑ3O: ΓΗΜΙΟΤΡΓΙΑ ΔΠΙΦΑΝΔΙΑ΢ 

 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε 

Pre-processor=>Modelling =>Create =>Areas =>Arbitrary =>By lines 

θιηθάξνπκε ην πεξίγξακκα θαη παηάκε ΟK. 
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ΒΗΜΑ 4Ο: ΟΡΙ΢ΜΟ΢ ΢ΣΟΙΥΔΙΧΝ 

 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

Pre-processor=>Element Type=>Add/Edit/Delete 

 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Add θαη ζηελ λέα θαξηέια απφ ην κελνχ 
solid επηιέγνπκε 8note183 θαη παηάκε ΟΚ. 

 

΢ηελ ζπλέρεηα επεμεξγαδφκαζηε ηηο ηδηφηεηεο ηνπο ζηνηρεηνχ. 
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ΒΗΜΑ 5Ο: ΚΑΘΟΡΙ΢ΜΟ΢ ΓΔΧΜΔΣΡΙΚΧΝ ΙΓΙΟΣΗΣΧΝ 

Απφ ην αξηζηεξφ κελνχ: 

Pre-processor =>Real Constants =>Add/Edit/Delete 

επηιέγνπκε Add θαη ζηελ ζπλέρεηα ΟΚ ζηελ θαξηέια πνπ εκθαλίδεηαη.  
 

 

΢ηελ αθφινπζε θαξηέια βάδνπκε πάρνο 3mm. 
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ΒΗΜΑ 6O: ΙΓΙΟΣΗΣΔ΢ ΤΛΙΚΟΤ 

Ο νξηζκφο ηνπ πιηθνχ ζα γίλεη σο εμήο: Απφ ην αξηζηεξφ κελνχ επηιέγνπκε  

Pre-processor =>Material Props =>Material Models =>Structural =>Linear =>         
Elastic =>Isotropic 

΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξψλνπκε ην κέηξν ειαζηηθφηεηαο θαη ην ιφγν 
Poisson. ΋πνπ ΔΥ=3 GPa θαη PRXY=0,35. 

 

Δπίζεο ζηελ ίδηα θαξηέια επηιέγνπκε ηελ εληνιή Density θαη νξίδνπκε θαη ππθλφηεηα 

πιηθνχ: DENS=1200 kg/m³. 
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ΒΗΜΑ 8Ο: ΜΔΓΔΘΟ΢ ΠΡΧΣΟΤ ΠΛΔΓΜΑΣΟ΢ 

Ζ επηινγή ηνπ κήθνπο ησλ ζηνηρείσλ γίλεηαη σο εμήο: Απφ ην αξηζηεξφ κελνχ 
επηιέγνπκε  

Pre-processor =>Meshing =>Size Controls => Manual Size =>Areas => All Areas 

Καη εκθαλίδεηαη ε παξαθάησ θαξηέια φπνπ ζπκπιεξψλνπκε ην κήθνο ησλ 
ζηνηρείσλ θαη παηάκε ΟΚ. 

 

 

 ΒΗΜΑ 9Ο: ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η (ΠΡΧΣΟ ΠΛΔΓΜΑ) 

 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

Pre-processor=>Meshing=>Mesh=>Volumes=>Free 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Pick all γηα λα επηιεγεί νιφθιεξε ηελ 
επηθάλεηα 

 

 



217 
 

ΒΗΜΑ 9Ο: ΟΡΙ΢ΜΟ΢ ΔΙΓΟΤ΢ ΑΝΑΛΤ΢Η΢ 

 

Σν είδνο ηεο αλάιπζεο νξίδεηαη σο εμήο: Απφ ην αξηζηεξφ κελνχ επηιέγνπκε: 

Solution=>Analysis Type=>New Analysis 

Καη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε static.  

 

 

 

ΒΗΜΑ 10Ο: ΟΡΙ΢ΜΟ΢ ΢ΣΗΡΙΞΔΧΝ 

 

Γηα λα νξίζνπκε ηηο ζηεξίμεηο αθνινπζνχκε ηελ εμήο δηαδηθαζία: Απφ ην αξηζηεξφ κελνχ 
επηιέγνπκε : 

Solution =>Define Loads =>Apply =>Structural =>Displacement 

παηάκε On Areas θαη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε Pick All. 

 Αθνχ θιηθάξνπκε ηελ επηθάλεηα πνπ ζέινπκε λα παθηψζνπκε έπεηηα ζηε λέα θαξηέια 
πνπ εκθαλίδεηαη επηιέγνπκε All Dof θαη παηάκε ΟΚ. 
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ΒΗΜΑ 11Ο: ΟΡΙ΢ΜΟ΢ ΓΤΝΑΜΔΧΝ 

 

Γηα λα νξίζνπκε ηελ ηηκή θαη ηελ δηεχζπλζε ηνπ θνξηίνπ αθνινπζνχκε ηηο εμήο 
εληνιέο:  

Solution =>Define Loads =>Apply =>Structural =>Force/Moment=> On Key points 

Δπηιέγνπκε ην θάησ κέξνο ηεο επηθάλεηαο ζε δπν ζεκεία(κε Apply), επηιέγνπκε ηνλ 
άμνλα εθαξκνγήο ηεο δχλακεο (FY) θαη εθαξκφδνπκε δχλακε 10N(κε πξφζεκν κείσλ(-)). 

 

 

ΒΗΜΑ 12Ο: ΔΠΙΛΤ΢Η ΣΟΤ ΠΡΟΒΛΗΜΑΣΟ΢ 

 

Δθηεινχκε ηελ επίιπζε απφ ην αξηζηεξφ κελνχ  

Solution > Solve > Current LS. 

΋ηαλ ηειεηψζνπλ νη ππνινγηζκνί ην πξφγξακκα καο ελεκεξψλεη κε ην παξαθάησ κήλπκα: 
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ΒΗΜΑ 13Ο: ΠΡΟΒΟΛΗ ΑΠΟΣΔΛΔ΢ΜΑΣΧΝ 

Α) ΠΑΡΑΜΟΡΦΧΜΔΝΟ ΢ΧΜΑ 

Σν ANSYS καο δίλεη ηελ δπλαηφηεηα απεηθφληζεο ηνπ παξακνξθσκέλνπ ζψκαηνο. 
Απφ ην αξηζηεξφ κελνχ αθνινπζνχκε ηελ γλσζηή αθνινπζία: 

General Postproc=>Plot Results=>Deformed Shape=>def+underformed 

θαη ζηελ θαξηέια πνπ εκθαλίδεηαη παηάκε ΟΚ. 
 

 

 

ΔΜΦΑΝΙ΢Η ΠΑΡΑΜΟΡΦΧΜΔΝΟΤ ΢ΧΜΑΣΟ΢: 
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Β) ΚΑΣΑΝΟΜΗ ΣΧΝ ΜΔΣΑΣΟΠΙ΢ΔΧΝ: 

 

Απφ ην αξηζηεξφ κελνχ επηιέγνπκε : 

General Postproc=>Plot Results=>Contour Plot=>Nodal Solution 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παξαθάησ επηιέγνπκε  

DOF Solution > Displacement vector sum παηάκε ΟΚ θαη εκθαλίδεηαη ην ζρήκα ησλ 
κεηαηνπίζεσλ. 

 

ΣΟ ΢ΥΗΜΑ ΣΧΝ ΜΔΣΑΣΟΠΙ΢ΔΧΝ ΔΙΝΑΙ ΣΟ ΠΑΡΑΚΑΣΧ: 
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Γ) ΚΑΣΑΝΟΜΗ ΣΧΝ ΣΑ΢ΔΧΝ: 

 

Δθηεινχκε πάιη ηελ ίδηα δηαδηθαζία απφ ην αξηζηεξφ κελνχ : 

General Postproc => Plot Results =>Contour Plot =>Nodal Solution 

Kαη ζηελ ίδηα θαξηέια πνπ εκθαλίδεηαη απηή ηε θνξά επηιέγνπκε: 

Stress =>Von Misses Stress θαη παηάκε ΟΚ. Σν παξαθάησ είλαη ην ζρήκα ησλ ηάζεσλ. 
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ΒΗΜΑ 14Ο: ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η (ΓΔΤΣΔΡΟ ΠΛΔΓΜΑ) 

Με ζθνπφ ηελ ζχγθιηζε ησλ απνηειεζκάησλ ην δνθίκην δηαθξηηνπνηείηαη πάιη κε 
δηαθνξεηηθφ κέγεζνο ζηνηρείσλ. Οπφηε αθνινπζνχκε ηελ εμήο δηαδηθαζία:  

Pre-processor=>Meshing=>Size Controls=>Manual Size=>Areas=>All Areas. 

΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξψλνπκε ην λέν κήθνο ζηνηρείσλ. 

 

 

΢ην παξαθάησ ζρήκα απεηθνλίδεηαη ην δνθίκην κε ην δεχηεξν κέγεζνο πιέγκαηνο φπνηε κε 
ηελ ίδηα δηαδηθαζία έρνπκε: 

 

ΓΙΑΚΡΙΣΟΠΟΙΗ΢Η: 

 

Λχλνπκε ην ζχζηεκα θαη παίξλνπκε ηα δεχηεξα απνηειέζκαηα: 
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Α) ΠΑΡΑΜΟΡΦΧΜΔΝΟ ΢ΧΜΑ: 

 

 

 Β) ΜΔΣΑΣΟΠΙ΢ΔΙ΢: 
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 Γ) ΚΑΣΑΝΟΜΗ ΣΑ΢ΔΧΝ: 
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